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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published December 2014. 

© 2014 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
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Overview 
The Deltek Acumen software suite consists of three products: 

 Deltek Acumen Fuse® 

 Deltek Acumen Risk™ 

 Deltek Acumen 360™  

These products work together to provide the analytics and insight necessary for sound scheduling 
and successful project execution. 

Product Feature Overview 
Deltek 
Acumen 
Fuse® 

Deltek 
Acumen 
RiskTM 

Deltek 
Acumen 
360TM 

Full 
Software 
Suite 

Integration with All Major Planning Tools 

Schedule Diagnostics     

DCMA 14 Point Assessment     

Schedule Quality Analysis     

Logic Analysis     

Project Benchmarking     

Schedule Cleansing     

Schedule Risk Analysis     

Cost Risk Analysis     

Forensic Analysis/Schedule Comparison 

Dashboard Reporting     

Schedule Acceleration     

Schedule Deceleration     

Customizable Metrics     

Customizable Reports     
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If You Need Assistance 
If you need assistance installing, implementing, or using the Acumen products, Deltek makes a 
wealth of information and expertise readily available to you. 

Customer Services 
For over 20 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and hot fixes 

 

If you need assistance using the Customer Care Connect site, the online help available on the 
site provides answers for most questions  
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  
1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you do not have a username and password for the Customer Care Connect site, contact your 
firm’s Acumen Administrator. 

If you forget your username or password, you can click the Account Assistance button on the 
login screen for help. 

Additional Documentation 
The following table lists the additional Deltek documentation available for this release. Except 
where noted, all the user guides and quick reference guides listed in this table are available for 
download using Deltek Software Manager (DSM), available from the Deltek Customer Care 
Connect site. 

Document Name Description 

Deltek Acumen Technical 
Installation Guide 

This guide contains technical installation and setup information 
for the staff at your company who maintain the hardware and 
software required to install Deltek Acumen. 

Deltek Acumen API Guide This guide provides information about the Deltek Acumen API 
and how to integrate with different platforms to create custom 
reports. 

Deltek Acumen Metric 
Developers Guide 

This document is a reference and guide for Acumen Software 
users looking to develop and customize advanced metrics 
within Acumen. 

Deltek Acumen RiskBook This document includes information for setting up and using 
RiskBook. Most of this information is also included in the User 
Guide. 

Deltek Acumen Historical 
Release Notes 

This document includes information about features and 
resolved issues from previous releases. 

http://support.deltek.com/
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Navigate Through the Acumen Suite 
Use the tabs at the top of the software to navigate throughout the product suite. Each tab relates 
to a particular level of the Acumen schedule maturity framework which is a series of 5 stages that 
result in a validated, risk-adjusted, and team-approved schedule.  

 

See Improving Project Plans using a Schedule Maturity Framework for more information. 

Acumen Suite Tabs 

Tab Description 

Available in these 
Acumen products 

Fuse Risk 360 

S1 // Projects Create and maintain project workbooks. Use to 
import, view, and edit project data.    

S2 // Diagnostics This includes the main Acumen Fuse view and 
is used to conduct analysis.     

S2 // Logic Advanced logic checks.    

S2 // Benchmarking Comparison of project data to cloud-based 
database of similar projects.    

S3 // Risk Monte-Carlo risk analysis, risk register, and 
reporting.    

S4// Acceleration Define acceleration goals and criteria.    

S5 // Dashboard Reporting dashboard.    

Forensics Compare multiple snapshots or historical 
instances of a project(s).    

Metrics The metric editor for maintaining custom 
metrics.    

Fields Tab for defining custom field mappings when 
importing project data.    

http://www.projectacumen.com/resource/improving-project-plans-using-a-schedule-maturity-framework/
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Navigating Between Tabs 
Use the Ribbon Navigation menu bar to navigate between tabs. 

 

You may not see all tabs. The tabs that display depend on the products that you have licensed 
as well as your security settings.  

 

Menu Items with Additional Options (Shortcut Menu) 
Some of the menu items on the tabs have additional options. You can tell which by looking for the 
down arrow in the bottom right corner of the icon. If an arrow is visible, then that menu item has a 
drop-down menu with additional options. 

When you read the steps in this guide, if it doesn’t specifically state to click the down arrow, then 
you should click on the top portion of the icon to run the process. 

Where You Click the Icon Description 

 
Click the top portion of the icon to run a process. 

 

Click the bottom half of the icon, or the drop-down arrow 
on the bottom right corner of the icon, to display a drop-
down menu with additional options. 

File Management Features 
Click the  icon in the top left corner of the product to access the File management features: 

 New — Create a new workbook. 

 Open — Open an existing workbook. 

 Save — Save an existing workbook. 

 Save As — Save a workbook by entering a file name. 

 Print — After you have run a Fuse analysis, you can use this option to print, for example, 
an Executive Briefing report.  

 Close — Close the current workbook. 

 Deltek Acumen Options — Open the Deltek Acumen Options dialog box. 

 Exit Deltek Acumen — Close Acumen. If you have unsaved work, a message displays 
asking if you want to save your workbook. 
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Set Deltek Acumen Options 
The Deltek Acumen dialog box allows you to set your user preferences and options. 

To access the Deltek Acumen Options dialog box, complete the following steps: 

1. Click  in the top left corner of the Acumen window. 

2. At the bottom of the pane, click Deltek Acumen Options. 

The Deltek Acumen Options Tabs 

General Tab 
The General tab allows you to: 

 Check for product updates and set Acumen to automatically check when starting 

 Set default folders, libraries, and templates 

 Set field mapping options 

 Install Add-Ins 

User Interface Tab 
The options on the User Interface tab are as follows: 

Analysis tab 

 Default Font Size — Use this option to set the default font size. 

 Show Long Date Format — If you select this option, the date format displayed in 
Acumen changes from MM/DD/YYYY to MM/DD/YYYY HH:MM:SS AM/PM. 

 Hide Empty Ribbons — Hide ribbons on the S2 // Diagnostics tab that have no data. 

 Calculate Score using metric based score instead of activity based score 

Forensics 

 Hide empty Forensic Analyses — Use this option to hide Forensic Analysis fields that 
have no variance. 

 

See Viewing the Forensic Analysis Report for more information about these fields. 

Scorecard 

Set Scorecard upper and lower values. 

Fluent UI 

Specify the project import options that you want to see on the S1 // Projects tab in the Get 
External Data From menu. 

Language 

Set language, date and time formats. 
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Platforms Tab 
Use the Platforms tab to connect to and set options for project management platforms. 

General 
 Import Code Field Values as — Use this option to specify whether you want to import 

the code field values as a value or description. 

Oracle Primavera Project Management P6 
 Calculate Baseline Values From — Use this option to specify whether you want to 

calculate baseline values from planned or current values. 

 Web Service Timeout (seconds) — Use this option to set the number of seconds before 
the web service times out. The default is 300. 

Microsoft Project 
 Activity Comparison Field — Use this option to specify the field that Acumen Forensics 

should use to uniquely identify an activity. You can select UniqueId, Id, Guid, or WBS. 

 Load MPP files directly without requiring Microsoft Project — If you do not have 
Microsoft Project installed, you can select this option to specify that Acumen should 
import the MPP files directly. Direct loading is faster but less reliable than using Microsoft 
Project. 

 If the “Acumen ID” field is present, map it to “Id” — This option modifies the default 
mapping when Acumen imports a project from Microsoft Project. Microsoft Project does 
not have an equivalent to Acumen’s ID field. Selecting this option allows Acumen’s ID 
fields to be preserved when a project is: 

1. Exported from Acumen to a Microsoft Project XML file. 

2. Edited in Microsoft Project. 

3. Exported from Microsoft Project. 

4. Re-imported into Acumen.  

When Acumen exports data for Microsoft Project, it creates a user-defined field called 
Acumen ID. When Acumen imports a project from Microsoft Project, it looks for the user-
defined field called Acumen ID. If you select this option, values from the Acumen ID field 
are loaded into Acumen’s ID field, thus preserving the content. 

 Import external activities — Microsoft project supports cross-project links. A cross-
project link is a relationship between an internal activity (an activity in the current project) 
and an external activity (an activity in another project). If you select this option, Acumen 
imports the cross-project links and their external activities. 

Deltek Open Plan 
 Username / Password — Enter your username and password in these fields so that you 

don’t have to enter them every time you import an Open Plan project.  

 Import Code Field Definition as — Use this option to specify whether you want to 
identify imported Open Plan code field using their description, name, ID, or a prompt. If 
you select prompt, then you will be asked to specify your choice every time you import a 
project. You can view the code fields on the Fields tab in the Source fields area. 
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Deltek RiskBook 

When you purchase a RiskBook license, Acumen should automatically be set up to publish a risk 
register to RiskBook. If you need to manually enable RiskBook in Acumen, you will need to enter 
your Kona Business token information into these fields. 

 Redirect URl 

 Client ID 

 Client Secret 

 

See The Kona Business Token for steps on how to obtain the information needed in these 
fields, or contact your Kona Business Administrator or Kona Support (support@kona.com), or 
you can log a case at: http://support.kona.com/tickets/new. 

Contact Us Tab 
The Contact Us tab includes: 

 A link to the Deltek website. 

 The Deltek Headquarters address. 

 Email and telephone information for Customer Support and general inquiries. 

About Deltek Acumen tab 
Use the About Deltek Acumen tab to: 

 View the software version number. 

 Opt-in to Deltek Acumen Cloud. 

 View License Terms. 

 Reset your license. 

mailto:support@kona.com
http://support.kona.com/tickets/new
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Create or open 
a workbook 

Create external 
data project links 

Import the 
project data 

Getting Started 
There are three main tasks you need to complete before you can begin analyzing data in 
Acumen: 

 

 

 

 

All three tasks are performed on the S1 // Projects tab. 

 

See The S1 // Projects Tab for more information about this tab. 

Optional steps prior to importing include:  

 Add snapshots. 

 Convert snapshots to projects. 

 Merge multiple data sources into a single dataset. 

 Filter project data prior to import. 

Acumen Workbooks 
Workbooks are the core files within Acumen. They contain all analysis information including: 

 Imported project data 

 Metric libraries and metrics 

 Analysis Views 

 Custom field mappings 

A single workbook can contain multiple analysis views. For example, you may have an analysis 
view designed for cost analysis and a second analysis view for risk exposure analysis in the 
same workbook. 

When you open or create a workbook, it displays on the S1 // Projects tab in the Projects pane. 
The default file name for a new workbook is Workbook1 (0). When you save the workbook, the 
name in the Projects pane changes accordingly. The number in parenthesis next to the workbook 
name indicates the number of activities that are contained within the workbook. A new workbook 
contains no activities until you link to an external data source and import a project.  

Workbooks are stored as single files, either on a local or network drive.   

 

Only one workbook can be open at a time within Acumen. 

Integrate With Project Management Platforms 
Acumen integrates with multiple project management platforms. Each Acumen workbook can 
contain projects from any of the following platforms: 
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 MS Project, MS Project Server 

 Primavera P6 

 Primavera P3 

 Oracle Pertmaster/Risk Analysis 

 Asta PowerProject 

 UN/CEFACT XML 

 Deltek Open Plan® 

 Deltek Cobra® (Earned Value) 

 Deltek Risk+ 

 ARES PRISM G2 

 Phoenix Project Manager 

 Safran Project 5 

In addition, Acumen provides flexible customizable integration with MS Excel. The Excel 
integration enables you to import data in almost any format from an Excel spreadsheet. 

You can analyze data from any discipline (for example, cost, schedule, risk, earned value, 
performance) within Acumen. 

 

See Appendix A: External Data Sources to see specific setup information and steps for each 
external data source. 

Workbook File Format 
Acumen workbooks use the standard file format; a proprietary, high-performance format that is 
the recommended format for analyzing large project files. Standard files have an .afw file suffix. 
You can share these files via file sharing, e-mail, and so on, but the content of the file cannot be 
edited outside of Acumen.  

Set the Default Workbook Folder 

To set the default workbook folder, complete the following steps: 

1. Click . 

2. At the bottom of the pane, click Deltek Acumen Options. 

3. On the General tab, in the Folders, Libraries and Templates group Default Workbook 
Folder field, browse to and select the default folder. 

4. Click OK. 

Create a New Workbook 

To create a new workbook, complete the following steps: 

1. Click . 

2. In the drop-down menu, click New. 

If you already have a workbook open, you will be asked if you want to save the open 
workbook before your new workbook is created.  

Acumen adds a new workbook, titled Workbook1 (0), to the S1 // Projects tab Projects 
pane.  

Open an Existing Workbook 

To open an existing workbook, complete the following steps: 
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1. Click . 

2. In the drop-down menu, click Open. 

3. In the Open dialog box, browse for and select the workbook. 

Only one workbook can be open at a time. If you already have a workbook open, you will 
be asked if you want to save the open workbook before you open a different one.  

Acumen adds the workbook to the S1 // Projects tab Projects pane. The number in 
parenthesis indicates the number of activities that are contained within the workbook. 

Save a Workbook 

To save a workbook, complete the following steps: 

1. Click . 

2. In the drop-down menu, do one of the following: 

 If this is an existing workbook, click Save. 

 If this is a new workbook, click Save or Save As. In the Save As dialog box: 

a. Navigate to your preferred folder. 

b. In the File name field, enter a name for the workbook. 

c. Click Save. 

The name of the workbook in the S1 // Projects tab Projects pane changes to the new file 
name. 

Link To External Data Sources  
After you have created a new workbook, you can link to external data sources using the Get 
External Data From menu on the S1 // Projects tab. You create links and mappings between your 
workbook and one or more data sources in order to determine the project data source. Linking is 
the precursor step to importing the data. 

A workbook can have an unlimited number of links to external sources. After an external source is 
linked, default field mappings are applied between the source data and the Acumen workbook. 
These mappings are fully configurable. 

 

 See Appendix A: External Data Sources for specific setup and linking information for each 
data source. 

 See Custom Field Mappings for field mapping information. 

 See Customize the “Get External Data From” Menu for more information. 

Project and Snapshot Links 
Links to data sources can either be projects or snapshots within a workbook. During an analysis, 
it is often useful to reference summated values within a workbook; for example, total workbook 
cost or duration. If the workbook contains different projects, then such a summation is 
straightforward. However, if the workbook contains, for example, two versions of the same 
project, then it is not valid to assume that the total workbook cost is the sum of both projects.  

By flagging a project as being a project or a snapshot of a parent project, the analysis engine is 
able to correctly calculate workbook level totals. 
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A project link is the most common type of link within a workbook. A project link treats the linked 
data as a normal project, including all data in workbook summary calculations. 

Snapshots are versions of a project file. This enables comparisons between versions of a single 
project file to be carried out without accidental ‘double-dipping’ of data during analysis. Snapshot 
links belong to project links and cannot exist outside of a project link. A snapshot link is used to 
flag the project data as being a version of the parent project. Not all the data from a snapshot-
linked project gets rolled up to the workbook level when the analysis engine calculates workbook-
level metrics. 

A snapshot of a project does not have to originate from the same source type as that of its parent 
project. For example, your current schedule may be stored in Primavera P6 whereas a previous 
version of the project may have been created, and linked to in Acumen, in MS Project. 

A project can contain one or more snapshots and a workbook can contain one or more projects. 

 

Create a Project Link 

 

The steps below are general steps for linking to an external data project. See Appendix A: 
External Data Sources for specific setup information and steps for each data source. 

To create a project link in a workbook, complete the following steps: 

1. Click . 

2. Click Open to open an existing workbook or click New to create a new workbook. 

3. In the Get External Data From menu, select the project data type. 

 

Depending on the data source selected, you may need to click the down arrow next to 
the data source menu item and select an option. See Appendix A: External Data 
Sources for descriptions of the options specific to each data source. 

4. In the Open dialog box, select the project(s) to which you want to link and click Open. 

 Select a project file, then hold down SHIFT to select multiple contiguous project files.  

 Select a project file, then hold down CTRL to select multiple non-contiguous project 
files.  

Snapshots 

Project 

Workbook 
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The projects are listed in the Projects pane under the workbook. The zero in parenthesis 
to the right of each project tells you that no activities have been imported yet for that 
project. This number will change when you import your project data. 

The checkbox next to each project indicates whether the project is included or excluded 
from ribbon analysis.  

 

See Include/Exclude Projects from Analysis for more information. 

5. If needed, repeat steps 3 and 4 to add additional project links to the workbook. 

6. After you add your project links, you can choose to: 

 Add snapshots. 

 Convert snapshots to projects. 

 Merge multiple data sources into a single dataset. 

Steps for the above processes are listed below. 

 

You can add and convert snapshots and merge data sources at any time, before and 
after you import your data. 

When you are done, your next step is to import your project data. 

Add a Snapshot to a Project 

To add a snapshot to an existing project, complete the following steps:  

1. Select the S1 // Projects tab. 

2. In the Projects pane, select the project to which you want to add a snapshot. 

 

By selecting a project in the list of projects prior to linking to a new source, you are 
automatically designating the newly linked project to be a (child) snapshot of the 
selected project. 

3. In the Get External Data From menu, select the project data type. 

 

The steps from this point are the same as when you link a project to workbook. See 
the Create a Project Link topic above for steps. 

Convert a Snapshot to a Project 

To promote a snapshot to become its own project, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Projects pane, select the snapshot. 

3. In the Editing menu, click Convert Snapshot to Project. 

Merge Multiple Data Sources into a Single Dataset  
Acumen includes a utility for merging datasets from different sources into a single set of data that 
can subsequently be analyzed. You can use this integration feature to combine cost and 
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schedule information. For example, Acumen can merge a cost estimate from Excel with a 
schedule created in MS Project or Primavera.  

Non-standard fields can also be imported/merged by drag-dropping the merge fields into the 
Acumen field list in the field mapping view. Available mapped fields are displayed in the source 
field list highlighted in green. The merge file must have a column called ID in order to bind the 
merge data with activities in the Acumen workbook. 

 

 

 

 

To create a merge file, complete the following steps: 
1. Select the S1 // Projects tab. 

2. In the Projects pane, select the project or snapshot file to which you want to merge data.  

3. Right click on the project and select Merge with Excel File.  

4. In the Add File dialog box, select the Excel file and click Open. 

5. In the Excel Merge dialog box: 

a. Select the worksheet you want to merge with the project. 

b. Select the column that matches the ID field in your project. 

Mapping Merge 
File Fields 

Schedule ribbons grouped by 
CAM and showing actual cost  
(both from merged XLS file) 

Source XLS cost data 
containing Actual 

Cost and CAM owner 
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c. Click OK. 

6. In the Import menu, click the Import All Projects down arrow and select Import Project 
to complete the merge. 

The data merge occurs when the parent project data is imported into Acumen. After it is merged, 
the combined dataset can be exported from Acumen using the Export to Excel button in the 
project workbook view. 

Merging is not limited to cost/schedule. Any dataset that has an ID structure that corresponds 
with the activity IDs in the main dataset can be merged. If the field headings in the XLS merge file 
correspond to field names in the Acumen file, they will be auto-mapped (merged).  

Import Project Data 
After you have defined your workbook by linking projects and adding snapshots, you are ready to 
import the data. You can choose to import all data in a workbook, or only certain projects. 

 

Importing project data will override any existing versions of previously imported data for the 
project(s) in question. 

After import, the project data is stored within the Acumen workbook. Subsequent importing is not 
necessary to conduct repeated analysis. Reimporting is only required if you want to analyze 
newly updated data that has changed in the source application. 

Filter Project Data Prior to Import 
When importing project data, you can use the Import menu Filters feature to filter the type of 
information that is imported into your Acumen workbook. Filters can be applied based on: 

 Activity type — Normal, milestone, summary, Level of Effort (LOE) 

 Status — Complete, in progress, planned 

 Resource assignments 

You can apply different filters to each project or snapshot within a workbook. 

To import all projects in the workbook, complete the following steps: 

1. Select the S1 // Projects tab. 

2. (Optional) In the Projects pane, select a project/snapshot and apply filters. 

a. In the Import menu, click Filters. 

b. Deselect any filters that you don’t want applied to the imported data for the 
selected project. 

c. Repeat step 2 for each project to which you want to add a filter. 

3. In the Import menu, click Import All Projects. 

The data is imported and the number in parenthesis to the right of each project displays 
the number of activities that have been imported for each project.  

To import a single project or snapshot, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Projects pane, select the project or snapshot. 
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3. (Optional) In the Import menu, click Filters and deselect any filters that you don’t 
want applied to the imported data for the selected project. 

4. In the Import menu, click the Import All Projects down arrow and select Import 
Project. 

The data is imported and the number in parenthesis to the right of the project displays the 
number of activities that have been imported for that project. 
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View and Edit the Schedule 

The S1 // Projects Tab  
Use the S1 // Projects tab to: 

 Set up Acumen workbooks 

 Link to and import external data 

 Manipulate schedules 

 Create scenarios 

 

See Getting Started for information about Acumen workbooks, linking to external data sources, 
and importing projects. 

 
The S1 // Projects tab includes several areas and panes: 

 Projects Pane: 

 Workbook — Workbooks are the core files within Acumen. They contain all analysis 
information. See Acumen Workbooks for more information. 

 Project / Snapshot — Links to data sources can either be projects or snapshots 
within a workbook. A project link treats the linked data as a normal project, including 
all data in workbook summary calculations. A snapshot link is used to flag the project 
data as being a version of the parent project. See Link to External Data Sources for 
more information. 

 Activity View — The Activity view is the standard view after importing a project. This 
view displays all activities, grouped hierarchically by Work Breakdown Structure (WBS), 

Snapshot 

Activity View 
(imported data) 

Details Pane 

SmartGantt 

Workbook 

Project 
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along with each activity attribute including start/finish dates, remaining duration, calendar, 
and activity status. See Activity View for more information. 

 SmartGantt — The gantt chart view allows you to view metric results, activity progress, 
uncertainty settings, or modification such as activity acceleration, directly on the 
schedule. See SmartGantt for more information. 

 Details Pane — Use the tabs in the Details pane to view and edit project, activity, and 
WBS information. See Edit the Schedule Using the Details Pane for more information. 

Include/Exclude Projects from Analysis 
While an Acumen workbook can contain an unlimited number of projects and snapshots, you can 
control which of these projects/snapshots get included in analysis. Use the checkboxes to the 
right of the project icons in the projects pane to include/exclude projects from analysis. 

 

View Start and Finish Milestones 
If your scheduling tool differentiates between start and finish milestones, then when you import a 
project, Acumen maintains that differentiation for metric analysis. You can see whether a 
milestone is a start or finish milestone using the Activity Type Ex column.  

To add the Activity Type Ex column to see whether a milestone is a start or finish 
milestone, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Right-click on an activity column name and click Show Column Chooser.  

3. Drag the Activity Type Ex column from the Column Chooser list to the Activities pane 
and place it between two existing columns. 

 

Acumen will remember your selection and display this column the next time you view 
this project. 

4. Close Column Chooser. 

5. If you have activity milestones, and as long as your scheduling tool differentiates between 
start and finish milestones, this column will display Start Milestone or Finish Milestone. 

Customize the “Get External Data From” Menu 
You can add or remove icons in the Get External Data From menu so that you only see the 
import types that you need. The first time you access Acumen, an External Tools for Acumen 

Include/exclude 
projects from analysis 
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dialog box displays where you can select or deselect options. For subsequent changes, use 
Deltek Acumen Options. 

To add or remove icons from the Get External Data From menu, complete the following 
steps: 

1. Log into Acumen. 

2. Click . 

3. Click Deltek Acumen Options. 

4. Select the User Interface tab. 

5. In the Fluent UI group, use the checkboxes to select or deselect a tool. If you deselect it, 
the tool icon will not display in the Get External Data From group. 

6. Click OK. 

Set Display Units 
Workbook duration and work data can be displayed in either days or hours. Irrespective of the 
display units selected, the analysis engine will always calculate results to the nearest minute.  

In addition, you can set the default duration per time period. This is used when converting the 
default duration units for displaying durations in Acumen. 

The Display Settings menu includes the following options: 

 Duration Time Unit — Hours or Days (default) 

When Acumen imports or exports a risk register, the activity duration field units display in 
the unit that you have set in this field. 

 

See Import and Export Risk Registers for more information. 

 Work Time Unit — Hours (default) or Days 

 Hour Per Time Unit — Hours/Day (default is 8) 

 Elapsed Durations Time Unit — Hours, Days, Weeks (default) 

 Culture — Currency Symbol (default is $) 

To set the display units, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Activities menu, click the Activity View down arrow and click (or hover over) 
Display Settings.  

3. Select or change settings as needed. The information is saved as soon as you enter it.  

Activity View 
The Activity view is the standard view after importing a project. This view displays all activities, 
grouped hierarchically by Work Breakdown Structure (WBS), along with each activity attribute 
including start/finish dates, remaining duration, calendar, and activity status. Use the scroll bar at 
the bottom of the screen to view all of the details for each activity or group of activities.  
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External Activities 
If you have imported external activities from Microsoft Project, they display in gray. If you select 
one, you can see the predecessor/successor information on the Activity Relationships tab. 

 

See Import External Activities in Appendix A: External Data Sources for more information. 

Calibration 
Each activity row includes a duration calibration slider.  

 
By default these sliders have 6 calibration levels:  

 Off — No calibration applied 

 Dark Green — Requires Much Less Time 

 Light Green — Requires Less Time 

 Yellow — Realistic 

 Orange —Requires More Time 

 Red — Requires Much More Time 

Padlock 

You can use the padlock to the left of the calibration slider to lock the setting for that activity. 
When you move the calibration slider for a parent activity, the sliders for any child activities that 
are not locked will move to the same location as the parent activity. Those activities that are 
locked will remain where they are.  

Scenarios 
You can only use calibration on scenarios.  

To create a scenario, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Select a project in the Projects pane for which you want to create a scenario.  

3. In the Scenario Generation menu, click the Scenario Calibration down-arrow then click 
Create Scenario. 

You can change the calibration levels by completing the following steps: 

1. Select the S1 // Projects tab. 

2. In the Scenario Generation menu, click Scenario Calibration » Calibration Template. 
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3. Use the Calibration Template Editor to edit the settings/levels. 

 

 

See Use Calibration to Manipulate the Schedule for more information about calibration. 

 

Activity Grouping 

To group activities, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Activities menu, click the Activity View drop-down arrow and select Grouping.  

 
3. Select the grouping type:  

 Group by WBS — This option displays the activities by the project WBS hierarchy.  

 



View and Edit the Schedule 

 

User Guide 29 

 

 Group by Fields — Grouping by fields allows you to create a structure based on 
existing fields within your project file. For example, you could view all critical activities 
within a certain contractor by first grouping by Critical/Non-Critical and then by 
Contractor. The screenshot below shows the view grouped by critical/non-critical and 
then by WBS.  

 

To ungroup activities, complete the following steps: 
1. Select the S1 // Projects tab. 

2. In the Activities menu, click the Activity View drop-down arrow and select Grouping.  

3. Click Flat. 

Expand or Collapse Activity Groupings 
Expand or collapse the groupings by using the + or – signs to the left of each row. To expand or 
collapse the entire project at once, use the Display Level slider (Activity View » Grouping).  
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Add or Remove Columns 
You can add or remove columns by right-clicking on any column header and selecting Show 
Column Chooser. In the Column Chooser, click the column you want to add and drag and drop it 
onto the view.  

 

Change Time Now and Update Progress 
You can use the Time Now field on the Details pane Status tab to change Time Now and update 
activity progress. 

To change Time Now, complete the following steps: 

1. Select the S1 // Projects tab 

2. Select a project in the Activities view. 

3. In the Details pane, on the Status tab, click the ellipses in the Time Now field. 

4. In the Change Time Now and Update Progress dialog box: 

a. Click the Time Now drop-down arrow to select a different Time Now. 

b. In the Activity Progress group, select whether you want to automatically 
progress work as planned or reschedule uncompleted work to start after Time 
Now. 

c. Click OK. 

Time Now changes and activities are progressed according to your selections. 

Change the Work Breakdown Structure of an Activity 
To change the Work Breakdown Structure of any activity, you must first group activities by WBS 
then drag and drop the activity into the appropriate WBS grouping. 
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SmartGantt 
In the Activity view, on the right side of the screen, the project displays as a Gantt chart, called 
the SmartGantt™. The gantt chart view allows you to view metric results, activity progress, 
uncertainty settings, or modification such as activity acceleration, directly on the schedule. 

You can resize the gantt chart by clicking on the left hand border of the Gantt column header and 
dragging to the left/right.  

 

Top and Bottom Activity Bars 
The SmartGantt can display a single bar (top bar) for each activity or two bars for multiple activity 
attributes. You can also set different options for each bar. 

 

See SmartGantt Options for more information about the options and how to set them. 

To display a second (bottom) bar on the gantt chart, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Activities menu, click the SmartGantt drop-down arrow. 

3. Click the Bottom Bar menu option. The bottom bar menu item  is highlighted and the 
bottom bar for each activity displays in the gantt chart. 

To remove the second (bottom) bar from the gantt chart, complete the following steps: 
1. Select the S1 // Projects tab. 

2. In the Activities menu, click the SmartGantt drop-down arrow. 

3. Click the Bottom Bar menu option. The bottom bar for each activity no longer displays in 
the gantt chart. 

Drag to resize the 
Gantt chart 
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SmartGantt Options 
The SmartGantt options allow you to specify how the top and bottom bars display. You can 
access them from the SmartGantt drop-down menu or by using the SmartGantt Configuration 
dialog box.  

 The SmartGantt Menu — The Top Bar and Bottom Bar menu items display the current 
SmartGantt options. When you hover over either of these menu items, a secondary drop-
down menu displays where you can change the options.  

The example below shows that the top bar has been set to display scheduled dates with 
each activity color based on schedule quality. The bottom bar has been set to display 
baseline dates with each activity color based on historical performance.  

 
 The SmartGantt Configuration Dialog Box — The SmartGantt Configuration dialog box 

includes the following tabs: 

 Top Bar Color — This tab includes schedule and risk mode options and color 
mapping options for the top SmartGantt bar. 

 Bottom Bar Color — This tab includes schedule and risk mode options and color 
mapping options for the bottom SmartGantt bar. It also includes an option to enable 
the bottom bar which must be selected in order to use the options on this tab. 

 Top Bar Date — This tab includes date mode options and progress and float options 
for the top SmartGantt bar. 

 Bottom Bar Date — This tab includes date mode options and progress and float 
options for the bottom SmartGantt bar. It also includes an option to enable the bottom 
bar which must be selected in order to use the options on this tab. 

 Filters — This tab allows you to rename or delete custom filters. 

 

See Filter Activities for more information and steps. 

To access the SmartGantt options from the SmartGantt drop-down menu, complete the 
following steps: 

1. Select the S1 // Projects tab. 

2. In the Activities group menu, click the SmartGantt drop-down arrow. 
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3. Hover over the Top Bar or Bottom Bar option to display a drop-down menu. 

The menu options are the same for both the Top Bar and Bottom Bar. 

 

If you do not have the bottom bar selected to display, it will display as soon as you 
select an option in its menu. 

To access the SmartGantt options from the SmartGantt Configuration dialog box, 
complete the following steps: 

1. Select the S1 // Projects tab. 

2. Click the Activities group menu drop-down arrow to display the SmartGantt Configuration 
dialog box. 

The dialog box also displays when you select the Metrics or Field color option from the 
SmartGantt drop-down menu. 

The SmartGantt options are described in the following table.  

SmartGantt 
Option 

Description 

Dates Select which date to display on the SmartGantt.  

 Scheduled —Current dates for the activities as defined in the schedule.  

 Early —Earliest possible date that the activity can start.  

 Late —Latest possible date that the activity can start.  

 Baseline —Dates defined by the project baseline.  

 Original —Dates as defined in the schedule prior to any modifications 
such as acceleration.  

 Px Dates — Probabilistic or risk-adjusted dates identified during a project 
risk analysis.  

Color Select color settings for the activities displayed in SmartGantt. 

 Critical/Non Critical — Show critical activities in red and non-critical 
activities in blue.  

 Schedule Quality — Show color based on the Fuse Schedule Index. 
Activities in red are poorly planned (include errors such as missing logic, 
negative float or insufficient detail) while activities in green are well 
planned. Yellow or orange activities fall somewhere in-between.  

 Historical Performance — Show color based on the historical 
performance of each activity. Activities that have been performing poorly 
are shown in red. Activities that are on time and on budget are shown in 
green. Yellow or orange activities fall somewhere in-between.  

 Metrics — Show color based on a certain metric from a Fuse analysis. 
Each activity will be colored based on the thresholds defined by the metric. 
When you select this option, the SmartGantt Configuration dialog box 
displays. Use the dropdown arrow next to the Metric field on the 
Top/Bottom Bar Color tab to select a metric.  

 Field — When you select this option, the SmartGantt Configuration dialog 
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SmartGantt 
Option 

Description 

box displays. Use the dropdown arrow next to the Field field on the 
Top/Bottom Bar Color tab to select a field such as Activity Status (or any 
user-defined field) to use as the basis for coloring each activity. After a field 
is selected, use the Color Mapping area to define the color mapping.  

 Adviser / Schedule Realism Adviser — Color each activity based on 
suggestions from the Schedule Realism Adviser™.  

 

See Schedule Remediation and Acceleration Using Acumen 360 for 
more information about the Schedule Realism Advisor. 

 Risk Inputs — Color activities based on the uncertainty inputs defined 
during a risk analysis. This option is only available with Acumen Risk.  

 Duration Uncertainty — Color each activity based on the Duration 
Uncertainty assigned in Acumen Risk. The colors are defined in the 
Uncertainty Template found on the S3 // Risk tab.  

 Cost Uncertainty — Color each activity based on the Cost 
Uncertainty assigned in Acumen Risk. The colors are defined in the 
Uncertainty Template found on the S3 // Risk tab.  

 

See Risk Inputs for more information on uncertainty assignments in 
Acumen Risk. See The Uncertainty Factor Template for more 
information about the template. 

 Risk Outputs — The Risk Output options for coloring activities in the 
SmartGantt are only available with Acumen Risk. A risk analysis must be 
performed first in order to use these options.  

 Criticality — Color based on how many times the activity fell on the 
critical path during risk analysis. Red activities have a higher criticality 
while green activities have a lower criticality. Yellow or orange 
activities fall somewhere in the middle.  

 Duration Contribution — Color the activities based on how much or 
how little they impact the risk-adjusted project finish date. Red 
activities have a higher impact on project finish while green activities 
have a lower impact. Yellow or orange activities fall somewhere in the 
middle.  

 Risk Range Factor — Color the activities based on Acumen Risk’s 
simulation of the impact of risk events on the schedule.  

 Acceleration — Color activities based on the acceleration calibration 
settings. This option is only available with Deltek Acumen 360. The color 
settings for this option are defined in the calibration template.  

 

 See Interactive Acceleration for more information on calibration.  

 See Calibration for more information about the calibration 
template. 

 

Display 
Progress 

Select this option to show progress of each activity. A dark line will be added to 
the activity bar to display activity progress. For example, an activity with 50% 
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SmartGantt 
Option 

Description 

completion looks like this:  

Display 
Float 

Select this option to display the amount of float on each activity. A black line is 
added below the activity to indicate positive float. A red line below the activity 
shows negative float.  

 

Edit the Schedule Using the Details Pane 
Many features of the schedule can be modified directly within the Acumen software suite. Use the 
tabs in the Details pane to view and edit project, activity, and WBS information. The tabs and 
information that displays varies depending on your selection in the Activity View.  

Deltek recommends that you create a scenario prior to making any edits to the schedule.  

 

See Schedule Remediation and Acceleration Using Acumen 360 for more information on 
scenarios. 

 
The Details Pane tabsincludes the following tabs: 

 General — This tab includes information about the project, including the project name, 
platform, date it was created, and calendar. 

Modify activity 
details 
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 Status — Use this tab to update activity status, suspend or resume an activity, and add 
or remove constraints. 

 Relationships — Use this tab to change the relationship type of any activity or 
add/remove a relationship. Predecessor activities display on the left and any successor 
activities display on the right. 

 
 Duration Uncertainty — This tab displays remaining duration and risk notes. 

 

See Risk Inputs for more information about duration uncertainty. 

 Costs — This tab displays the total, actual, and remaining cost for the line selected in the 
Activity View. 

 Resource Assignments — This tab displays information about the assigned resources 
for the selected activity. 

 Risk Events — This tab displays information about any risk events that have been 
mapped to the selected activity. 

 

See Map Risk Events to Activities for more information. 

 Settings — This tab displays the float type, scheduling mode, and critical activity 
definition information for the line selected in the Activity View. 

 Acceleration — If you accelerate the project by clicking Accelerate Schedule in the 
Scenario Generation group, this tab is added to the Details pane. It includes information 
about the script used, targeted goal, total acceleration, and a graphical representation of 
how the acceleration changes the project dates. 

 

See Schedule Remediation and Acceleration Using Acumen 360 for more information 
on scenarios. 

Filter Activities 
You can create filters for the Activities View and SmartGantt using metrics or during forensic 
analysis. You can also create an activity filter using critical path data. 

 

See Create a SmartGantt Filter Using Critical Path Data for more information. 

After the filters have been created, you can apply them to the listed activities. 
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Create a Filter Using Metrics 
Any metric within Acumen can be used to create a filter for the activities view and SmartGantt.  

To create a filter using metrics, complete the following steps: 
1. Select the S2 // Diagnostics tab. 

2. Click on a metric result at the bottom of the window.  

 

See Manage Metrics for more information about metrics. 

3. In the Activity browser toolbar, click the  SmartGantt filter.  

 
4. Enter a name for the filter. 

Create a Filter Using Forensics 
Create a filter for the Activities View and SmartGantt using activities identified during a Forensic 
Analysis.  

 

For more information on forensic analysis, see Using Forensics to Identify Additions, Deletions, 
and Modifications. 

To create a filter using forensics, complete the following steps: 
1. Select the Forensics tab. 

2. In the SmartGantt menu, click Create SmartGantt Filter to create a filter for the listed 
activities. 

Click the 
SmartGantt filter. 
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3. Enter a filter name. 

 
4. Select the S1 // Projects tab. 

5. In the Activities menu, click Activity View » Filtering » <Select the newly created 
filter>. 

The activities as well as the SmartGantt are removed from the list. 

Apply a Filter to the Activity View 

To apply a filter to the Activity View, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Activities menu, click the Activity View drop-down menu and select Filtering » 
<Select a filter>. 

Clear the Activity View Applied Filter 

To clear filters applied to the Activity View, complete the following steps: 
1. Select the S1 // Projects tab. 

2. In the Activities menu, click the Activity View drop-down menu and select Filtering » 
None. 

Rename or Delete a Filter 

To delete a filter from the Activity View filters list, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Click the Activities group menu drop-down arrow to display the SmartGantt Configuration 
dialog box. 

3. Select the Filter tab. 

4. Click on a filter name. 

5. Do one of the following: 

 Edit the name. 

 Click Delete to delete the filter. 
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6. Click OK. 

 

See SmartGantt Options for more information about the SmarGantt Configuration dialog box. 

Timeline View 
Select activities can be added to a graphical timeline view on the projects tab. This is useful when 
looking at the big picture within a project as well as comparing a project to its respective 
snapshots or scenarios. 

The Timeline View menu includes the following options that you can apply in the Timeline View: 

 Activity Titles — Select this option to display the title for each activity on the timeline. 
The information that you display as title depends on the option that you select in the 
Activity Title Display Mode menu option. 

 Different Colors — Select this option to use colors to differentiate between activities. 

 Copy to Clipboard — Select this option to copy the timeline view to the clipboard. You 
can then paste the view into a different application or email. 

 Activity Title Display Mode — Use these options to specify the information to be 
included in the activity title. You can specify whether you want to display the ID and/or 
description for each activity on the timeline. This only becomes applicable when you 
select the Activity Titles option. 

To add activities to the timeline view and view them, complete the following steps: 
1. Select the S1 // Projects tab. 

2. In the Activities menu, click Activity View. 

3. To assign activities to the timeline, do one of the following: 

 To select individual activities, use the checkboxes in the Activity View list.  

 To select groups of activities, first create groups. 

 

See Activity Grouping for more information. 

 To select all activities within a group, select the group heading or parent.  

 

Select the parent activity to 
add that entire group of 

activities to the timeline view 

Use the check boxes to 
select activities to show 

in the timeline view 
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4. In the Activities menu, click Timeline View.  

Each project/snapshot/scenario is shown in its own timeline.  

5. (Optional) In the Activities menu, click the Timeline View drop-down arrow to access the 
Timeline View options.  

6. To scale or zoom, click and drag the left / right bar on the zoom feature at the bottom of 
the view. 

 

Create a New Cost Estimate 
You can create a new cost estimate directly within Acumen Risk in order to perform a cost risk 
analysis. 

 

You can create a new cost estimate on the S1 // Projects tab as well as the S3 // Risks tab. 
See Cost Risk Analysis for more information. 

To create a new cost estimate directly within Acumen, complete the following steps:  
1. Select the S1 // Projects tab. 

2. In the Get External Data From menu, select the Microsoft Excel drop-down arrow and 
click Create Cost Estimate.  

 

Click and drag the left / right 
bar to scale or zoom 
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This opens a new cost estimate which will automatically be populated with a single 
activity called New Activity.  

3. Edit the activity name and details directly in this view or by using the fields in the Activity 
Details Pane.  

 

See Edit the Schedule Using the Details Pane for more information. 

Add New Activities to a Cost Estimate 

To add a new activity to the cost estimate, complete one of the following steps: 

 In the Editing menu, click Add Activity. 

 Right-click on any row in the Activities View and click Add Activity.  

Organize Cost Estimate Activities into a Hierarchy or Cost Breakdown 
Structure 
Activities in a cost estimate can be dragged and dropped to create a Cost Breakdown Structure 
or other hierarchy within the cost estimate. Select any activity or row within the activities view and 
drag and drop it into the desired grouping.  

In the example below, New Activity 5 was dragged onto the row titled Parent 2. This makes New 
Activity 5 a child of Parent 2.  

 
You can create any number of hierarchical levels or groups in the cost estimate.  

New Activity 5 is now 
a child of Parent 2 
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In the example below, New Activity 5 has been turned into a parent activity by adding a new 
activity (New Activity 6) and dragging it onto the New Activity 5 row.  

 
Any time an activity, or group of activities, is dragged onto another row, it becomes a child of that 
row. 

New Activity 5 is now a 
parent to New Activity 6 
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Export (Publish) Acumen Projects 
The table below lists the formats to which you can export (publish) your Acumen projects. 

Acumen Project Format Available Export Formats Notes 

Microsoft Project MPP  Excel XLS 

 UN/CEFACT XML 

 Microsoft Project MPP 

 Oracle Primavera P6 XER 

You must have Microsoft Project 
installed on your machine if 
exporting to Microsoft Project 
MPP. 

Microsoft Project XML  Excel XLS 

 UN/CEFACT XML 

 Oracle Primavera P6 XER 

 

Oracle Primavera P6 XER  Excel XLS 

 UN/CEFACT XML 

 Microsoft Project XML 

 Oracle Primavera P6 XER 

You can only export to Oracle 
Primavera P6 XER format if you 
export an Acumen scenario. The 
option is grayed out for projects. 

Microsoft Excel   Excel XLS  

Deltek Open Plan  Excel XLS 

 UN/CEFACT XML 

 Oracle Primavera P6 XER 

 

Phoenix Project Manager  Excel XLS 

 UN/CEFACT XML 

 Microsoft Project XML 

 Oracle Primavera P6 XER 

 

Asta Powerproject  Excel XLS 

 UN/CEFACT XML 
 

UN/CEFACT XML  Excel XLS 

 UN/CEFACT XML 

 Microsoft Project XML 

 Oracle Primavera P6 XER 

 

Safran Project  Excel XLS 

 UN/CEFACT XML 

 Microsoft Project XML 

 Oracle Primavera P6 XER 
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Print and Export 
In addition to publishing your project, you can use the Print and Export option to export the 
information as it is currently displayed in the Activities View.  When you select this option, a Print 
Preview window displays. You can use this window to search the data, open or save a file, and 
select the export format, among other things. The following file formats are available: 

 PDF 

 HTML 

 MHT 

 RTF 

 XLS 

 CSV 

 Text 

 Image 

 XPS 

To export an Acumen project, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Projects pane, select the project that you want to export. 

3. In the Publish menu, click the Publish down-arrow and select the format to which you 
want to export. 
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Run Diagnostics with Acumen Fuse 
Acumen Fuse is a project diagnostic tool that pinpoints and resolves schedule shortcomings, 
helping to ensure a sound basis of schedule and a successful execution. 

The S2 // Diagnostics Tab 
Use the Diagnostics tab to:  

 Analyze a single project 

 Compare multiple projects within a program/portfolio 

 Run trend analysis of a single project over time 

 
The S2 // Diagnostics tab includes several areas and panes: 

 Ribbons — Ribbons are groupings of activities based on a given criteria. See Ribbon 
Analysis for more information. 

 Phases — Phases are user-definable ‘segments’ of time against which an Acumen Fuse 
analysis is run. See Phases for more information. 

 Ribbon Analyzer — The ribbon analyzer shows the results from an analysis for each 
ribbon. See Ribbon Analyzer for more information. 

 Phase Analyzer — The phase analyzer shows the results from an Acumen Fuse 
analysis for each phase. See Phase Analyzer for more information. 

 Activity Browser — The Activity Browser lists specific activities based on a given 
criteria. See Use the Activity Browser for more information. 

Phases Ribbons 

Phase 
Analyzer 

Ribbon 
Analyzer 

Activity 
Browser 
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The Executive Briefing Report 
The Executive Briefing report consolidates information and results that have been generated from 
an analysis, and presents them in a descriptive briefing without the need for manual interpretation 
of the data.  

You can run this report from the Publish menu on the S2 // Diagnostics tab. 

 

See Executive Briefing in the Reporting Diagnostics Results section of this guide for more 
information. 

Use Acumen for Project Analysis 
Acumen uses a combination of ribbons and metrics to run a project analysis. The Acumen engine 
analyses projects in three dimensions. The table below summarizes each analysis type.  

Analysis Type Summary Details 

Ribbon Analysis Cross ribbon 
comparison 

Metric analysis by ribbon enabling cross-
ribbon comparisons to be drawn. The 
ribbon analyzer tells you which group of 
activities (Critical or Non-Critical) has 
missing logic. 

See Ribbons for more information. 

Phase Analysis Cross phase 
comparison 

Metric analysis by phase enabling cross-
phase comparisons to be drawn. Trending 
can also be carried out. 

See Phases for more information. 

Intersection Analysis Specific ribbon/phase 
analysis 

Metric analysis for a specific ribbon/phase 
intersection enabling pinpointing of project 
hot spots and problem areas. 

See Intersection Analysis for more 
information. 

Trend Analysis Specific project 
snapshots 

Metric analysis for multiple project 
snapshots across ribbons.  

See Trend Analysis for more information. 

As well as calculating metrics, Acumen Fuse analysis also determines whether or not defined 
tripwire thresholds have been triggered.  

 

See Tripwires for more information. 

In the example below, the “Missing Logic” metric is being applied to a project.  

 The ribbon analyzer tells you which group of activities (Critical or Non-Critical) has 
missing logic. 

 The phase analyzer tells you which time period contains the activities with missing logic. 
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 The intersection analyzer pinpoints the path and phase. 

 
You can use the Activity Browser to pinpoint which activity(s) are causing the metric tripwire to 
trigger. The Activity Browser shows activities based on which ribbon, phase, or intersection you 
click on.  

 
The Acumen Fuse analysis engine can analyze across multiple phases as well as segment data 
by ribbon. The analysis engine automatically calculates duration, cost, and work across phase 
boundaries and spreads values accordingly.  

For example, a 60-day activity starting on January 1 will automatically be segmented into 31 days 
in January, 28 days in February (assuming a non-leap year), and 1 day in March. The costs and 
work for this activity also get spread accordingly so that when the metric engine is run, results are 
not only analyzed for the ribbon as a whole but also within each individual phase.  

Similarly, the engine determines, for example, within which phase an activity starts. This in turn 
enables metrics, such as the number of activities starting within a particular fiscal reporting 
period, to be created. 

Activity 
Browser 

Ribbon 
Analyzer 

Phase 
Analyzer 

Intersection 
Analyzer 
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Ribbon Analysis 
Ribbons are groupings of activities based on a given criteria. You can use them to: 

 Slice and dice a project into meaningful groups of activities for analysis. 

 Flatten and simplify large amounts of project data. That is, reduce large numbers of 
activities to a more manageable number of ribbons. 

 Visualize activities based on common criteria (for example, activity attributes or network 
path). 

 
A ribbon can be created by something as simple as an activity attribute (for example, type of 
activity, contractor, or critical/non-critical), a WBS, or a resource, or it can be defined to represent 
a path through a network between two activities within a project. You can hide activities from 
within a ribbon. 

By default, ribbons are grouped by project; however, they can be grouped in multiple ways 
including activity attribute, resource, and path. If a workbook contains multiple projects, then a 
separate ribbon will display for each project.   

Ribbons are segmented by phases. Acumen Fuse analysis is conducted against ribbons. 

Example of Ribbon Analysis 
The example below shows a sample project created in MS Project that contains four activities 
and two parallel paths.  

 Activities A, C, and D all lie on the critical path.  

 Activity B contains float and is not on the critical path.  

 

Ribbons 
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At the summary level, you can create a single ribbon that contains all activities within the project. 
The example below shows a ribbon view of the same sample project where a single ribbon is 
created for the entire sample project.  

 
You may want to ribbonize based on whether or not an activity falls on the critical path. The 
example below shows the same sample project; this time ribbonized by Critical Path. By 
separating critical and non-critical activities, you are able to get a clearer insight into your project. 

 
You can take this a step further and create by work breakdown structures (WBS) as shown in the 
example below.  

 
Ribbonizing by various activity attributes and network paths allows you to run Acumen Fuse 
analytics in multiple dimensions, providing insight that is not easily available in traditional Gantt 
chart type reports. 



Run Diagnostics with Acumen Fuse 

 

User Guide 50 

 

Ribbon Analyzer 
The ribbon analyzer shows the results from an analysis for each ribbon. Multiple metrics can be 
added to the ribbon analyzer. The ribbon analyzer can be displayed as either a table or a chart. 

 

Ribbon Browser 
The ribbon browser is the core of the diagnostics tab and is highly customizable. Within the 
ribbon browser, you create ribbons, segment by phases, and apply metrics. 

 

Ribbon 
Browser 

Ribbon 
Analyzer 
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Smart-Filtering of Ribbons 
The Analysis view is a highly interactive view. As you click on the any of analyzer cells, the 
activities shown within the ribbons are automatically filtered to correspond to the activities in the 
activity browser.  

 

Use Ribbons to Group Activities 
You can group activities based on any attribute (for example, activity status, critical/non-critical, 
contractor). Ribbons can be created using one of four techniques: 

 Project/Snapshot Ribbons 

 Field-Based Ribbons 

 Resource Ribbons 

 WBS-Based Ribbons 

In all four instances, the purpose of creating ribbons is to slice and dice the project data in order 
to run a meaningful analysis.  

 

See Ribbon Analysis for more information about ribbons. 

Project/Snapshot Ribbons 
Project ribbons are the simplest types of ribbons. When you set the ribbon mode to 
Project/Snapshot, a separate ribbon is created for each project and/or snapshot within the 
workbook. In the case of a workbook containing a single project, a single ribbon is created. This is 
the default option when opening an analysis view. 

You can use project-based ribbons to run high level analysis against a project or portfolio without 
drilling down into specific activities or sections of the project(s).  

Smart filtering of 
activities based on 

analysis results 
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In the example below, the workbook contains multiple projects, each displayed as a separate 
ribbon. 

 

Field-Based Ribbons 
Field-based ribbons are very flexible in that ribbons can be defined through any of the imported 
activity fields. Common examples of field-based ribbons include: 

 Critical path — Compare analysis results between critical and non-critical activities. 

 Activity type — Differentiate between normal, summary, and milestone activities. 

Example of Selecting a Field-Based Ribbon 

 
In addition to defining ribbons by field, you can further define a field-based ribbon using one of the 
grouping types in S2 // Diagnostics » Ribbons » Fields: 

 Discrete — A separate ribbon is created for each field value. 

 Interval size — A variable number of ribbons each defined by a user selected size (for 
example, cost broken out into multiple ribbons in $50,000 intervals). 

 Number of Intervals — A fixed number of ribbons are created based on the selected 
number of intervals. This is useful if creating ribbons by a field that returns, for example, a 
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percentage. Creating ten intervals would result in ten ribbons representing 0 – 10%, 10 – 
20%, 20-30%, and so on, all the way to 90-100%. 

 Delimiter — Ribbons are created based on period delimiters. This is useful when 
needing to create ribbons from a WBS or a hierarchical code field that uses delimiters to 
designate separation of sections (and level) within a hierarchy. 

Resource Ribbons 
Resource ribbons provide a rotated view of a project from the perspective resources. By creating 
a separate ribbon per resource, you are able to see who is working on which activities and, more 
importantly, when. Resource-ribbons provide an excellent insight into cost/schedule performance. 
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WBS-Based Ribbons 
You can use WBS ribbons to group activities by any given level of a project WBS. This is very 
useful for comparing the quality and performance across WBS elements of a project as well as 
being able to conduct a project rollup at any level. 

 

Sorting Ribbons 
You can sort ribbons by metric results by right-clicking on the metric header and selecting the sort 
option. This is a good technique for prioritizing results once an analysis has been conducted. 

 

Filter and Drill Down Using Ribbons 
Ribbons can be used as a powerful means of filtering and drilling down into specific sections of 
an analysis. You can select any ribbon as a filter by double-clicking on the ribbon heading. This 
filters activities for that specific ribbon, and analysis and results then only pertain to the filtered 
data set. In addition, filter hierarchies can be created.  

In the example below, the data was ribbonized by location, and then filtered by a location called 
Domestic. It was further ribbonized by contractor, and then filtered by contractor ACom. Then it 
was ribbonized by activity status.  
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Navigation back up through the created hierarchy is straightforward using the vertical navigation 
strip on the left hand side of the screen. Clicking on the  Home button takes you back to the 
unfiltered set of data. 

Phases 
Phases are user-definable ‘segments’ of time against which an Acumen Fuse analysis is run. 
Phases can be weeks, days, months, quarters, years, custom periods, or the entire project 
duration.  

 
For a phase analysis, the Acumen Fuse engine calculates results across ribbons within a specific 
time slice or phase. This tends to be more complex than a ribbon analysis because activities may 
span multiple phases. 

In the example below, a simple project with three activities spans a four-week period. 

 

Analyze Within and Across Defined Phases 
When you analyze the data, and calculate two basic metrics (cost and schedule), the Acumen 
Fuse engine prorates both duration and cost based on how the activities span across the four 
periods. This makes phase-based analysis very powerful because you can analyze both within 

Phases 

Home button 
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and across defined phases, accounting for the amount of cost, duration, and work that falls into 
each phase.  

 

Phase Analyzer 
The phase analyzer shows the results from an Acumen Fuse analysis for each phase. You can 
add multiple metrics to the phase analyzer. The phase analyzer can be displayed as either a 
table or a chart. 

 

Define Date Ranges and Phases 
Ribbons are segmented by phases. Each phase is analyzed separately in the phase analyzer. 

By default, Acumen Fuse will create an analysis view that encapsulates the entire project. Phase 
definition is fully customizable. The start and end of the analysis view can be defined either by a 
specific date or event (for example, start of project or Time Now).  

Phase 
Analyzer 
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You can set phase intervals to days, weeks, months, quarters, years or single (representing the 
entire date range as a single phase). 

In addition, you can create custom phases through the use of the Phases » Add Phase menu 
item.  

 

Merge Phases 
You have the ability to merge phases. For example, two adjacent quarters can be merged into a 
single half-year segment. This is achieved by deleting a phase boundary.  

To merge phases, complete the following steps: 

1. Hover over the phase header until the Delete icon displays.  

2. Click Delete to remove the boundary and merge the two phases. 

  
Splitting 2010 and 2011 Phases Merged 2010 and 2011 Phases 

Click the Phases » Reset Dates menu item to reset the entire analysis view to include all 
activities. 

 

Zoom In and Out of Phases 
The analysis view provides a quick means of zooming in and out of phases.  

 To zoom into a phase, hover over the phase header and click on the magnifying glass 
icon.  

 To zoom out of a phase, hover over the Timeline header and click on the magnifying 
glass icon. 
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Intersection Analysis 
Intersection analysis only includes activities within a specific ribbon within a specific phase. The 
example below shows two activities in MS Project that overlap with respect to time.  

 
When Acumen analyzes the activities using two metrics (original duration and Total Cost), the 
assigned metric (Total Cost) for each intersection is calculated separately.  

 

Zooming within 
phases 
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Intersection Analyzer 
In addition to running an analysis against a ribbon or phase, Acumen Fuse also enables metric 
reporting against a single segment within the ribbon browser (that is, for a specific ribbon within a 
specific phase).  

 

Trend Analysis 
You can use the Acumen Fuse trend analysis feature to replace the traditional time-based phases 
in the diagnostics view with project snapshots.  

 

You need to have a project loaded with at least one snapshot to use this feature. 

Similar to a phase analysis, the Acumen Fuse engine calculates results across ribbons within 
each snapshot.  

Example of Trend Analysis 
The example below shows a trend analysis across the following project snapshots:  

 The initial plan 

 1-month update 

 6-month update  

 Current schedule 

The Total Activities metric has been added to the intersection analyzer and the activities have 
been grouped by status. In this view you can see the number of activities that are planned, in-
progress, or complete for each project snapshot.  

Intersection 
Analyzer 
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The Phase Analyzer shows the total metric result for each snapshot. 

 

Types of Analysis 
You can use Acumen Fuse to analyze one or more projects within a single workbook. Through 
the use of ribbons, you are able to perform three main types of analysis: 

 Single Project Analysis 

 Snapshot Comparison-Trending of a Project over Time  

 Multi-Project/Portfolio Analysis  

These are described in detail below. 

Single Project Analysis 
When a workbook contains a single project, you can generate ribbons as a single project ribbon 
or grouped by field, WBS, or resource. This type of analysis provides a huge amount of slice and 
dice flexibility within a single project. 

  
Single Project as a Project Ribbon Single Project Ribbonized by WBS 
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Snapshot Comparison-Trending of a Project over Time 
You can include multiple snapshots of the same project within a workbook in order to run 
comparisons against a given version of the same project.  

 

See Working with Acumen Workbooks for more information. 

To run such an analysis, include the multiple snapshots of the project in a single workbook and 
then ribbonize by project. This will result in a separate ribbon being created for each of the 
snapshots. You can then use metric analysis using all three analyzers in the usual way. 

Use the Ribbon and Intersection Analyzers to analyze the characteristics of the portfolio. 

 

See Ribbons and Intersection Analysis for more information. 

Multi-Project/Portfolio Analysis 
In a similar manner in which you can analyze multiple snapshots of the same project, you can 
ribbonize multiple projects within a given program or portfolio.  

Import multiple projects (even from multiple platforms) into a single workbook and ribbonize by 
project. Use the Ribbon, Phase, and Intersection Analyzers to analyze the characteristics of the 
portfolio. You can also use the Comparison Analyzer to compare metric results across projects. 

Example of the Portfolio Analysis Mode 
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Use the Activity Browser 
Use the Activity Browser to report specific activities based on a given criteria. The activities 
shown depend on which segment of the ribbon or analyzer windows are clicked. 

 
The activities that display can originate from any of the following: 

 Activities irrespective of Tripwire threshold: 

 A ribbon (cutting across multiple phases) — All activities for a given ribbon. 

 A phase (cutting across multiple ribbons) — All activities for a given phase. 

 An intersection — All activities for a given ribbon within a specific phase. 

 Activities that trigger a given tripwire threshold: 

 Ribbon metric results — Activities for a given metric segment within the ribbon 
analyzer. 

 Phase metric results — Activities for a given metric segment within the phase 
analyzer. 

 Intersection metric results — Activities for a given metric segment within the 
intersection analyzer. 

Action Analysis View Activity Browser 
Results 

Activities irrespective of Tripwire threshold 

Click on a ribbon 
description 

 
 

Shows all activities for 
the selected ribbon 

Activity 
Browser 
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Action Analysis View Activity Browser 
Results 

Click on a Phase 
Header 

 

Shows all activities for 
the selected phase. 

Click on a 
ribbon/phase 
intersection 

 

Shows all activities for 
the selected 
intersection. 

Activities that trigger a given tripwire threshold 

Click on a 
intersection 
metric  

Shows those activities 
for the selected 
intersection that 
triggered the tripwire. 

Click on a ribbon 
analyzer cell 

 

Shows those activities 
for the selected ribbon 
that triggered the 
tripwire. 

Click on a phase 
analyzer cell  

Shows those activities 
for the selected phase 
across all ribbons that 
triggered the tripwire. 

Display the Activity Browser 

To display the Activity Browser, complete the following steps: 
1. Select the S2 // Diagnostics tab. 

2. In the Analyze menu, click Fuse to calculate the metrics. 

 

If a metric does not have a tripwire formula defined, you cannot use the Activity 
Browser to view activities. See Tripwires for more information about tripwires and 
tripwire formulas. 

3. Select a project on the Timeline (top left quadrant of the screen). 

The Activity View populates with activity details for that project. 

You can also display a snapshot of the Activity Browser as a popup window. This is useful when 
reporting large quantities of data.  

To display a snapshot of the Activity Browser in a separate window, complete the 
following step: 

1. Select the S2 // Diagnostics tab. 
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2. In the Activity Browser Modes menu, click Undock.  

The results display in a separate window. 

Customize Columns 
You can use the field chooser to select the columns that display. In addition, you can change 
column order and adjust column width. Acumen saves your selections and the next time you view 
this project, your customized view displays. 

To select or remove columns, complete the following steps: 

1. In the Activity View, right-click on a column to view the field chooser. 

2. In the field chooser popup dialog box, click on column names to select or remove them. A 
selected column has a checkmark next to it. 

3. Click anywhere outside the popup dialog box to close it. 

To adjust column width, complete the following steps: 

1. In the Activity View, place your cursor between two columns. 

 
2. Drag left or right to adjust the width. 

To change column order, complete the following step: 

1. Click on a column and drag it left or right to the new location then release. 

Sort or Filter Activity List 

To sort the activity list, complete the following steps: 
1. Hover over the column name by for you want to filter to see the down arrow.  

2. Click on the down arrow to display the filter list.  
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3. Select all fields that should remain in the activity list. Click (Clear Filter) to clear all 
filtering. 

4. Click outside the popup dialog box to close it. Only the filters activities display. 

Set the View Options 
The Activity Browser can display activities in a tabular format, a Gantt chart, scorecard, or 
detailed view. Click on the Activity Browser View icons to toggle the view mode. 

You can select the Activity Browser Modes on the S2 // Diagnostics tab in the Activity Browser 
Modes menu. 

 

Activity Browser Formats 
You can display activities within the Activity Browser in one of five formats:  

Activity Browser 
Format 

Example 

Tabular mode 

 

Gantt mode 
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Activity Browser 
Format 

Example 

Heat map The heat map mode is an extremely powerful visual aid with regards to 
reporting results. A heat map report uses relative box size and color to 
distinguish various attributes of activities. Any activity attribute can be 
used to define box size, color, and grouping of heat maps charts.  

In addition, the number of activities shown in a heat map chart can be 
defined. 

The heat map example below illustrates: 

 Size of box showing duration 

 Color showing Total Cost 

 Grouped by showing Critical/Non Critical 

 

Detailed mode 

 

Scorecard This view gives the advantage of totaling metric scores directly within the 
analysis view. 
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Activity Browser 
Format 

Example 

 

Print Activities 

To print from the Activity Browser window, complete the following steps: 

1. Select the required activities to display.  

2. Select tabular view (default mode). 

3. Arrange, sort, and group the columns as needed. 

4. Click Print in the Activity Browser to print the report. 

Activity Reporting 
You can print results from the Activity Browser in a tabular or scorecard report by clicking on the 
Publish icon. 

To report activities, complete one of the following steps: 
 To report activities, irrespective of tripwire threshold, click on the ribbon or phase or 

intersection header.  

 To report activities that make up the score in the analyzer cells, click on the cell in 
question.  

Adding Annotations to Activities 
To add notes or annotations to the metric results, use the notepad icon found in the Activity 
Browser. You can annotate a single activity or the entire Activity Browser.  

 Click the notepad icon next to an individual activity to only add the note to that activity.  

 Click the notepad icon in the top right hand corner of the Activity Browser to annotate all 
activities within the browser.  
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Multiple annotations can be added to the activities by re-clicking the notepad icon. 

 

View and Interpret Results through Analyzer Windows 
After an analysis has been run, you can view results through the three main analyzer windows: 

 Ribbon Analyzer 

 Phase Analyzer 

 Intersection Analyzer 

These are used to report totals and numbers of exceptions to tripwire thresholds. Use the Activity 
Browser to drill down further to determine individual activities causing the tripwires to trigger.  

Ribbon Analyzer 
The ribbon analyzer displays metric results for each individual ribbon. By default, the results 
display in a tabular format but can also be viewed as a chart. 

  
Ribbon Analyzer -Tabular View Ribbon Analyzer – Chart View 

Click the notepad in the 
Annotate column to 

annotate a single activity 

Click the notepad on the 
activity browser to 

annotate all activities 
within the view 
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Phase Analyzer 
The phase analyzer shows metric results for each individual phase. By default, the results are 
shown in a tabular format but can also be viewed as a chart. The phase analyzer is useful for 
viewing trending information over time. 

  
Phase Analyzer Tabular View Phase Analyzer – Chart View 

Intersection Analyzer 
The intersection analyzer is slightly different to that of the ribbon and phase analyzer in that it can 
only report one metric at a time. However, in the same manner as ribbons and phases, results 
can be shown in both a tabular and graphical format. The intersection analysis is the most 
detailed of the three analyzers as it pinpoints exceptions within ribbons and phases combined. 

  
Intersection Analyzer Tabular View Intersection Analyzer – Chart View 

Analyzer Chart Options  
When viewing any of the three analyzers in chart mode, you can modify the chart type by using 
the Phases » Charts options on the S2 // Diagnostics tab. In addition, you can use the Charts 
options to set charts to cumulative and non-cumulative. 

When you view analyzer results through the use of charts, the colors of the bars and lines relate 
to the tripwire threshold colors as defined for the metric in question. 

Use Metrics to Analyze Projects 
Acumen Fuse uses libraries of metrics to analyze projects. Standard metric libraries pertaining to 
schedule quality, cost, project performance, risk exposure, earned value, and more are included 
within the tool. Additional libraries and associated metrics can be created. 

Metrics contain formulas and tripwire thresholds.  

 Formulas are used to calculate results as part of an analysis.  
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 Tripwire thresholds are used to flag and filter activities that exceed given thresholds. 

Metric results can be numeric (for example, cost or duration) or percentages (for example, 
percentage of total project duration). Percentages are useful for portraying results within a given 
context. 

Metric formulas are defined using standard MS Excel-based formula syntax. 

Acumen Fuse includes various metrics libraries including, but not limited to: 

 DCMA 14-Point Schedule Assessment — Schedule critique 

 Schedule — Schedule characteristics 

 Cost — Cost characteristics  

 Performance — Execution performance relative to a given baseline 

 Plan characteristics — Nature and complexity of a project plan 

 Risk exposure — Cost and schedule risk exposure 

 Earned Value — EV-based performance analysis 

 Earned Schedule — Schedule-based performance analysis 

 Forensics — Comparison-based metrics for determining root cause of delay 

 

For more information, see Managing Metrics. 

Apply Metrics 
By default, the S2 // Diagnostics tab is automatically populated with multiple sub- tabs containing 
separate views for each of the metric libraries. You can edit each of these views with regards to 
adding/removing metrics to each of the three analyzers (ribbon, phase, intersection).  
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Add a Metric to an Analysis View 
You can add metrics to any of the three analyzer windows (ribbon, phase, intersection).  

To add a metric, complete the following steps: 
1. Click on the Metrics tab on the left hand side of the analysis view to reveal the list of 

metric libraries and corresponding metrics within each library.  

2. Right click on the required metric and select one of the following: 

 Add to Ribbon Analyzer 

 Add to Phase Analyzer 

 Add to Intersection Analyzer 

 Add to All Analyzers 

 
You can add an unlimited number of metrics to the ribbon and phase analyzers. You can only 
view one metric at a time in the intersection analyzer. 
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Remove Metrics from an Analysis View 
You can remove metrics from the ribbon and phase analyzer by right clicking on the metric title 
and clicking Delete.  

To delete the currently applied intersection metric, complete the following steps: 

1. Hover over the intersection metric title in the top left hand corner of the view. 

2. Click Delete. 

 

Add an Entire Metric Library to an Analyzer 
In addition to adding individual metrics to an analysis view, you can add entire metric libraries to a 
view in a single action. The process is similar to that of adding individual metrics.  

To add a metric library to an analyzer, complete the following steps: 

1. Right-click on the desired metric library. 

2. Select one of the following: 

 Add to Ribbon Analyzer 

 Add to Phase Analyzer 

 Add to Ribbon and Phase Analyzer 

 

 

Since you can only view one metric at a time in the Intersection Analyzer, you cannot add a 
metric library to the Intersection Analyzer. Instead, assign individual metrics as described 
above. See Intersection Analysis for more information. 
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Add New Metric Views 
You can add new tabs with metrics to an analyzer the same way you add a library.  

To add a new tab, complete the following steps: 

1. Click the new tab/ribbon icon  located to the right of the last tab. 

2. Rename the tab by right-clicking on the tab and selecting Rename. 

 

Metric Benchmarking 
In addition to calculating metric results in the three analyzer windows, you can also benchmark 
metric scores against other scores. You can conduct benchmark comparison in three dimensions: 

 Compare results between ribbons. 

 Compare results between phases. 

 Compare results between intersections. 

To enable benchmark comparison, complete the following step: 

1. Select the S2 // Diagnostics tab. 

2. In the Display Settings menu, click the Other Settings down-arrow. 

3. Click Benchmark Comparison.  

After it is enabled, click on any of the analyzer cells to run a comparison with the selected 
ribbon/phase/intersection and the other ribbons/phases/intersections. 

Benchmark comparison results are shown through the use of up/down triangular icons.  

 Red shading indicates a negative comparison. 

 Green shading indicates a positive comparison. 

Add new tab or 
ribbon view 
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Example of Metric Benchmarking 

This example shows benchmark comparison where the Northern Region ribbon is the selected 
base scenario against the comparison analysis being carried out. 

 

Run Logic Analysis Using Logic Trace 

 

In addition to running it from the S2 // Diagnostic tab, you can also run logic trace from the S2 // 
Logic tab. See Using Logic Trace for more information. 

Logic analysis traces the path(s) of activities to and from a given activity. For example, all activity 
paths leading into a given milestone, or all activities on the path from a project sanction milestone 
to the end of the project.  

You can use the following tracing modes: 

 Trace Forward — Trace logic forward starting from the selected activity. 

 Trace Backward — Trace logic backward starting from the selected activity. 

 Trace Forward / Backward — Trave logic forward and backward starting from the 
selected activity. 

 Trace Path — This traces the paths between any two given activities. That is, it traces 
the logic from a starting activity until reaching the finishing activity. 

When you conduct a logic analysis, the analysis engine and resultant metric results only reflect 
those activities that are returned in the path analysis. 

You trigger logic analysis on the S2 // Diagnostic tab in one of two ways: 

 Select an activity then use the ribbon bar Logic menu (Logic » Trace). 

 Select an activity then use the Logic Trace icons in the Activity Browser. You can use 
these buttons as a fast-track means of running a logic trace by selecting the activity in 
question and using the icons to trace forwards, backwards, or in both directions. 
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Driving Logic 
Driving Logic allows you to analysis only those path(s) that are driving the schedule through to 
completion. This allows you to pinpoint the key activities in a schedule.  

 

By default, the logic trace runs in Driving Logic Only mode. 

To switch from Driving Logic Mode Only to display all logic, complete the following steps: 

1. Select the S2 // Diagnostics tab. 

2. In the Logic menu, click the Trace down-arrow. 

3. Click Driving Logic Only to deselect it. 

It has a checkmark to the left of it when it is selected and no checkmark when it is not 
selected. 

Example of Driving Logic Analysis  
The screenshot below shows an example of a driving logic analysis looking at all driving activities 
leading into and stemming from an activity called EPC Design. The activities in this path analysis 
are also shown in the ribbon browser and the results in the ribbon/phase analyzer are reflective of 
this driving path. 
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Run a Logic Trace From the S2 // Diagnostics Tab 

 

To run a logic trace using the S2 // Logic tab, see Run a Logic Trace From the S2 // Logic tab. 

To run a logic trace, complete the following steps: 
1. Select the S2 // Diagnostics tab. 

2. In the Project/Snapshot pane, select a project. 

3. In the Activity browser, select an activity. 

4. Do one of the following: 

 In the Logic group, click the Trace down-arrow and select a tracing mode. 

 Click one of the trace logic icons in the Activity browser. 

The trace logic filtered activities display in the Activity browser. 

5. (Optional) Click the Trace down-arrow and deselect Driving Logic Only if you want to 
display all logic. 

 

To reset the trace, click Logic » Trace. 

Run a Fuse Analysis 
To run a Fuse analysis, complete the following steps: 

1. Populate your workbook with project data. 

 

See Working with Acumen Workbooks for more information. 

2. Run Acumen Fuse Analysis: 

a. Select the S2 // Diagnostics tab.  

b. Select a pre-defined analysis view using the tabs at the bottom of the screen. 

c. In the Analyze menu, click Fuse to run the analysis. 

d. Click on any metric result, ribbon, or phase to view the included activities in the 
Activity Browser. 
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Example of Fuse Analysis Results  

 

Exclude Activities From the Analysis 
You can filter activities out of the Fuse analysis using the Excluded checkboxes within the 
Activity Browser.  

To exclude an activity from the analysis, complete the following steps: 

1. On the S2 // Diagnostics tab, run a Fuse analysis, select a metric result, and review the 
activities included in the Activity Browser.  

 

See Run a Fuse Analysis for steps. 

2. To exclude an activity from the analysis, select the Excluded box next to the activity. 

 

Check to exclude 
an activity from the 

Fuse analysis 
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3. Re-run the analysis to update the metric results.  

Comparison Analysis 
The Comparison Analyzer enables you to compare similarities and differences between two 
scenarios. The scenarios that get compared can originate from multiple origins as well as report 
in different contexts. 

The Comparison Analyzer allows you to: 

 Compare the same metric across two different ribbons. 

 Compare the same metric across two different time periods within either the same ribbon 
or between different ribbons. 

 Compare two different metrics within the same ribbon or phase. 

 Compare similarities — Report activities that haven’t changed between two scenarios. 

 Compare differences — Report activities that have changed between the two scenarios. 

Run a Comparison Analysis 

To run a comparison, complete the following steps: 

1. Select the S2 // Diagnostics tab. 

2. Create Scenario A by clicking on one of the following: 

 Ribbon analyzer cell — Selects all activities that trigger the tripwire for the selected 
metric within the selected ribbon (across multiple phases). 

 Phase analyzer cell — Selects all activities that trigger the tripwire for the selected 
metric within the selected phase (across multiple ribbons). 

 Intersection analyzer cell — Selects all activities that trigger the tripwire for the 
selected metric within the selected phase within the selected ribbon. 

 Phase header — Selects all activities across all ribbons for the selected phase.* 

 Ribbon header — elects all activities across all phases for the selected ribbon.* 

3. In the Analyze menu, click Compare. 

4. Create Scenario B by clicking on any of the same options as described in the above step 
for Scenario A. 

After selecting Scenario B, the compare analysis will automatically run. The results 
display in a popup window.  

 

 

Selecting a scenario from either a phase or ribbon header allows you to select activities for a 
scenario irrespective of whether the activities trigger a metric tripwire.  
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Apply Filters 
You can apply three filters in the Comparison Analyzer results window. This enables you to do 
further analysis comparing similarities and differences within the two scenarios. By default, all 
three filters are enabled resulting in three sets of data. The filters are cumulative and not 
exclusive. 

 Present in both — This filter displays only those activities that are present in both 
scenarios. In the case of comparing two scenarios against the same metric, this indicates 
those activities that trigger a metric tripwire in both instances; that is, activities that have 
not changed between the two scenarios. 

 Only present in <Scenario A> — This filter displays those activities that are present in 
the first scenario but not in the second. In the case of comparing two scenarios against 
the same metric, this reports those activities that triggered the metric tripwire in the first 
scenario but not in the second. Typically, this is used to show those activities that were 
an issue in Scenario A that then got addressed and fixed in Scenario B. 

 Only present in <Scenario B> — Shows those activities that are present in the second 
scenario but not in the first. In the case of comparing two scenarios against the same 
metric, this reports those activities that triggered the metric tripwire in the second 
scenario but not in the first. Typically, this is used to show those activities that weren’t an 
issue in Scenario A that then became an issue in Scenario B. 

Comparison Analyzer Printing 
You can print the Comparison Analyzer results by clicking Print in the Comparison Analyzer 
window. 
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Manage Metrics 
The Acumen Fuse analysis engine uses libraries of metrics to run project analytics. These 
metrics are defined using either basic filters or more advanced formulas that are of the same 
syntax as those found in MS Excel. Acumen includes several metrics libraries. Metrics can be 
edited using the metric editor.  

The Metrics Tab 

 

Metrics within a Workbook 
Each workbook contains its own metric library. Any change you make to metrics or the metric 
library is made only to the open workbook.  

To reuse an updated metric library, complete the following steps: 

1. Click  then click Open to open the updated workbook. 

2. Click  and in the left-hand pane, click Save As…. 

3. Save the file. 

4. Add projects for analysis. 

Building Blocks of Acumen Fuse Metrics 
Each metric is made up of a Primary Formula, a Secondary Formula, and Tripwires.  

 Primary Formula — The primary formula is the formula used to calculate the primary 
result calculated in the analysis (for example, total cost). 

 Secondary Formula — The secondary formula is the second of two results that can be 
displayed for a metric after running an analysis. Typically (although not limited to), the 
secondary metric is used to show the primary formula as a percentage (for example, cost 
as a percentage of total project cost). The secondary formula is an optional attribute of a 
metric. If it is not defined, it will not display in the analyzer windows. 

Metrics 

Filters 

Advanced 
Formula 
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 Tripwire Formula — The tripwire formula is (optionally) used to determine the individual 
exceptions that are listed in the Activity Browser. Metrics that do not contain a Threshold 
formula cannot be used to display activities in the Activity Browser and also cannot be 
used in the Comparison Analyzer.  

 Tripwire Threshold — A tripwire threshold is a defined value that, if exceeded, 
causes a metric to be classified as ‘triggered’. A metric can have multiple trigger 
points with corresponding color coding for each interval. The threshold editor enables 
customizable bandwidths or thresholds to be defined, color coded and described.  

Each formula is built using a three-level hierarchy: 

 Inclusions — A top-level set of filters to exclude specific activities based on type, status 
and time period 

 Filters — Standard filters that further pinpoint specific activities 

 Formula — Advanced custom formulas to further specify advanced criteria sets. 

 

Write Metric Formulas 
You can develop Acumen Fuse metrics using a basic or advanced approach, or a combination of 
the two: 

 Basic — A filter-based set of metrics that doesn’t require detailed formula definition. 

 Advanced — Detailed formulas used to define a metric beyond a simple filter. 

Formulas use array-based formulas in their calculations. These are explained in detail below. The 
formulas enable you to group and aggregate multiple activities together so that results for a 
ribbon or phase or intersection can be calculated. 

Array Formula Types 
Acumen Fuse metric formulas are based on Single Value Result Array formulas. Single Value 
Result Array formulas work with a series of data (activities), aggregate it (typically using SUM, 
AVERAGE or COUNT) and return a single value to the (ribbon, phase, or intersection) analyzer.  

Array formulas typically return a series of values. For example, in Excel, the formula 
=Row(A1:A5) returns only a single value (the first value in the list). An array formula will return all 
values for A1 to A5. You usually apply a container function, such as SUM or AVERAGE or 
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COUNT, against the results of an array formula. This enables you to apply the function to the list 
of values and return a single value result.  

In Acumen Fuse, a ribbon, phase, and intersection all contain one or more activities. In the case 
of phases and intersections, the activities may span across more than one phase or intersection. 
Therefore, certain data (for example, duration, work, and cost field types) gets prorated. When 
metric functions are applied during a Fuse analysis, they are applied to the ribbon, phase, or 
intersection indirectly being applied to all activities within that segment through the use of an 
array formula. 

 

Develop Primary Formulas 
Primary formulas can return any type of numeric or text-based result.  

To create a Primary formula, complete the following steps: 
1. Define inclusions — These are overarching filters that limit which activities get included in 

the search by type/status/phase. 

2. Define Filters — These are the next level of filters further filtering out specific activities. 
Many metric definitions can be completed by just using inclusions and filters (for 
example, Critical activities).  

3. Add an optional formula — If additional advanced criteria definition is needed, then select 
the advanced mode and define the function using the advanced metric editor. 

4. Select a format from the Formula Format field to format primary format results — This 
applies to both basic and advanced primary formula definitions. 

  

Basic formula 
definition 

Advanced formula 
definition 

Formula Format 
field 
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Develop Secondary Formulas 
A secondary formula is additional information shown in a ribbon/phase or intersection analysis 
window. Secondary formulas are defined in a similar way to primary formulas. If you want to use 
a secondary formula to show a percentage, set the Format field to Percentage. 

There are two ways to create a secondary formula: 

 Simple percentage relative to the primary formula — If the secondary formula 
represents a percentage of the primary formula, then you don’t need to create complex 
formulas. Instead, select the relevant inclusions and filters (in order to define the 
population against which you are going to divide the primary formula in order to calculate 
the percentage) and then set the mode to Percentage of Primary Formula. A simple 
percentage secondary formula can be auto-calculated in this mode irrespective of 
whether the primary formula has been defined in basic or advanced mode.  

 Advanced Secondary Formula — If the required secondary formula is not a simple 
percentage of the primary formula, then set the mode to Advanced and define the 
inclusions, filters and advanced formula manually. 

  

Tripwires 
Tripwires graphically depict when a particular metric threshold is reached. Acumen Fuse tripwires 
are flexible with regards to the: 

 Number of thresholds per metric that can be defined. 

 Type of thresholds (absolute and gradient). 

 Formulas against which thresholds can be based (primary and secondary).  

Tripwire Formulas 
The tripwire formula is used to determine the individual exceptions that are listed in the Activity 
Browser. Tripwire formulas must ultimately return a Boolean in the form of either a True or False 
value. The most commonly used function to return this Boolean is an AND statement.  

AND(ActivityType=”Normal”, ActivityStatus=”Planned”) 

AND functions can contain an unlimited number of conditions.  

Tripwire formulas get applied to each activity separately whereas primary and secondary 
formulas get applied to groupings of activities (depending on the ribbon, phase, or intersection 
context). 

You can create tripwire formulas in one of two ways: 

Auto percentage 
mode 

Manually 
defined mode 
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 Auto Calculated by Primary Formula — If the primary formula was created using the 
basic mode, you can opt to automatically create the tripwire formula without defining any 
inclusions, filters, or formulas for the tripwire definition. Instead, Fuse will automatically 
create a tripwire formula based on the inclusions and filters defined in the primary 
formula. This mode cannot be used if the primary formula was created in Advanced 
mode. In Auto Calculated by Primary Formula mode, the tripwire inclusions and filters 
options are disabled because they are automatically inherited from the primary inclusions 
and filters.  

 Advanced — This mode enables you to manually create inclusions, filters, and advanced 
functions that together return the required set of activities.  

  

Tripwire Thresholds 
Each metric includes an optional set of tripwire thresholds. You use these thresholds to 
graphically show when a defined threshold is exceeded. Tripwire thresholds can be based on 
either the primary or secondary formula.  

If you enable the secondary formula by selecting the checkbox for the secondary metric, then the 
tripwire threshold is automatically associated with the secondary metric. If you do not select the 
checkbox, the tripwire threshold is automatically associated with the primary formula.  

Define Tripwire Threshold Scales 
You can define tripwire threshold scales as having any number of intervals. To automatically 
create standard scales, click Metrics » Tripwire Thresholds » Color Scales.  

 
This option provides three types of standard scale: 

 Lowest is Better — Creates a scale where the lowest values are preferable. 

 Highest is Better — Creates a scale where the highest values are preferable. 

 Ideal Value — Creates a scale where the middle values are preferable. 

You can create varying numbers of interval for each of these scale types. 

Auto-calculated 
mode 

Advanced mode 
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In addition to using the standard scale types, you can add additional intervals using the Color 
Scales menu.  

Normal and Gradient Scales 
You can define threshold intervals as either normal or gradient. By default, scales are defined as 
normal. All threshold intervals within a single metric are either normal or gradient-based (they 
cannot be mixed within a metric).  

Normal scales behave in an absolute or binary manner – that is, a metric result either does or 
does not trigger a threshold.  

A gradient scale behaves differently, in that a metric result, while falling within a given interval, 
can be represented as being close to an interval boundary. This type of scale is useful when 
determining how close a metric result is to a tripwire boundary. When using gradient scales, 
instead of discrete colors for the intervals being used, gradient scales of color are used (based on 
where the metric falls in the scale). 

Include or Exclude Metrics from Analysis 
By default, each metric is available in all three analyzers (ribbon, phase, intersection). Metrics can 
be excluded from a particular analysis (for example, phase) if, for example, the context is not 
valid. Use the check boxes in the Metrics tab » Applies To menu to Include/exclude metrics 
from each of the three analyzers.  

 
In addition, you can use the Include in new Workbook checkbox to define whether a metric gets 
automatically added to a view upon creation of a new workbook. 

 

Test Metric Formulas 
You can click Check Formula to validate the syntax of the formula when creating or editing a 
metric formula. The test calculation is applied to all activities within the workbook. 

 

Common Functions 
The Acumen Fuse metric editor supports all MS Excel functions. The most commonly used 
formulas are grouped in Metrics » Function Libraries » Common. 
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IF Function 
The IF function returns one value if the specified condition is TRUE and returns another value if 
the specified condition is FALSE. 
IF(logical_test, value_if_true, [value_if_false]) 

 Logical_test (Required) — Any value or expression that can be evaluated to TRUE or 
FALSE. 

 Value_if_true (Required) — The value to be returned if the “logical_test” argument 
evaluates to TRUE. 

 Value_if_false (Optional) — The value to be returned if the “logical_test” argument 
evaluates to FALSE. If omitted then zero is returned. 

Example — IF(TaskStatus="Inprogress",1,0) returns 1 if the activity status is equal to InProgress 
otherwise 0 is returned. 

You can write IF statements in shorthand within Acumen Fuse. If the IF function name and 
Value_if_true and Value_if_false parameters are omitted, the Acumen Fuse engine will assume 
that the function is an IF statement returning either a 1 or a 0.  

Example — IF(TaskStatus="Inprogress",1,0) can be written in shorthand as 
(TaskStatus="Inprogress"). 

SUM Function 
The SUM function adds all the numbers specified as arguments. 
SUM(number1, [number2], [number3], [number4], ...) 

 number1 (Required) — The first item that you want to add 

 number2, number3, number4, ... (Optional) — The remaining items that you want to 
add 

Example — SUM(ActualCost) returns the sum of the Actual Cost. 

AND Function 
Returns TRUE if all its arguments evaluate to TRUE; returns FALSE if one or more arguments 
evaluate to FALSE. Most commonly used in the Tripwire formula. 
AND(logical1, [logical2], ...) 

 logical1 (Required) — The first condition that you want to test that can evaluate to either 
TRUE or FALSE. 

 logical2, ... (Optional) — Additional conditions that you want to test that can evaluate to 
either TRUE or FALSE 

Example — AND( ActivityType="Normal", ActivityStatus<>"Complete") returns TRUE if the 
activity type is “NORMAL” and activity status is not equal to “COMPLETE”. 

MAX Function 
Returns the largest value in a set of values. 
MAX(number1,number2,...)  

 Number1, number2, ... — are 1 to 255 numbers for which you want to find the maximum 
value. 
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Example — MAX(TotalFloat) returns the maximum Total Float. 

AVERAGE Function 
Returns the average (arithmetic mean) of the arguments. 
AVERAGE(number1, [number2],...)  

 number1 (Required) — The first number for which you want the average. 

 number2, ... (Optional) — Additional numbers for which you want the average, up to a 
maximum of 255 

Example — AVERAGE(TotalFloat) returns the average Total Float. 

COUNTIF Function 
Counts the number of occurrences that meet a given criteria. 
COUNTIF(range, criteria) 

 Range (Required) — One or more fields that contain numbers. 

 Criteria (Required) — A number, expression, or text string that defines which records to 
be counted. For example, criteria can be expressed as 3, ">3","Normal", or "3". 

Example — COUNTIF(TotalFloat,">5") counts the number of activities who have a Total Float 
value greater than 5. 

Types of Fields 
When creating metric formulas, you can reference four types of fields: 

Field Description 

Activity Fields Activity fields are the most commonly used type of field in an Acumen 
Fuse metric formula. All fields that are defined in the field mapping 
during a project import are exposed as activity fields in the metric editor. 

Project Fields Some project level fields get automatically imported during a project 
import. These fields are also exposed for use within metric formulas. 
When a metric is calculated that contains a project field reference, the 
specific project field value for the activity in question is used.  

A single metric calculation may contain activities from multiple projects. 
In this instance, the appropriate project level field value will be used for 
each activity (for example, Time Now may be different for each of the 
projects).  

Project fields include: 

 Project Start [ProjectStart] 

 Project Finish[ProjectFinish] 

 Project Time Now [ProjectTimeNow] 

Workbook Fields Workbook fields are summated values that are calculated at the 
workbook level (that take into account all activities within the workbook).  

Workbook fields include: 
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Field Description 

 Workbook Cost (total) [WorkbookCost] 

 Workbook Actual Cost [WorkbookActualCost] 

 Workbook Remaining Cost [WorkbookRemainingCost] 

 Workbook Budget Cost [WorkbookBudgetCost] 

 Workbook Budget Duration [WorkbookBudgetDuration] 

 Workbook Actual Duration [WorkbookActualDuration] 

 Workbook Remaining Duration [WorkbookRemainingDuration] 

 Workbook Duration (total) [WorkbookDuration] 

 Workbook # of Activities [WorkbookNumberofactivities] 

Dynamic Fields Dynamic fields have different values depending on the context within 
which they are being used within an analysis. Period Start and Period 
Finish are both dynamic fields.  

 Period Start — [_PeriodStart] 

 Period Finish — [_PeriodFinish] 

When Period Start and Period Finish are being applied to a phase 
analysis, they relate to the start and finish of the phase in question.  

When being used within the context of a ribbon, Period Start and 
Period Finish relate to the start and end date of the ribbon. 

Formulas are generally written within the context of an activity. By further exposing fields outside 
of the activity context (for example, project and workbook), you are able to model how activities 
relate to and potentially impact other contexts such as project and workbook. 

Template Metric Libraries 
In addition to editing a metric library within a given workbook, you can save metric libraries as 
templates and reused within other Fuse workbooks.  

Save a Metric Library as a Template 
After a metric library has been customized, you can save it (for reuse) as an XML file that can 
subsequently be used when creating new workbooks. You can store metric library files on file 
servers and shared between multiple users. 

To save a metric file as a template, complete the following steps: 

1. Click . 

2. On the left-hand pane, click Save as… » Deltek Acumen Metric Library Template.  

3. In the Save As dialog box, navigate to the folder in which you want to save the template 
and enter a file name.  

4. Click Save. 
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Reuse a Metric Library Template 
When you reuse a metric library template, it creates a new workbook and automatically inherits 
the selected metric template library. 

To reuse a metric library template, complete the following steps: 

1. Click . 

2. On the left-hand pane, click Open. 

3. Select the Fuse metric template file.  

4. Click OK. 

A new workbook is created that includes the selected metric template library. 

Set a Custom Metric Library as the Default Library 
In addition to manually applying custom metric libraries through the steps described above, you 
can also set a custom metric library to be the standard default library for each newly created 
workbook.  

To set a custom metric library as the default library, complete the following steps: 

1. Click . 

2. On the bottom of the pane, click Deltek Acumen Options and select the General tab.  

3. In the Folders, Libraries and Templates menu, deselect Use Built-In Metric Library.  

4. In the Default Metric Library Location field, select the custom metric library file that you 
want to use.  

This will subsequently be applied to all newly created workbooks. 
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Move, Copy, and Delete Metrics and Metric Libraries 
Both metrics and metric libraries can be reconfigured with copy-paste functionality. Using either 
the Fuse clipboard menu or the right click feature of a metric/metric library, you can copy metrics 
and move them to different locations within the metric library. 

 

Metric Weightings for Scorecards 
Scorecard totals are calculated using two approaches: 

 Overall scores (for example, project scores) — This is based on the number of activities 
within the dataset that fail one or more of the metric tests (irrespective of weighting). You 
can modify this method on the User Interface tab of the Deltek Acumen Options dialog 
box to use weighted scores based not just on the number of activities that fail a test but 
the total number of metrics that fail a test. 

 
 Individual Activity scores — Based on the weighted results of all metrics being applied 

to the activity. 
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In order to calculate these activity scores, the relative weighting for each metric is required. You 
can view and edit weightings by clicking Metrics tab » Metrics » <metric library folder>. 

 
Weightings are based on a +/- 10-point sliding scale. The higher the weighting, the more impact 
the metric in question has on the scorecard score. By default, metric weightings have been set to 
the midpoint in the weighting scale (that is, +/- 5 depending on whether a high score is a positive 
or negative result).  

Newly created metrics inherit a neutral score until you edit them. Weightings only apply to activity 
scores and not project/dataset scores. 

Metrics Using Variables 
Acumen provides an extremely powerful means of defining metrics against generic fields and 
values prior to knowing what these values actually are. There are two forms of variables within 
Acumen: 

 Variable Values — When defining a metric, instead of setting criteria based on a defined 
value, you can describe a metric in terms of a variable. An example is a custom metric 
called High Cost. At the time of the metric being created, you do not know what this 
value should be. Instead you can create a variable called, for example, High Cost Value 
and use this in the metric definition. At run-time, when a Fuse analysis is run, the user is 
prompted to enter a value for this variable which will subsequently be used in the 
calculations. 

 Variable Fields — When defining a metric, if a field to be used in a metric definition is 
unknown, then a variable field can be created. In a similar manner to the variable value 
concept, when a Fuse analysis is run, the user is prompted for the actual field to be 
assigned. This is useful when a metric refers to, for example, a user-defined or code field 
that is not known at the time of creation of the metric. 

You can define a metric using variable values, variable fields, or both. 

Define Variables 
You can define variables on the Metrics tab in the Variables folder. The screenshot below shows 
an example of a variable called My Unknown Cost. You can use this variable in the definition of 

Click on a metric library folder 
to view the metric weights 
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the metric. If no value is specified in the Value field, the user is prompted for this during a Fuse 
analysis. Upon entering this value (at run-time), the variable will store and use this value unless 
altered at a later time by the user. 

 

Reference Variables when Defining Metrics 
After you have defined a variable, you can reference it when defining a metric in the exact same 
way a normal defined value is referenced. The screenshot below shows an example of a metric 
called High Cost being defined using the variable My Unknown Cost.  

 

Click on the Variables 
folder to define variables 
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Run a Fuse Analysis using Variables 
In the example below, a variable called My Unknown Cost has been created and referenced in a 
custom metric called High Cost. When a Fuse analysis is run, if the variable value has not been 
set, the user is prompted to set a value.  

 
If the user enters a value of $1,000,000 as the variable value at run-time, the results are as 
follows:  
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Change the Value of a Variable 

To change the value of a variable, do one of the following: 

 On the Metrics tab, in the Variables folder, click the name of the variable and enter a new 
value in the Value field. 

 
 On the S2 // Diagnostics tab, in the Analyze menu, click on the expand icon in the 

bottom-right corner of the Analyze menu item. 

 
 In the Variable Definition dialog box, edit the variable value as needed. 
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Define and Reference Variable Fields 
As well as defining, referencing, and analyzing variable values, you can also utilize variable fields. 
After you have defined a variable field, you can reference it when defining a metric.  

Example of Defining and Referencing Variable Fields 

This example shows the definition of a variable (unknown) field called Owner.  

 
An Owner Activities metric is created that references the Owner variable field. However, at the 
time of creating the metric, the exact field name is not known (as it will subsequently be defined 
as a user defined field of an unknown field name). 
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The Owner variable field is bound to a user-defined field in Primavera called Contractor. This 
means that the metric can be run against any project irrespective of the actual field name used to 
represent Owner. 

 
The screenshot below displays the Fuse analysis results when using the Owner Activities 
metric, a count of the number of activities whose user-defined field Contractor has a value of 
InHouse. 
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Work with Both Variable Fields and Variable Values 
The previous example demonstrated working with either a variable value or field where the field 
value was known. In some instances, the value of a variable field is not known. In this case, you 
can use the Variable Field editor to create variable values.  

 
After you have created the variable field and variable value, you can define the metric as shown 
below. 
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At run-time, the user is prompted to define both the Variable field as well as the variable value. 

 

 

Multiple Variables 
You can create multiple variables against a variable field. For example, you can create a variable 
field called Acceptable Cost that contains two variables — Low Value and High Value. You 
then define a metric based on two criteria: The Total Cost being greater than Low Value, and 
less than or equal to High Value. 

 

Selecting variable field and 
value at runtime 

Results from the Owner 
Activity Metric using a 
Variable field and value 
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At run-time, the user is prompted for the field that is being used in the calculation as well as the 
two variable costs being used in the metric calculation. 

 
The results from analysis using a variable field and multiple variable values are as follows: 
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Reporting Diagnostics Results 
You can include all components of an Acumen diagnostics check in an MS Excel-based report, 
including: 

 Ribbons 

 Ribbon Analyzer 

 Ribbon Analyzer Detail 

 Phase Analyzer 

 Phase Analyzer Detail 

 Intersection Analyzer Detail 

You can publish all ribbon data to MS Excel through the Publish menu on the S2 // Diagnostics 
tab. You can also use these editable reports in other applications such as MS PowerPoint. 

 

Executive Briefing Report 
The Executive Briefing is one of the most powerful reports within Acumen. It consolidates 
information and results that have been generated from an analysis, and presents them in a 
descriptive briefing without the need for manual interpretation of the data.  

The report includes three sections: 

 Workbook — Summary of the overall analysis including cost and schedule 
characteristics. 

 Project — Project level summary including characteristics, status, areas of concern. 

 Ribbon — Detailed analysis of each ribbon including trending. 
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See Appendix C: Executive Briefing Variables and Customization for information about editing 
the report and a description of the Executive Briefing variables. 

Generating the Executive Briefing Report 
You can generate the Executive Briefing report from the Publish menu on the S2 // Diagnostics 
tab as either an editable MS Word document or a ready-to-publish Adobe PDF file.  

Example of an Executive Briefing Report 

 

Analyst Report 
The analyst report is designed to serve as a checklist listing of the individual activities that fail the 
various metric tests that have been applied to the view.  
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Example of an Analyst Report 
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Logic Analysis 
In addition to using Acumen Fuse to perform diagnostic checks on schedule attributes, Fuse can 
evaluate relationships between activities.  

The S2 // Logic Tab 
The logic analysis view is used to run various logic integrity checks against the schedule(s).  

 
Fuse logic analysis provides multiple advanced logic checks on a project (or multiple projects) 
including: 

 Analysis of logic types 

 Positive and negative lags (leads) 

 Redundant logic 

 Circular logic 

 Open ends 

 Relationships on summaries 

 Out of sequence status updates 

 Reverse Logic 

 Dangling Activities (Open Start and Open Finish) 

 Logic Sensitivity™ 
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Positive and Negative Lags and Leads 
This analysis pinpoints all relationship links that are carrying a lag. Negative lags (or leads) cause 
concern within a schedule as they can lead to reverse logic. Likewise, positive lags often result in 
detail being lost within a schedule during statusing / execution. 

 

See Reverse Logic for more information. 

Redundancy Index 
The redundancy index analysis pinpoints redundant logic links within a schedule. This enables 
you to generate and maintain clean schedules that don’t contain redundant or overlapping logic. 

Example of Redundancy Index Analysis 
You have three activities (A, B, and C) in sequence with FS logic links. If the schedule in question 
has a logic link between Activity A and C, then this link is essentially redundant as Activities A 
and C are already logically tied through Activity B. 

 

To run a Fuse logic analysis, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Select the workbook, project, or snapshot against which you want to run the analysis. 

3. Select the S2 // Logic tab. 

4. In the Logic Checks menu, click Redundancy Index to run the logic analysis.  

 

Duplicated logic between Electrical 
Design and Mechanical Design 
(through Telecoms Design) 

Redundant logic link between 
Electrical Design and Mechanical 
Design 
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Logic Sensitivity 
The logic sensitivity check allows you identify how potential delays affect key activities or 
milestones later in the project.  

To run the Logic Sensitivity check, complete the following steps: 
1. Select the S2 // Logic tab. 

2. In the Logic Analysis menu, click Logic Sensitivity. 

3. On the Logic Sensitivity screen, enter information into the following fields: 

 Nudge Activity — Select any activity or milestone from your project. This activity will 
be the starting point of the test. A simulation will be run where a delay is added to this 
activity to see if it impacts an activity or milestone later in the project.  

 Nudge Duration — Input the number of days by which you would like to nudge, or 
delay, the Nudge Activity. By default this number is set at 600 days.  

 Target Activity — Select the target activity on which you would like to test the 
impact.  

4. Click Analyze. 

The example below shows the results of a Logic Sensitivity test where the nudge activity was 
delayed by 600 days. The test found that 30 days of delay could be added to the nudge activity 
before any impact was seen on the target activity.  

 
You can also use this interactive view to determine the impact on the target activity at any given 
amount of nudge. Roll your mouse along the blue line to see the intersecting points.  



Logic Analysis 

 

User Guide 106 

 

Use Logic Trace 

 

In addition to running it from the S2 // Logic tab, you can also run logic trace from the S2 // 
Diagnostics tab. This allows you to slice and dice based on different parameters, and filter 
using metrics, before you select the activity from which you want to start tracing.  

See Running Logic Analysis Using Logic Trace for more information. 

Logic analysis traces the path(s) of activities to and from a given activity. For example, all activity 
paths leading into a given milestone, or all activities on the path from a project sanction milestone 
to the end of the project.  

You can use the following tracing modes: 

 Trace Forward — Trace logic forward starting from the selected activity. 

 Trace Backward — Trace logic backward starting from the selected activity. 

 Trace Forward / Backward — Trave logic forward and backward starting from the 
selected activity. 

 Trace Path — This traces the paths between any two given activities. That is, it traces 
the logic from a starting activity until reaching the finishing activity. 

The above options are available on the Logic Trace menu as well as when you right-click on an 
activity.  

When you conduct a logic analysis, the analysis engine and resultant metric results only reflect 
those activities that are returned in the path analysis. 

Driving Logic 
Driving Logic allows you to analysis only those path(s) that are driving the schedule through to 
completion. This allows you to pinpoint the key activities in a schedule.  

 

By default, the logic trace runs in Driving Logic Only mode. 

To switch from Driving Logic Only mode to display all logic, complete the following steps: 
1. Select the S2 // Logic tab. 

2. In the Logic Analysis group, click the Logic Trace down-arrow. 

3. Click Driving Logic Only to deselect it. 

It has a checkmark to the left of it when it is selected and no checkmark when it is not 
selected. 

View the SmartGantt and Run a Logic Trace From the S2 // Logic Tab 

 

To run a logic trace using the S2 // Diagnostics tab, see Run a Logic Trace From the S2 // 
Diagnostics tab. 

When you first access the S2 // Logic tab, the Logic Trace menu options are grayed out. You 
need to display the SmartGantt and select an activity in order for these options to become 
available. 
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The Logic Trace menu includes SmartGantt options. See SmartGantt in the Viewing and 
Editing the Schedule topic for detailed information about these options. 

To display the SmartGantt and run a Logic Trace, complete the following steps: 
1. Select the S2 // Logic tab. 

2. Select an activity. 

3. Do one of the following: 

 In the Logic Analysis group, click the Logic Trace down-arrow and select a tracing 
mode. 

 Right-click on an activity and select a tracing mode. 

The trace logic filtered activities display in the SmartGantt view. 

4. (Optional) Click the Trace down arrow and deselect Driving Logic Only if you want to 
display all logic. 

Change the Display Level  
You can use the Logic Trace grouping feature to roll-up or expand the display. 

To change the display level, complete the following steps: 
1. Select the S2 // Logic tab. 

2. In the Logic Analysis group, click the Logic Trace down-arrow. 

3. Click Grouping then use the Display Level slider to roll-up or expand the display. 

Group Activities  
You can use the Logic Trace drop-down menu to group activities by WBS or by activity fields, 
user-defined fields, or code fields. 

To group activities, complete the following steps: 
1. Select the S2 // Logic tab. 

2. In the Logic Analysis group, click the Logic Trace down-arrow. 

3. Click Grouping and select a grouping option: 

 Group by WBS — Group activities by WBS 

 Group by Fields — Group activities by activity fields, user-defined fields, or code 
fields. 

 Flat — Ungroup activities. 

Reset a Logic Trace 
To reset the logic trace, complete the following steps: 

1. Select the S2 // Logic tab. 

2. In the Logic Analysis group, click the Logic Trace down-arrow. 

3. Click Reset Trace. 
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The logic trace filter is cleared. 

Save a Logic Trace as a Filter 
You can save the current trace as a filter for use as a filter on the S3 // Risk tab. 

To save the current trace as a filter, complete the following steps: 

1. After running a logic trace, in the Logic Analysis group, click the Logic Trace down-arrow 
and select Create SmartGantt Filter. 

2. In the Create Filter dialog box, enter a name for the filter. 

3. Click OK. 

You can use the saved filter on the S3 // Risk tab.  

 

See Using a Filter to Focus on a Certain Subset of Activities for more information. 

Additional Logic Checks 

Logic Description 

Circular Logic Circular logic analysis checks for paths of activities that loop back on 
themselves. This is a big concern in multi-project environments (for 
example, multiple Primavera files that reference each other) where 
circular logic checks can otherwise go undetected. 

Open Ends Open ends analysis checks for any activities that are missing either 
predecessors or successors, causing the activity to be “open ended.” 

Logic on 
Summaries 

While some scheduling tools allow logic links to be added to summary or 
WBS elements, it is generally accepted best practice to only logic-tie 
normal activities together so as to retain the ability to re-sort/group 
activities without having to break the summary logic links. 

Out of Sequence Out of sequence errors occur between activities when the successor 
activity status contradicts the logic with its predecessor. For example, a 
successor activity starting before its FS predecessor has started. 

Reverse Logic Reverse logic errors occur when the start of a successor activity starts 
before the start of the predecessor. Typically caused by negative lags 
(leads), these reverse logic errors should be avoided at all costs. 

Dangling 
Activities (Open 
Starts and Open 
Finishes) 

Dangling activities occur as a result of a FF or SF predecessor link (open 
start) or SS or SF successor link (open finish) and not when there are any 
missing predecessors or successors. The successor ends up with an 
open start and the predecessor ends up with an open finish. 
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Sort and Group Logic Analysis Results 
You can sort and group analysis results by dragging the column header above the table to create 
a grouped list of results. Click on a column header to sort.  

Logic Analysis Report 
The Logic Analysis report includes a separate tab for each of the Fuse logic analysis checks. 
Each exception (activity or logic link) is listed in the report. 
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Use Forensics to Identify Additions, Deletions, 
and Modifications 
The Acumen Forensic Analyzer provides a flexible means of comparing differences and 
pinpointing changes made to two or more schedules, cost estimates, or risk models.  

You can use the analysis to compare: 

 Updated revisions of schedules (for example, monthly updates) 

 Differences between, for example, contractual baseline schedules and as-builts during 
dispute resolution or lessons learned exercises.  

 Differences (and integrity) in the same schedule developed on different platforms (for 
example, MS Project and Primavera). 

Analytics include:  

 Added or removed activities 

 Changed activity status 

 Changed calendar definitions 

 Modified logic links 

 Added or changed constraints 

 Updated or changed resources and resource assignments 

 Updated activity costs 

 Updated progress and earned value 

 Changed critical/longest path activities 

 Added or modified activity attributes (for example, activity type, status, % complete, 
actual duration, remaining cost, risk) 

Absolute and percentage variances are shown for each of the comparison snapshots (compared 
to the base schedule being compared against). 

Forensic analysis can be used for:  

 Ongoing project surveillance 

 Schedule import/export integrity support 

 Contractor performance tracking 

 Claims avoidance/evaluation 

 Expert witness testimony 
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The Forensics Tab 
You can run an unlimited number of forensic checks in the analysis including changes to code 
and user-defined fields. You can add, sort, and group results and then publish to, for example, 
PDF and MS Excel. 

 

 

For Microsoft Project files, you can use the Activity Comparison Field on the Platforms tab of 
the Deltek Acumen Options dialog box to specify the field that Forensics should use to uniquely 
identify an activity. The options are: UniqueID, ID, Guid, WBS. 

Set up a Forensic Analysis 
A forensic analysis requires at least two projects within a workbook. In addition, one of the two 
projects must be designated as a snapshot against the primary project.  

 

See Snapshot Links for more information. 

To create a hierarchy for forensic analysis, complete the following steps: 

1. Click . 

2. On the left-hand pane, click New to create a new workbook. 

3. On the S1 // Projects tab, use one of the Get External Data From menu items to add a 
primary project to the workbook. 

4. Select the primary project and then click one of the Get External Data menu items to add 
a snapshot(s) to the parent primary project. 

5. In the Import menu, click Import All Projects to complete the import. 
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Example of a Workbook Ready for Forensic Analysis 
The screenshot below shows a workbook containing a single primary project with two snapshot 
projects (last month and last year snapshots) assigned. This hierarchy provides the basis for 
running a forensic analysis.  

There is no limit to the number of snapshots that can you can assign to a parent project and 
subsequently analyze using the forensic analyzer.  

 

View the Forensic Analysis Report 
After running a forensic analysis, each field listed in the ribbon area of the Forensics tab displays 
a number in parenthesis. This indicates the number of variances relating to that specific analysis. 
For example, if the Outputs group displays Total Float (27), that means that there are twenty-
seven total float variances between the projects that were analyzed. You can click on the field to 
view variance details in the pane below. 

Example of Number of Variances Indicated Next To Each Field 

 

Hide Forensic Analysis Fields With No Variance 
You can hide all forensic analysis fields in the ribbon area of the Forensics tab that have no 
variance. This allows you to more easily see those areas with variance. 

To hide the forensic analysis fields with no variance, complete the following steps: 

1. Click . 

2. Click Deltek Acumen Options. 
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3. On the User Interface tab, select Hide Forensic Analysis Fields With No Variance. 

4. Click OK. 

Sort and Group a Forensic Analysis Report 
The results are shown in a tabular format which can be modified using sorts, groupings, and 
custom columns.  

 Sort data by clicking on a field header. 

 Group data by drag-dropping a grouping field from the table header to the top of the table 
to create a grouping. 

Calendar Definition Forensics 
The calendar forensics analysis integrates multiple versions of a schedule, identifying changes to 
the calendar definition. This includes changes to standard working/non-working time as well as 
changes to exceptions (for example, holidays). In addition, it can interrogate changes to calendar 
assignments on activities.  

Example of Calendar Definition Forensic Analysis 

 

Modify Reporting Criteria 
You can add additional criteria and columns to the Forensic analysis using the Fields tab.  

 

See Fields Tab for more information. 

To modify criteria and/or columns, complete the following steps: 

1. To access the Fields options, do one of the following: 
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 Select the Fields tab. 

 On the Forensics tab, in the Activity Variances menu, click More. 

  
2. In the fields view, scroll to the right and use the last two columns to customize the 

Forensic report: 

 Compare in Forensics — Creates a new Forensic view that compares differences 
between the snapshots for the given field 

 Show in Forensics — Adds the selected column to all activity-based forensic reports 
(which can then be used for sorting and grouping) 

  
The fields are added to the applicable field group on the Forensics tab. 

Use these two columns to 
customize the Forensic report 
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Example of a Forensic Comparison with Customized Columns and Criteria 
The example below shows a forensic comparison (percent complete) with an additional column 
added (remaining cost). There is no limit to the number of additional comparisons and/or fields 
that you can add including custom fields and Code fields. 
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Generate a Forensics Analyst Report 
The forensics analyst report is generated as a Microsoft Excel file. A separate tab is automatically 
created in the Excel workbook for each forensic check. 

Example of an Analyst Report 

 

To export forensic analysis results to MS Excel, complete the following step: 

1. Select the S1 // Projects tab. 

2. In the Publish menu, click Publish to export Acumen Forensic Analysis results to 
Microsoft Excel. 
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Use the Acumen Dashboard 
The Acumen dashboard provides an interactive overview of project(s) status; schedule quality, 
metrics, forensics, and changes made over time. You can run the dashboard in the context of an 
entire workbook or you can select a specific project from the project view. 

The S5 // Dashboard Tab 
The dashboard comprises two types of customizable widgets: 

 General widgets 

 Project Status 

 Activity Status 

 Forensics 

 Logic Quality 

 Status Overview 

 Analysis widgets 

 Customizable widgets driven by the diagnostics metrics/views 

 

To copy all widgets within the dashboard to the clipboard, complete the following step: 

1. Select the S5 // Dashboard tab. 

2. In the Publish menu, click Copy to Clipboard. 
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Diagnostics (Analysis) Widgets 
You can incorporate results from an analysis created in the diagnostics view into the dashboard 
through diagnostic widgets. You can add multiple widgets to a single dashboard. After you select 
a diagnostic widget, you can customize it using the S5 // Dashboard tab » Settings menu items:  

 View mode — Group by ribbons or metrics and display in horizontal or vertical mode 

 Auto Fit — Automatically fits the data within the widget to the window, eliminating 
scrolling. 

 Copy — Copies the current widget to the clipboard 

 Font — Control of the font within the Widget 
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Cleanse and Resolve Flaws in a Schedule 
Use the Schedule CleanserTM to cleanse and resolve flaws in a schedule. It allows you to specify 
how you want the schedule to be cleansed. The options are as follows: 

 Redundant Logic — Lower redundancy Index to zero by removing unnecessary 
(redundant) links. 

 Hard Constraints — Removes all hard constraints (Mandatory Start, Mandatory Finish, 
Must Start On and Must Finish On) from the schedule. 

 Soft Constraints — Remove all soft constraints (Finish On or After, Finish On or Before, 
Start On or After, Start On or Before, As Late As Possible) from the schedule. 

 Remaining Leads — Removal of negative lags (leads) from the schedule. This results in 
a more realistic forecast. 

 Remaining Lags — Elimination of positive durations on relationships. Achieve this either 
by removing the lags or converting the lags to activities. 

 Links on Summaries — This feature converts relationships that involve summary 
activities into equivalent relationships by connecting only non-summary activities. This is 
helpful because only “real” work in the schedule has relationships and summary activities 
can potentially be removed. 

 If the predecessor is a summary, then: 

1. Acumen searches within the WBS in which the summary predecessor is 
located for activities that have no successors within that WBS. 

2. The same type of relationships between these group of activities and the 
successor activity of the original link are created. 

3. The original link is removed. 

 If the successor is a summary, then: 

1. Acumen searches within the WBS in which the summary successor is 
located for activities that have no predecessors within that WBS. 

2. The same type of relationships between these group of activities and the 
predecessor activity of the original link are created. 

3. The original link is removed. 

 If both the predecessor and successor are summaries, then the above steps are 
combined. 

 

If a relationship of the same type is already being created, then the existing 
relationship is kept and its lag is updated if the newer lag is bigger. 
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If the checkbox next to a cleanse option is: 

 Cleared — None of the items for that option are included in the cleanse. 

 Selected — All items for that option are included in the cleanse.  

 Shaded — Some but not all of the items for that option are included in the cleanse.  

When you click on a cleanse option, the list of related issues displays in the right pane, allowing 
you to include all, none, or only certain items.  

You can include or exclude individual activities. In addition, lags (durations on relationships) can 
either be removed or converted to activities. 

The numbers in the parenthesis next to each cleanse option tell you how many items you have 
included for that option. For example, (2/4) means that you have included two out of four possible 
items. 

Scenarios 
When you run a schedule cleanse, the system creates a scenario instead of updating the source 
schedule file. A scenario is very similar to a snapshot and is a schedule created directly within 
Acumen. Scenarios can be compared to their respective parent projects using the forensic 
analyzer and analysis views.  

 

See Snapshot Links for more information. 
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Run a Schedule Cleanse 
To run a schedule cleanse on MS Project and Primavera P6 schedules, complete the 
following steps: 

1. Select the S1 // Projects tab. 

2. Select the project that you want to cleanse. 

3. To create a scenario, do one of the following: 

a. Right-click on the project and select Create Scenario. 

b. In the Scenario Generation menu, click Cleanse Schedule.  

4. On the Cleanse Schedule dialog box, select the desired cleanse options. 

Click on a specific cleanse option to see the list of related issues in the right pane.  

You can include or exclude individual activities. In addition, lags (durations on 
relationships) can either be removed or converted to activities. 

5. Click OK to create a cleanse scenario.  

The scenario is listed in the S1 // Projects tab Projects tree under the selected project. 

Publish a Scenario to MS Project and Primavera 
After a cleansed scenario has been created, you can publish it back to its original format (MS 
Project or Primavera).  

To publish a scenario, complete the following step: 

1. To export the scenario, do one of the following: 

 Right-click on the scenario in the Projects tab tree view and select the export option. 

 Select the scenario then, in the Scenario Generation menu, click Export Scenario. 

The published file is scheduled/CPM-time analyzed in Acumen before being published 
and therefore has updated early/late dates, float, and so on. 
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The Acumen Application Programming Interface 
(API) 
You can use the Acumen Application Programming Interface (API) for: 

 Custom reporting 

 Integration with 3rd party applications 

 Exporting schedule data to custom formats 

 Integrating with web-services 

 Integrating with third party reporting tools such as Crystal reports 

 Publishing results to portals such as MS SharePoint 

You can add all of these custom reports/applications into Acumen and launched them through 
custom Publish menu items.  

Example of a Custom API Integration 

 

 

See the Deltek Acumen API Guide for more information.  
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Project Risk Analysis 
Acumen Risk is an advanced risk analysis tool for managing both cost and schedule risk 
exposure within a project (or multiple projects). It incorporates utilities such as Monte-Carlo 
simulation and an integrated project risk register, together with risk approaches such as 
Uncertainty Factors™ and Risk Contribution™ reporting. 

Acumen Risk is designed for planners, schedulers, risk analysts, and risk workshop facilitators. It 
is created for ease of use with meaningful reporting that doesn’t rely upon complex statistical 
interpretation. That is, it is designed for project teams wanting to determine their cost and 
schedule risk exposure together with establishing a sound plan for risk exposure reduction. 

The S3 // Risk Tab 
Acumen Risk is part of the Acumen suite and can work either alongside, or apart from, Acumen 
Fuse and Acumen 360. As part of the Acumen platform, all common platform capabilities, such as 
importing from multiple scheduling tools and running forensics, are included in Acumen Risk. 

 
You can use the S3 // Risk tab to (among other things): 

 View, assign, import, and export uncertainty values. 

 View, import, and export risk registers. 

 Perform cost and schedule risk analysis. 

 Determine the most common critical paths. 

 Report, publish, and print risk results. 
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Left and Right Panel Views 
You can use the Views menu on the S3 // Risks tab to select different views for the left and right 
panel. 

Left Panel 

View  Description Related Topic 

Activities 

 

View the project schedule and set 
duration uncertainties. 

See Risk Inputs for more 
information. 

Risk Register Create and maintain project risks 
and integrate them into 
cost/schedule model. 

See Risk Register for more 
information. 

Right Panel 

View  Description Related Topic 

None  

 

If this option is selected then the 
view selected in the Left Panel menu 
displays in the entire Acumen 
window. 

N/A 

Gantt Chart  View the project schedule in Gantt 
chart format. 

See SmartGantt for more 
information and settings for this 
view. 

Uncertainty Inputs  View the breakdown of uncertainty 
inputs. 

See Risk Inputs for more 
information. 

Risk Exposure  View and evaluate risk exposure in a 
histogram. 

See Report Risk Exposure for 
more information. 

Risk Drivers  View cost and schedule risk drivers 
in a tornado chart. 

See Report Risk Drivers for 
more information. 

Risk Comparison  Compare multiple risk exposure 
scenarios. 

See Risk Comparison for more 
information. 

Risk Sensitivity  View relationship and joint 
confidence level (JCL) between 
activities and/or costs in a scatter 
chart. 

See Risk Sensitivity for more 
information. 

Critical Schedule 
Drivers  

View critical paths and near-critical 
paths that become critical due to 
risk. 

See View the Most Common 
Critical Paths for more 
information. 

Risk Register  Create and maintain project risks 
and integrate them into 
cost/schedule model. 

See Risk Register for more 
information. 
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Import Cost/Schedule Data into Acumen Risk 
The starting point for a risk analysis is to import a cost/schedule file from, for example, MS 
Project, Primavera, or MS Excel. Use the standard file import options within the Acumen platform 
to import data for a risk analysis.  

 

See Linking and Importing Projects for more information. 

You can conduct a risk analysis on both projects and snapshots within Acumen Risk.  

Update an Existing Risk Model with a Modified Schedule  
If you are working on a risk model and have assigned uncertainties and risk events, Acumen Risk 
supports a subsequent import of an updated cost/schedule file while still retaining your assigned 
uncertainty/risk values. This allows you to run a risk analysis on updated schedules without 
having to re-create the risk model upon each subsequent update. 

Re-import the schedule/cost file from within the Projects view by clicking the Import button.  

Use a Filter to Focus on a Certain Subset of Activities 
Use the activity view filter to view a certain subset of activities to which you can apply risks or 
uncertainties. 

To use the Activity View filter, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Activities group, click the Activity View down-arrow. 

3. Click Filtering then select a filter. 

 

Trace Logic filters that have been saved will display in this filter list. See Save a Logic 
Trace as a Filter for more information. 

Learn More About Risk Analysis 
The topics that follow include detailed information about: 

 Risk inputs 

 Risk register 

 Running a risk analysis 

 Risk reporting 

 Cost risk analysis 

 Building a risk adjusted schedule 

 Analyzing risk results 
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Risk Inputs 
For activities that are in progress or have not yet started, when you run a risk analysis, Acumen 
calculates a range of uncertainty values for each activity. The values that get calculated depend 
on the distribution type selected. 

View Activity Uncertainty Values 
You can view and edit activity uncertainty values and options in two places in the S3 // Risk tab 
Activity view: 

 In the grid using the uncertainty values columns.  

 

If you can’t see one or more of the columns, right-click on a column and use the 
Column Chooser to add the applicable columns to the grid. 

 On the Duration Uncertainty tab below the grid. 

Distribution Types 
Acumen includes three distribution types when modeling uncertainty. You can see the distribution 
type in the Type column of the Risk activity view. 

The uncertainty values are displayed using both an absolute and a percentage value. If you 
change the one value, Acumen automatically recalculates the other. For example, if you change 
the percentage value, Acumen will automatically recalculate the absolute value as soon as you 
move off the field, and vice versa.  

You can change the values and options for each distribution type both on the grid or on the 
Duration Uncertainty tab. 

  — This type calculates minimum, most likely, and maximum remaining 
duration and is the default type. These values can be seen in the following columns:  

 Min Duration 

 Most Likely Duration 

 Max Duration 

 Min Duration % 

 Most Likely Duration % 

 Max Duration % 

  — This type calculates a mean remaining duration and can be seen in the 
following columns: 

 Mean Duration 

 Mean Duration % 

The normal curve includes a standard deviation option that controls the width of the bell 
curve. The default is 1.  

  — This type calculates a minimum and maximum remaining duration and 
can be seen in the following columns: 

 Min Duration 
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 Max Duration 

 Min Duration % 

 Max Duration % 

You can define the distribution type for each activity in the activities view or include this as part of 
the Uncertainty template set up.  

 

Disable Uncertainty for Specific Activities 
You can disable uncertainty values for any activity row using the Use Duration Uncertainty 
column. Deselet the checkbox to disable uncertainty for the selected activity.  

 

If you can’t see the Use Duration Uncertainty column, right-click on a column and use the 
Column Chooser to add it to the grid. 

Assign Uncertainty 
Assigning uncertainty is the first step when developing a risk model. Uncertainty is typically driven 
by unknown scope or complexity of work. You can assign uncertainty using one of two modes: 

 Graphically assign using the Uncertainty Factor™ sliders. 

 Manual data entry of minimum, most likely, and maximum ranges. 

Deltek recommends that the Uncertainty Factor approach is used for developing risk models. It 
provides a fast, consistent, and validated means of risk-loading a model, avoiding potential errors 
in data entry.  

The Uncertainty Factor Template 
Prior to applying uncertainties to the risk model, you should first define the Uncertainty Factor 
template. An Uncertainty Template is used by the project team to describe the degree of buy-in 
and confidence in the underlying durations and costs in the risk model. You can configure it to 
model a varying number of uncertainty categories. 
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You should not use an uncertainty template for modeling the potential impact of risk events. This 
is covered through the use of the risk register. 

To define Uncertainty Factor templates, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Templates menu, click Uncertainty Template.  

 
3. Use the Size slider to set the desired number of categories.  

4. Enter or edit Name and Type. 

5. Enter or edit Min, Most Likely, and Max percentages. 

These percentages are used when applying the template to the risk model.  

 

Deltek recommends that you use the standard 5-point scale using the default Acumen 
Risk Workshop categories and associated percentage values. 

6. Click Save to save the template.  

This allows you to re-apply it to other risk models or apply it during different phases of the 
project lifecycle. 

7. If you loaded a new template, or made changes to an existing template, click Apply to 
have the changes reflected in the Risk model.  

Set the Uncertainty Loading Level 
After the Uncertainty Factor template has been defined, you need to set the level at which you 
are going to conduct your risk workshop/risk loading.  

To set the Uncertainty Loading level, complete the following steps: 
1. Select the S3 // Risk tab. 
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2. In the Activities menu, click the Activity View down-arrow then hover over Grouping to 
display a sub-menu where you can adjust the Display Level slider. 

 
3. Set the level based on the level at which you want to risk load your risk model.  

Setting the risk loading level is a means of making the risk loading process practical, avoiding the 
need to manually risk load every single activity within your potentially large schedule. The next 
section describes how, irrespective of the level you set, the risk loading process actually applies 
risk and uncertainty to the entire schedule.  

Define Uncertainty Factors 
After the risk loading level has been set, you can define your Uncertainty Factors to your risk 
model.  

To define the uncertainty factors, use a top down approach using the Uncertainty Factor sliders in 
the spreadsheet view.  

 
As you assign an uncertainty factor value to any given parent node, all children nodes 
automatically inherit the same applied Uncertainty Factor category. This top-down inheritance 
approach results in an extremely fast means of applying uncertainties to large schedules.  

Each time you set a node, it, and its children, become locked so that any subsequent 
manipulation of uncertainty values higher up in the schedule hierarchy does not impact the 
explicit change that you made at the node level.  

Example of Using Assigned Uncertainty 
The screenshot below shows an example of a project that is using the standard Acumen 5-point 
scale.  

The project as a whole has been set to Very Aggressive and thus all activities within the entire 
project inherited a Very Aggressive ranking. However, Detailed Design has been overridden as 
Very Conservative therefore all Detailed Design activities, except Base, are set to Very 
Conservative. Base has been singled out as being Very Aggressive.  

Any subsequent changes to the Detailed Design group (at the group level) won’t impact the Base 
activity until that activity has its padlock icon released. 
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This hierarchical approach to uncertainty loading allows you to build risk models in a timely 
manner. 

You can also adopt manual uncertainty loading by entering three-point estimates and associated 
distribution types (triangular, normal, uniform). If an activity is manually loaded, the Uncertainty 
Factor slider turns grey and is locked until the slider is re-activated by sliding the slider. 

The Risk Adviser 
The Risk Adviser™ helps to speed up the uncertainty assignment process by suggesting 
uncertainty ranges for each activity based on a given criteria.  

To set up the Risk Advisor, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Activities menu, click Risk Advisor.  

3. On the Risk Advisor dialog box, select one of the four options:  

 Schedule Quality — This option presents uncertainty assignments based on the 
Fuse Schedule Index score for each activity and activity grouping. By default, a score 
of lower than 10% will warrant a Very Aggressive assignment. Conversely, a score of 
greater than 75% will lead to a conservative uncertainty assignment.  

 Historical Performance — This mode compares the baseline plan to the current 
schedule and looks for discrepancies. The greater the variance between the two, the 
more aggressive that activity will be flagged.  

 Metric — Select any Acumen metric to use as the basis for uncertainty assignments.  

 Field — Select any field from the project to use as the basis for uncertainty 
assignments.  

4. Click Calculate Advice. 

After the Risk Adviser has calculated the advice, the recommendations are displayed in 
the Activities view.  
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5. Click the  Risk Advisor icon next to any activity or activity grouping to implement the 
recommended uncertainties. 

 

Import and Export Activity Uncertainty Data 
You can export uncertainty values for all in-progess and planned activities to an Excel 
spreadsheet. You might do this if you want to send the spreadsheet to someone for review, or if 
you want to edit the values in a spreadsheet format instead of in Acumen.  

When you have completed your edits, you can import the data back into Acumen. When you 
reimport the data, you have the option to import either the absolute or percentage values. The 
value type that you select is imported and the other is calculated after import. For example, if you 
elect to import the absolute values, then after the import completes, the percentage values are 
calculated. 

Use an Activity Uncertainty Spreadsheet 
You can use the spreadsheet to change values, activity descriptions, and uncertainty types. If you 
change an absolute value, the equivalent percentage value field is automatically recalculated. 

In addition to the three distibution types (triangle, normal, and uniform), the spreadsheet includes 
a None option in the Uncertainty Type column. Select this option to disable uncertainty for the 
selected activity. This has the same affect as deselection the checkbox in the Use Duration 
Uncertainty column in the Activity view in Acumen. 

In order to prevent errors when importing the spreadsheet back into Acumen, note the following: 

 Min Duration, Most Likely Duration, and Maximum Duration fields must be ascending 
amounts/percentages.  

For example, Min Duration % = 90, Most Likely Duration % = 100, Max Duration % = 
103.  

 The columns and column headings must remain the same. Do not remove or add any 
columns or edit any column headings. 

 Keep the column format the same. For example, don’t replace the numbers in the Min 
Remaining Duration column with letters. 

 Don’t change any of the activity ID’s. 

 

Tip: If you want to create a new activity uncertainty spreadsheet in Excel, Deltek recommends 
renaming an existing activity uncertainty spreadsheet and deleting the data so that the 
formatting is correct and errors are prevented when you import the data into Acumen. 

Export Activity Uncertainty Data to a Spreadsheet 

To export activity uncertainty data to a spreadsheet, complete the following steps: 

1. Select the S3 // Risk tab. 
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2. In the Views menu, click Left Panel » Activities. 

3. In the Import / Publish menu, click the Excel down-arrow and select Export Activity 
Uncertainty. 

4. Using the Save As dialog box, save the spreadsheet.  

The file name defaults to <project name> Activity Uncertainty; however, you can 
change that file name if desired. 

Excel opens with the spreadsheet displayed. 

Import Activity Uncertainty Data into Acumen 
To import activity uncertainty data into Acumen, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click Left Panel » Activities. 

3. In the Import / Publish menu, click the Excel down-arrow and select Import Activity 
Uncertainty. 

4. In the Open dialog box, select the spreadsheet and click Open. 

5. On the Import Activity Uncertainty dialog box, specify whether you want to import 
absolute or percentage values.  

If you select: 

 Absolute — Percentage values are calculated after import. 

 Percentage — Absolute values are calculated after import. 

 Cancel — The import is cancelled. 

The data imports into Acumen and displays on the S3 // Risk tab in the Activity view. If there were 
any errors, a dialog displays listing details of each error. Rows with errors are not imported into 
Acumen.  
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Modeling Task Existence 
Acumen Risk provides a means of modeling task existence. If you are not 100% certain that a 
task is going to happen in your schedule, you can assign a probability to the task to reflect this 
confidence level(for example, Re-work).  

 

Activity Correlation 
Use this option to select activities within the schedule that may impact one another.  

To correlate the uncertainty of one activity to another, complete the following steps: 

1. Select the S3 // Risk tab. 

2. Click the Correlation icon   next to the “driving activity.”  
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3. On the Correlation dialog box, select the activities that should be correlated to the driving 
activity. 

 
4. Click OK.  

The uncertainty of the driving activity will be correlated with any other activity to which it 
has been linked.   

Correlation Column Symbols 
Each symbol in the activity correlation column relates to a correlation option.  

Activity Activity Correlation Settings 

 
No correlation has been applied to this activity. 

 
This activity is a “driving activity” for other correlated activities. 

 
This activity has been included in a set of “driven activities” linked to a “driving 
activity. 

 
This activity is a “driving activity” linked to other activities and has also been 
selected as a “driven activity” by another driver. 

View Uncertainty Distributions 
During the Uncertainty loading process, the Gantt chart colors activities based on their 
uncertainty ranking. In a similar manner, you can use the Uncertainty Inputs view to interactively 
see the distribution of uncertainties as you develop the risk model. 
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To see the Uncertainty Inputs view, click S3 // Risk » Views » Right Panel » Uncertainty 
Inputs.  
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Risk Register 
Risk events are discrete events (threats or opportunities) that carry both a probability and a 
potential cost/schedule impact to the project. They are typically captured and modeled in a risk 
register.  

When you perform a risk analysis, you start by entering the risks into the risk register and 
assessing the probability of the risk occurring as well as the impact that you feel it will have on the 
schedule and cost. Acumen uses the probability indicator, together with either the cost or 
schedule risk impact (whichever is higher), to score and color-code the risk. The color coding 
allows you to easily see the different risk levels and the scoring allows you to prioritize risks. 

View the Risk Register 
To view the risk register, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click Risk Register from either the Left Panel or Right Panel menu. 
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Define the Risk Scoring Matrix 
Before defining risks, you need to define how you want risks to be scored when running a risk 
analysis. You do this in the the Event Template Editor. After defining the probability and impact 
values, the template can then be saved and re-applied to other projects and snapshots. 

 

Access the Event Template Editor 

To access the risk matrix Event Template Editor, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Templates menu, click Risk Matrix to display the Event Template Editor. 

Add, Edit, and Delete Custom Impact Types 
You can add, edit, and delete custom event impacts and include a custom prefix and/or suffix. 
The impact units will display in either days or hours, depending on your Duration Time Unit 
setting. 

 

You cannot edit the default cost and schedule impact types. 

 

See Set Display Units for information about changing your display from days to hours and vice 
versa. 
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To add a custom impact type, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Templates menu, click Risk Matrix. 

3. On the Event Template Editor dialog box, click Impact Types » Add. 

A new impact type is added to the bottom of the list. 

4. In the Name column, overwrite New Impact with the name that you want for the new 
impact. 

5. In the Prefix and Suffix columns, enter data as needed. 

6. Edit the Very Low through Very High columns as needed. 

7. Click OK. 

To delete a custom impact type, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Templates menu, click Risk Matrix. 

3. On the Event Template Editor dialog box, select the imact type you wish to remove. 

4. Click Impact Types » Delete. 

5. Click OK. 

To edit a custom impact type, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Templates menu, click Risk Matrix. 

3. On the Event Template Editor dialog box, click on a custom impact type and edit the 
fields as needed. 

4. Click OK. 

Edit the Probability / Scoring Template 
The risk register uses the information in the Probability / Scoring grid to score and color code the 
risk events. Set probability percentages and score ranges (in the Very Low to Very High columns) 
that will help you to assess and prioritize risks. Use the color thresholds (described in the next 
topic) to adjust the color ranges as needed. 
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You can edit all cells in this grid. To edit a cell, click in the cell and enter the new data. 

Increase or Decrease Number of Color Threshold Options 
You can use the color thresholds slider to increase or decrease the number of color thresholds 
between 2 and 5. In addition you can use the color palette to select each threshold color. 

 

 

Use User-Defined Fields in the Risk Register 
You can add up to 10 user-defined fields to the risk register. For example, if you have a risk event 
relating to a possible strike, you may want to add an email field that contains the Human 
Resources manager’s email address. These user-defined fields are included when you 
import/export the risk register. 

To add a user-defined field to the risk register, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Templates menu, click Risk Matrix. 

3. On the Event Template Editor dialog box, in the Risk Register Custom Fields area: 

a. Highlight the text on a line in the Name column and enter the name of the custom 
field that you want to add. 

b. Select the Is Enabled checkbox in the same line to add that custom field to the 
risk register. 

4. Click OK to close the template editor. 
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In the Risk Register view, scroll to the right to view the custom fields which display after 
all other fields. 

To remove a user-defined field from the risk register, access the Event Template Editor and 
deselect the Is Enabled checkbox for that field. 

Automatic Calibration 
Use the Auto Score and Auto Range features in the Event Template Editor Calibrate menu for 
automatic calibration. 

 Auto Score — Use to automatically set the values in the Probability/Scoring matrix. 

 Auto Range — Use to automatically set the impact values based on the duration and the 
cost of the workbook. 

Create Risk Events 
After the risk matrix has been defined, you can add risk events to the risk register.  

To add risk events to the register, complete the following steps: 
1. To create a new risk event: 

 Click on the risk matrix icon from within the main spreadsheet view. This will 
automatically create a new risk event as well as link it to the activity from which you 
clicked. 

 
 Manually add a risk event from within the risk register. 

 

See Mapping Risk Events to Activities for additional information about manually 
added risks. 

2. Define the following required risk attributes as well as any others you wish to define: 

 ID — The Risk ID. 

 Probability — Chance of the risk event happening. 

 Schedule — Direct impact on the activity/schedule. 

 Cost — Direct cost impact on the activity/cost estimate in question. 

 Type — Is it a threat, opportunity, calendar event, or risk window? 
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Acumen Risk includes the following risk event types: 

 Threat — A threat is any event that may negatively impact the project. This risk 
can carry a probability of occurrence, the likely impact on schedule and/or cost.  

 Opportunity — An opportunity is any event that may positively impact the 
project. This risk can carry a probability of occurrence, a schedule impact and a 
cost impact.  

 Calendar Event — A calendar event is a discrete risk event that is tied to a 
certain period of time. This risk carries a time period (months of the year in which 
it could occur) as well as a probability of occurrence for each month. In addition, 
the minimum/most likely/ and maximum impacts can be included.  

 Risk Window — A risk window is a time period that may cause a delay for the 
project. This risk carries a minimum/most likely/maximum time period of 
occurrence.  

 
3. Select the Mitigation column option to compare the current risk exposure state and a 

target state assuming mitigation is carried out. 

A risk event can carry both a Current and Mitigated State.  
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4. If needed, enter mitigation duration and cost overhead.  

 
As part of defining a mitigated state for a risk, Acumen Risk can also calculate the 
cost/benefit of executing a mitigation plan. In order for this to be calculated, a duration 
and cost overhead of mitigation needs to be defined against the risk event.  

Subsequently, when running a risk analysis, alternate scenarios can be generated either 
accounting for, or ignoring both the impact and/or overhead of executing mitigation. 

Map Risk Events to Activities 
Risk events need to be mapped to activities/cost elements in order to be included in the risk 
model. If you used a   Risk Matrix icon to create a new risk, the risk is automatically mapped 
and no manual mapping is required. 

If you manually created a risk event in the risk register, then it needs to be mapped back to an 
activity or group of activities. Risks can be mapped to both individual activities as well as 
groups/summaries/WBS elements.  

If you map a risk event to, for example, a parent WBS element, then all children activities 
automatically get mapped as well. This provides a very fast means of mapping to summary 
groups of activities yet still retains accuracy of the model itself. 

You can complete manual risk mapping either from a risk to activity(s) or activity to risk(s) 
perspective. 

Absolute Mapping 
The way Acumen Risk assigns risk impact across multiple activities depends on whether or not 
you use absolute mapping: 

 No absolute mapping — Risk is spread across multiple activities. If you map a risk event 
to a parent activity with no absolute mapping, the impact of the risk event gets spread 
across all children activities and is pro-rated based on the relative duration/cost of the 
children. 

 Using absolute mapping — Total risk is allocated to each activity. If you map a risk event 
to a parent activity and use absolute mapping, the total impact of the risk event gets 
allocated to each child activity. 

Example of Spreading Risk vs. Allocating Total Risk to Multiple Activities 

You have the following activities: 

Activity Remaining Duration 

Activity A 17d 

Activity B 65d 
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You map a high probability risk with a very high schedule impact to Activity A. In the Risk Matrix 
Template, Very High Impact is set to 120-150 days. 

Activity Remaining Duration Minimum Duration Maximum Duration 

Activity A 17d 120d 150d 

If you map that same risk to Activity B, the risk impact is spread over the two activities.   

Activity Remaining Duration Minimum Duration Maximum Duration 

Activity A 17d 25d 31d 

Activity B 65d 95d 119d 

If you map the risk to multiple activities and click the Absolute Mapping option next to the risk, the 
entire risk impact is allocated to each activity. 

 

Activity Remaining Duration Minimum Duration Maximum Duration 

Activity A 17d 120d 150d 

Activity B 65d 120d 150d 

Using Absolute Mapping 

You select absolute mapping using the Absolute Column in the Risk Register view on the S3 // 
Risks tab.  

After mapping a risk to multiple activities, select the checkbox in the Absolute Column next to the 
risk for which you want to use absolute mapping. You can see the changes in the Minimum and 
Maximum Duration columns on the Mappings tab. 

Manually Map a Risk to Multiple Activities 

To manually map a risk to multiple activities, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click: 

 Left Panel » Risk Register 

 Right Panel » Activities 
3. In the Risk Register (left pane), select the risk that you wish to map. 

4. In the Activities panel (right pane) Mapped column, select the checkbox next to the 
activities you wish to map to the selected risk. 

After mapping has been applied, you have the option to override mapped activities using 
the Mappings tab beneath the Risks (left pane). 
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5. (Optional), In the Risk Register (left pane) Absolute Mapping column, select the checkbox 
next to the risk(s) for which you want to use absolute mapping. Absolute mapping is 
applied to all activities that are mapped to that risk. 

Manually Map an Activity to Multiple Risks 

To manually map an activity to multiple risks, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click: 

 Left Panel » Activities 

 Right Panel » Risk Register 
3. In Activities (left pane), select the activity that you wish to map. 

4. In the Risk Register (right pane) Mapped column, select the checkbox next to the risks 
you wish to map to the selected activity. 

After mapping has been applied, you have the option to override the mapped impacts 
using the Risk Events tab beneath the activities (left pane). 

5. (Optional), In the Risk Register (right pane) Absolute Mapping column, select the 
checkbox next to the risk(s) for which you want to use absolute mapping. 

Import and Export Risk Registers 
Acumen Risk allows you to import and export risk registers to and from Microsoft Excel.  

When Acumen imports or exports a risk register, the activity duration field units display in the unit 
that you have set in the Display Settings Duration Time Unit field. For example, if your Duration 
Time Unit field is set to Hours and you import a risk register with activity duration fields in days, 
Acumen will convert the activity duration fields to hours. Conversely, if your Duration Time Unit 
field is set to days, and the spreadsheet you are importing displays duration fields in hours, 
Acumen will convert the fields to display in days. 

Risk Register Import/Export Activity Durations 
When Acumen imports or exports a risk register, the activity duration field units display in the unit 
that you have set in the Display Settings Duration Time Unit field. For example, if your Duration 
Time Unit field is set to Hours and you import a risk register with activity duration fields in days, 
Acumen will convert the activity duration fields to hours. Conversely, if your Duration Time Unit 
field is set to days, and the spreadsheet you are importing displays duration fields in hours, 
Acumen will convert the fields to display in days. 

 

See Set Display Units for more information. 

To export a risk register, complete the following steps: 

1. Select the S3 // Risk tab. 

1. In the Views menu, make sure that Risk Register is selected in the Left or Right panel. 

2. In the Import / Publish menu, click the Excel down-arrow and select Export Risk 
Register to Excel. 
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3. In the Save As dialog box, navigate to the preferred folder and enter a File Name. 

4. Click Save. 

After being exported, you can edit/add/remove risks outside of Acumen Risk and then 
subsequently import them back into the Acumen Risk risk register. 

To import a risk register, complete the following step: 
1. Select the S3 // Risk tab. 

2. In the Views menu, make sure that Risk Register is selected in the Left or Right panel. 

3. In the Import / Publish menu, click the Excel down-arrow and select Import Risk 
Register from Excel. 

4. Browse to and select the risk register you wish to import and click Open. 

5. If the workbook that you select contains more than one risk register worksheet, a Settings 
dialog box displays. Select the worksheet you want to import and click OK. 

 

Use RiskBook for Risk Register Collaboration 
When you create risk events in Acumen, you may want others to review them and to provide 
input about the risk levels and impacts. You now have the option to publish your risk register and 
risk scoring matrix to RiskBook; an Acumen Add-on that uses Kona’s cloud-based social 
collaboration and productivity features.  

When you publish a risk register to RiskBook, Kona creates a space for that risk register. A new 
space is created for each risk register that you publish to RiskBook. All the risks that were in the 
risk register are published to the Kona space and can be viewed on the Risks tab. You can click 
on a risk and see a complete risk breakdown, including the values that the risk register owner 
entered for probability, as well as schedule and cost impacts.  

As the owner of the Kona space, you can invite people to the space to add comments and to 
share their opinions about the risks. For example, you may have listed a very high risk probability 
whereas others may feel the probability is a medium risk.  

In addition, you can use the other Kona tabs, such as the Conversations and Tasks tabs, to 
discuss the risks and to add tasks for others to complete. For example, you may add a task 
requiring each person in the space to add their own scores to the risk items. 
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As with other Kona spaces, you have the option to set up space templates. For example, you 
may want to create a template that includes standard tasks relating to risk register. When you 
publish to RiskBook, you can select the template which Kona then uses when creating the space. 

After everyone has provided feedback, you can export the risk register to an XML file format 
which can then be imported back into Acumen. You can then compare your original risk register 
with the collaborative version and make any needed adjustments. 

 

The Acumen RiskBook license includes a Kona Business Account. 

The Kona Business Token 
The Kona Business Token includes three fields (Redirect URL, Client ID, and Client Secret) 
and is used to link Acumen to Kona. You will need this information if you need to manually enable 
RiskBook in Acumen (see next topic). 

 

You must be a Kona Business Account Administrator in order to obtain the Kona Business 
Token. 

To obtain the Kona Business Token, complete the following steps: 

1. From Kona, click Accounts in the left sidebar. 

2. Click the Account name. 

3. Click Edit Account in the upper right portion of the screen. 

4. Click the Integrations tab. 

5. If Acumen is listed, skip to step 8, otherwise continue with step 6. 

6. Click Add applications and complete the fields: 

 Application Name — Enter Acumen. 

 Redirect URL — Enter https://www.deltek.com. 

7. Click Done. 

The Acumen Client ID, Client Secret, and Redirect URL are listed on the tab.  

8. Do one of the following: 

a. Copy and paste each field entry into the corresponding field in Acumen: 

i. Click . 

ii. At the bottom of the pane, click Deltek Acumen Options. 

iii. On the Platforms tab, paste each field entry into the corresponding field. 

b. Email the information to another user. 

Enable RiskBook in Acumen 
When you purchase a RiskBook license, Acumen should automatically be set up to publish a risk 
register to RiskBook. If the Publish Risk Register to RiskBook icon on the S3 // Risk tab is 
grayed out, you may need to manually enable RiskBook. 
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To manually enable RiskBook, complete the following steps: 

1. In Acumen, click . 

2. On the bottom of the pane, click Deltek Acumen Options. 

3. On the Platforms tab, in the Kona by Deltek group, complete the following fields (this set 
of fields is known as the Kona Business Token): 

 Redirect URL 

 Client ID 

 Client Secret 

 

If you do not know the Kona Business token information that needs to be entered, 
please contact your Kona Business Administrator or Kona Support 
(support@kona.com), or you can log a case at: http://support.kona.com/tickets/new. 

4. Click OK to save the information and close the dialog box. 

Publish a Risk Register to RiskBook 

 

In order to publish a risk register to RiskBook, you need to be a member of the Kona Business 
Account. 

If you do not have a Kona account, contact your administrator, or Kona Support 
at support@kona.com, to request that they add you to the Kona Business Account. An email 
will then be sent to you with details about setting up your account. 

To publish a risk register to RiskBook, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, make sure that Risk Register is selected in the Left or Right panel. 

3. Use the risk register to create your risk events. 

If you enter an email in the risk register Owner Email column, and the user is a member 
of the Kona Business account, then when the risk register is published to RiskBook, the 
user will get an email inviting them to the space. 

 

See Risk Register for more information. 

4. In the Import / Publish menu, click the RiskBook down-arrow and select Publish 
Register to RiskBook. 

 

If this option is grayed out, see Enable RiskBook for more information. 

5. Do one of the following: 

 If you have set up a RiskBook space before, skip this step. 

 

If you have changed your password, you will need to re-authenticate by following 
the directions in Step 3 below.  

mailto:support@kona.com
http://support.kona.com/tickets/new
mailto:support@kona.com
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 If this is your first time setting up a RiskBook space, or if you have changed your 
password: 

i. On the Kona Log In screen, enter your Kona login details.  

 

If you are a Kona Business Account administrator logging into your 
account for the first time, click the question mark icon to display the reset 
password screen where you can set up your own password. 

 
ii. Click Log In. 

iii. On the Kona Integrate Risk Register screen, click Yes, Grant Access to 
allow Risk Register to access your Kona account. 

  

 

You only need to perform this login step the first time you access RiskBook or if 
you change your password. Acumen retains your Kona login information so that, 
when you create another RiskBook space, you won’t need to enter your login 
details or grant access to Kona again. 
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6. On the Create an Acumen RiskBook Register screen, complete the fields. 

 
 Space Name — Enter the name of your RiskBook space. 

 Description — Enter a description of the space. 

 Overview — Use this field to describe the purpose for the space. 

 Account — If you have more than one Kona account, select the account that Kona 
should use when creating the space. 

 Optional Template — If you have set up Kona templates, use this field to select a 
template to apply to the space. If this field is blank, then no template is applied. 

7. Click OK. 

8. Kona opens a browser window or a browser tab (depending on your browser settings) 
and creates the space. 
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9. The Risks tab lists all the risks from the published risk register. 

 

Start Using RiskBook 
After you create the RiskBook space, you can invite people to the space to start conversations 
and get input on the risk register.  

Open a risk to:  

 View details about the risk register owner’s threat analysis score. 

 View or add comments. 

 View consensus results, including a breakdown for each category. 

 Add your own threat analysis scores. 

 View the risk matrix that the risk register owner set up. 
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Example of a RiskBook Risk 

 

Export Risk Register from RiskBook 
After everyone has provided feedback, you can export the risk register to an XML file. 

To export the risk register from RiskBook, complete the following steps: 

1. In RiskBook, click Export risk data. 

 

You must be in a specific space to export. You cannot export from My Kona as that is 
a cross space/project area. 

The export may take several minutes to complete. When complete, the number on 
your Kona notifications icon will increase by 1. 

The exported risk register is attached to the RiskBook space as a spreadsheet file. The 
file name is the same as the risk register Kona space name. 

2. Use the Files tab to open or download the file. 

Import a Risk Register From RiskBook 
When you import a risk register from RiskBook into Acumen, you can import the owners values or 
the consensus values.  

The owner is the person who created the risk. The owner may not be the same person for all 
risks listed in a risk register. For example, Risk 1 may have been created by John and Risk 2 may 
have been created by Sam. The owner’s values are the values for probability schedule and cost 
impact that the owner entered for the risk. 

The consensus values are the average values of all the votes cast in RiskBook for probability 
schedule and cost impact for the selected risk register. 

View consensus 
results 

View risk matrix 

Add threat analysis 
scores 

Export risk register 
to XML file 
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To import a risk register from RiskBook, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, make sure that Risk Register is selected in the Left or Right panel. 

3. In the Import / Publish menu, click the RiskBook down-arrow and select Import Register 
from RiskBook. 

4. On the Import a Deltek RiskBook Register dialog box: 

a. In the Account field, select the account. 

b. In the Risk Register list, select the risk register you want to import. 

c. Select Owners Values or Consensus Values. 

d. Click OK. 

The values and scores are brought from RiskBook into the Acumen Risk Register. 

Compare Owner and Consensus Values 
You can use risk comparison to compare what the owner thinks about the risks to what the rest of 
the team thinks. In order to do so, you must run risk analysis twice; once with the owner results 
and once with the consensus results. 

To compare the owner and consensus results, complete the following steps: 

1. Import the consensus version of the risk register. 

It makes no different whether you import the owner or consensus risk register first. 

 

See Import a Risk Register from RiskBook for steps. 

2. Select the S3 // Risk tab. 

3. In the Views menu, click Left Panel » Activities. 

4. In the Views menu, click Right Panel » Risk Register. 

5. Using both panels, map activities to risks. 

 

See Mapping Risk Events to Activities for more information. 

6. In the Analysis menu, click Run Risk Analysis. 

After the analysis completes, the right-pane displays a risk histogram. 

 

See Reporting Risk Exposure for more information about the risk histogram. 

7. In the Views menu, click Right Panel » Risk Comparison. 

The Risk Comparison chart displays the consensus curve. 

 

See Risk Comparison for more information. 
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8. (Optional) In the right pane, on the Curves tab in the Name column, rename the scenario. 

9. Import the owner version of the risk register (or consensus version if you first imported 
the owner version). 

 

See Import a Risk Register from RiskBook for steps. 

10. A message displays asking if you want to keep the mappings. Click Yes if you don’t want 
to remap activities to risks. 

11. In the Analysis menu, click Run Risk Analysis. 

12. After the analysis completes, the right-pane displays the risk histogram. 

13. In the Views menu, click Right Panel » Risk Comparison. 

The Risk Comparison chart displays the owner and consensus curves in different colors.  

14. (Optional) In the right pane, on the Curves tab in the Name column, rename the scenario. 
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Run A Risk Analysis 
Acumen Risk uses a Monte Carlo simulation engine as the basis of its risk analytics. The engine 
is fast and flexible with the most common and appropriate settings enabled by default.  

Risk Analysis Options 
To access the risk analysis options, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Analysis group, click the Run Risk Analysis down-arrow. 

The risk analysis options are described in the table below. 

Run Risk Analysis Option Description 

Simulation Options 

 

Acumen Risk provides options for setting the 
number of simulation options.  

While 1,000 iterations is adequate for most 
schedules with an order of magnitude of 1,000 
activities, you have the option to change the 
specific number of iterations.  

If you select Complete Automatically, Acumen 
Risk will automatically determine the number of 
iterations to run based on a given level of 
accuracy (as defined in the Automatic Accuracy 
option).  

Scenarios 

 

Multiple scenarios can be generated in Acumen 
Risk. Four different analysis modes can be run: 

 Uncertainty only — The risk model only 
takes into account uncertainty and ignores 
any risk event impact 

 Uncertainty and Risk Events (No 
mitigation) — The risk model accounts for 
uncertainty and risk events but excludes any 
mitigating impacts 

 Uncertainty and Risk Events (mitigated 
excluding overhead) — The risk model 
accounts for uncertainty and risk events in 
their mitigated state but ignores the 
cost/schedule overhead of achieving this 
mitigation.  

 Uncertainty and Risk Events (mitigated 
including overhead) — The risk model 
accounts for uncertainty and risk events in 
their mitigated state and takes into account 
the cost/schedule overhead of achieving this 
mitigation.  
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Run Risk Analysis Option Description 

All four scenarios can be applied to the base risk 
model or used in conjunction with creating 
alternate scenarios.  

Interaction 

 

Run a risk analysis in three modes: 

 Automatic — Runs the analysis without 
screen interaction. Benefits from multi-
threading (very fast). 

 Interactive — Provides real-time screen 
updates during the analysis. 

 Diagnose — Allows you to manually step 
through each iteration. 

Repeatability 

 

Acumen Risk includes the option to use repeated 
risk analysis giving the exact same results. This is 
achieved through fixed seed. This option is on by 
default. 

Activity Correlation 

 

Correlate uncertainty outcomes between activities 
that have been previously set up via the correlate 
command.  

By setting a correlation, you estimate how closely 
the uncertainty distribution of one activity is 
followed by others. Negative correlation means 
that if one value is sampled high, the other tends 
to be sampled low and vice versa for positive 
correlation. 

See Activity Correlation for more information. 

Historical Risk Models 

 

The Correlation Coefficient allows you to use 
correlation as a means of overcoming the Central 
Limit Theorem on activities that have been 
previously set up via the CLT check box.  

By setting the correlation coefficient, the 
uncertainty distributions of the checked activities 
follow the values of their summaries in a similar 
manner as they would when using manual 
correlation. 

Cost/Schedule Integration 

 

Use this option when running cost risk models and 
should be enabled if the impact of schedule delay 
is to be taken into account in the cost model. 
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Create Multiple Scenario Risk Models 
To create multiple scenario risk models, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Analysis menu, click the Build Scenario down-arrow and select Create Copy. 

Acumen Risk creates a copy of the currently selected risk model, enabling you to run 
what if… analysis using different settings such as different scenarios analysis options. 
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Determine the Most Common Critical Paths in a 
Schedule 
When you run risk analysis and include uncertainties and risk events, each simulation may have 
a different critical path. Activities that are critical in your deterministric schedule may not be the 
same as those identified in the statistical model. 

Instead of looking at the critical path on the activity level, you can run simulations on the entire 
project. Each time a simulation is run, Acumen notes the critical path. As you run more and more 
simulations, some of the paths get repeated and those most common critical paths are the ones 
you may want to see.  

Acumen uses a Critical Schedule Driver tornado chart to display the most common critical paths. 
The percentage that displays to the right of each bar is how often, as a percentage, the path is 
most critical. For example, if you run 200 iterations and the Path 1 bar displays a percentage of 
13%, it means that Path 1 was the critical path in 26 (13%) of the 200 iterations. 

If you hover over a bar, you can see the list of activities that make up that path. You can create a 
SmartGantt filter using this information and use it to view the activities and make any needed 
adjustments. 

Example of a Critical Schedule Driver Tornado Chart 
This example shows a list of the critical paths, listed from most common to least common. The 
activities that make up the second most common path are displayed. 
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View the Most Common Critical Paths 
To view the most common critical paths, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Import your project into Acumen or select the project in the Projects pane. 

 

See Importing Project Data for more information and steps on how to import project 
data. 

3. Select the S3 // Risk tab. 

4. In the Analysis menu, click the Run Risk Analysis down-arrow to set the risk analysis 
options and run risk analysis. 

 

See Running a Risk Analysis for more information on the Risk Analysis options. 

5. In the Views menu, click Right Panel » Critical Schedule Drivers. 

Acumen calculates the most common critical paths and displays them in the right pane. 

This calculation is not driven by the selected activity but is instead calculated at the 
project level. 

6. In the Critical Schedule Drivers menu, click Configuration to select the number of critical 
paths you wish to display in the right pane. 

Create a SmartGantt Filter Using Critical Path Data 

Create a SmartGantt Filter Using a Critical Path 

To create a SmartGantt filter using a critical path, complete the following steps: 
1. On the S3 // Risk tab, click on a critial path in the tornado chart and select Create 

SmartGantt Filter from the menu that displays. 

 

See View the Most Common Critical Paths above for steps to view the critical path. 

2. In the Create Filter dialog box, enter a filter name and click OK. 

The filter is added to the Activity view filtering menu (Activities menu » Activity View » 
Filtering). 

 

See Filter Activities for more information including using, editing, and deleting activity 
filters. 

Create and Apply a SmartGantt Filter Using a Critical Path 

To create and apply a SmartGantt filter using a critical path, complete the following steps: 

1. On the S3 // Risk tab, click on a critial path in the tornado chart and select Create and 
Apply SmartGantt filter from the menu that displays. 
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See View the Most Common Critical Paths above for steps to view the critical path. 

2. In the Create Filter dialog box, enter a filter name and click OK. 

The filter is applied to the activities in the Activity view and is also added to the Activity 
view Filtering menu  (Activities menu » Activity View » Filtering). 

 

See Using a Filter to Focus on a Certain Subset of Activities for steps on how to use the filter to 
view a subset of activities to which you can apply risks or uncertainties. 
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Build A Risk-Adjusted Schedule 
You can generate scenarios based on risk inputs and outputs.  

Scenarios Based on Risk Inputs 
Creating scenarios based on risk inputs is useful when needing to re-calibrate a schedule based 
on the project’s team uncertainty rankings. You can achieve this using one of the following 
modes:  

 PERT Method — This option uses the PERT algorithm ((max+4*most likely+min)/6 to re-
calibrate the schedule/cost model.  

 Distribution Median — This option takes the median value between min, most likely and 
max to re-calibrate the schedule/cost model.  

 

See Risk Inputs for more information. 

To create a risk-adjusted schedule based on risk inputs, complete the following steps: 
1. Select the S3 // Risk tab. 

2. With the project selected in the Projects pane, in the Analysis menu, click Build 
Scenario. 

3. Select Scenario Based on Risk Inputs, then select either PERT or Distribution 
Median. 

4. In the Analysis menu, click Run Risk Analysis. 

Scenarios Based on Risk Outputs 
This option creates a scenario based on the outputs of a risk analysis. You can create a scenario 
based on any P-Value from the risk analysis. After creating the scenario, you can publish the risk-
adjusted schedule back to the scheduling tool or use it as the basis for building a new risk model. 

 

See Run a Risk Analysis for more information. 

To create a risk-adjusted schedule based on risk outputs, complete the following steps: 

1. Select the S3 // Risk tab. 

2. With the project selected in the Projects pane, in the Analysis menu, click Build 
Scenario. 

3. Select Scenario Based on Risk Outputs, then edit the P Schedule value if needed. 

4. In the Analysis menu, click Run Risk Analysis. 
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Cost Risk Analysis 
Create a new Cost Estimate 
You can create a new cost estimate directly within Acumen Risk in order to perform a cost risk 
analysis.  

To create a new cost estimate, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Risk Models menu, click Create Cost Estimate. 

This opens a new cost estimate that will automatically be populated with a single activity 
called New Activity.  

3. Edit the activity name and details directly in this view or by using the fields in the Activity 
Details Pane.  

 

See Edit the Schedule Using the Details Pane for information about the fields on the 
Details Pane tabs. 

4. To add a new activity to the cost estimate, do one of the following: 

 In the Editing menu, click Add Activity. 

 Right-click on any row in the Activities view and click Add Activity.  

Organize Activities into a Hierarchy or Cost Breakdown Structure 
You can drag and drop any activity or row within the Activities view to create a cost breakdown 
structure or other hierarchy within the cost estimate.  

You can create any number of hierarchical levels or groups in the cost estimate. Any time an 
activity, or group of activities, is dragged onto another row, it becomes a child of that row. 

Example of Creating a Hierarchy 

1. New Activity 5 is dragged onto the row titled Parent 2. This makes New Activity 5 a 
child of Parent 2.  

 
2. New Activity 5 becomes a parent activity when we add a new activity (New Activity 6) 

and drag it onto the New Activity 5 row.  
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Import an Existing Cost Estimate 
Acumen Risk includes an Excel-based template called CostRiskTemplate.xls located within the 
Samples folder. You should use this as the template file for importing cost estimates into Acumen 
Risk.  

After the cost estimate is populated into the template file, you can import it into Acumen Risk 
using the normal Excel import feature. 

 
After the cost estimate is imported into Acumen Risk, follow the normal procedure for building 
your cost model with uncertainty and risk events (same procedure as building a schedule risk 
model).  

 

See Assigning Uncertainty and Creating Risk Events for more information. 

You can run reports, such as Risk Exposure, Risk Drivers, and Comparison Analyzer against cost 
models. 
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Example of Cost Risk Analysis Results 

 
The Cost Contribution Metric in the Risk Driver report shows the biggest cost risk drivers in terms 
of cost rather than percentages, providing useful executive reporting. 

 

See Reporting Risk Drivers for more information. 

Link Cost and Schedule Risk Models 
Acumen Risk provides a fast and effective means of linking cost and schedule risk models 
together. Some cost elements, such as labor or project management, are often dependent. 
Acumen Risk offers a means of linking the schedule risk exposure from either the project as a 
whole, or from specific activities, to specific cost elements within your cost risk model. 

This approach eliminates the need for having to cost or resource-load a schedule in order to 
conduct a truly integrated cost/schedule risk analysis.  

To set up cost/schedule integration, complete the following steps: 

1. Build and analyze your schedule risk model. 

2. Build your cost risk model applying uncertainties and risk events. 

3. Select the S3 // Risk tab. 
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4. In the Activity view, click on one of the  Activity Schedule Overlay icons in the 
Activity Schedule Overlay column. 

 
5. In the Integrate Cost/Schedule Risk Uncertainty dialog box, select a project and the 

desired activities from the schedule model to apply schedule impact to specific cost 
elements (or the cost estimate as a whole).  

 
6. In the Analysis menu, click the Run Risk Analysis down-arrow and confirm that the 

Account for cost of schedule risk impact Cost/Schedule Integration option is selected. 
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7. In the Analysis menu, click Run Risk Analysis to run the cost risk analysis. 

You can use the Risk Comparison Report to analyze the additional impact of schedule risk 
exposure on your cost risk estimate. 

 

See Risk Comparison (Comparing Results) for more information. 

Example of a Risk Comparison Report 
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Risk Reporting  
You can display reports from a risk analysis by using the view options in the Left Panel and Right 
Panel menus. In addition, reports can be printed or copy/pasted to another tool.  

 

Report Risk Exposure (Risk Histogram) 
Use the risk histogram to report risk exposure. It is driven by the activity or summary that you 
select in the activity panel. The histogram displays both a cumulative and non-cumulative chart 
showing the distribution of duration, cost, float, start, or finish dates for the selected activity. 

To access the risk histogram, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Views menu, click Right Panel » Risk Exposure. 

Probability Values and Contingency 
You can add probability values (P-values) to the chart by clicking in the chart in the desired 
location and selecting one of the Add/Remove P-value options. Each time you add a new P-value 
to the chart, Acumen Risk automatically adds the P-value data to the table beneath the histogram 
as a column to the main activity spreadsheet. 

In addition, you can graphically plot contingency (the difference between a deterministic value 
and a P-value) by clicking in the chart in the desired location and selection one of the 
Add/Remove contingency options. Positive contingency is highlighted in red, negative 
contingency (that is, when your estimate has too much contingency built into it) is highlighted in 
green. 

Example of the Add/Remove Options 
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Example of a Risk Exposure Report with Positive Contingency Highlighted 

 

To adjust the risk exposure options, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click Right Panel » Risk Exposure. 

3. In the Risk Exposure menu, click Configuration. 

 To adjust the percentage increments, click Cumulative Axis Increment Size and 
select a different percentage.  

 To adjust the duration units, click Hits Bar Width and select a different duration unit.  

Report Risk Drivers (Risk Tornado) 
Use the risk tornado chart to display the key drivers within a risk model. Acumen Risk uses a 
metric known as Schedule or Cost Contribution Factor™ that reports drivers in terms of actual 
cost and duration rather than abstract relative percentage-based metrics. 

The Acumen Risk tornado also differentiates between logic, uncertainty, and risk events when 
reporting key risk drivers. In addition, it can be configured to report risk drivers at any level of the 
cost/schedule hierarchy, bringing more meaning to executive risk reporting. 

To access the risk tornado chart and report risk drivers, complete the following steps: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click Right Panel » Risk Drivers.  

3. In the Activity pane, click on either a summary activity or an individual activity.  

 If a summary activity is selected, then the Risk Drivers tornado will only report 
activities within the selected summary.  
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 If an individual activity is selected, then Acumen Risk will report only activities leading 
up to that given activity.  

Report Criticality 
Criticality is a traditional risk metric reporting how often an activity (or group of activities) falls on 
the critical path. It is an indication of how stable the critical path is as a result of risk and 
uncertainty. While it is a useful measure of stability of critical path, it is not a sound measure of 
which activities most impact risk exposure. For this, use the Cost/Schedule Contribution™ Factor 
(see Reporting Schedule and Cost Contribution below). 

To report criticality, complete the following steps: 
1. If the Risk Drivers view is not already displayed: 

a. Select the S3 // Risk tab. 

b. In the Views menu, click Right Panel » Risk Drivers. 

2. Click Risk Drivers » Criticality. 

Report Schedule and Cost Contribution 
Schedule and Cost Contribution™ are two risk metrics that report the actual schedule/cost 
impacts on any given activity (or group) in terms of currency and duration. 

The Schedule Contribution tornado shows which activities are the biggest risk drivers on the 
selected activity and, more importantly, it reports in terms of duration. 

Example of Schedule Contribution 
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To view schedule or cost contribution, complete the following steps: 

1. If the Risk Drivers view is not already displayed: 

a. Select the S3 // Risk tab. 

b. In the Views menu, click Right Panel » Risk Drivers. 

2. In the Risk Drivers menu, click one of the following: 

 To view schedule contribution, click Schedule Contribution. 

 To view cost contribution, click Cost Contribution. 

Risk Drivers Report Configuration 
You can configure the Risk Drivers chart to display either summary bars or segmented bars 
differentiating between logic, uncertainty, and risk events. In detailed mode, you can determine 
the specific driver behind each activity’s contribution to the overall risk exposure profile. In this 
mode, Acumen Risk reports whether the risk exposure is a result of preceding logic, the 
uncertainty of the activity itself, or risk events impacting the activity.  

Example of a Detailed Risk Drive Report 
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Set the Display Level 
The Risk Driver report has the ability to roll up the tornado chart to any given level within the 
project hierarchy. This provides flexible reporting as well as eliminating the generation of reports 
with inconsistent levels of detail within it. 

Example of a Detailed and Summary Risk Driver Report 

  
Detailed Risk Driver Report Summarized report 

To access the display level, complete the following steps. 

1. If the Risk Drivers view is not already displayed: 

a. Select the S3 // Risk tab. 

b. In the Views menu, click Right Panel » Risk Drivers. 

2. In the Risk Drivers menu, use the Display Level slider to adjust the display. 

Report Risk Event Drivers 
In addition to reporting cost and schedule contribution by activity, you can configure the Risk 
Drivers report to report the risk events contributing significantly to risk exposure.  

To display the risk events contributing significantly to risk exposure, complete the 
following steps: 

1. If the Risk Drivers view is not already displayed: 

a. Select the S3 // Risk tab. 

b. In the Views menu, click Right Panel » Risk Drivers. 

2. In the Risk Drivers menu, click Configuration » Mode.  

3. Select Events to view the risk events driving risk exposure.  
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Risk Sensitivity  
You can use the Risk Sensitivity™ report to evaluate the relationship between durations and/or 
costs by creating a scatter chart showing their interaction.  

To use the Risk Sensitivity report, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Views menu, click Right Panel » Risk Sensitivity. 

3. On the Risk Sensitivity configuration screen, select activities and values for each activity 
to view their relationship. 

The X-axis and Y-axis must be defined in order to use the Risk Sensitivity report.   

 
4. Click Analyze to create the Risk Sensitivity report. 

The Risk Sensitivity Report  
The Risk Sensitivity report includes several values and views: 

 Deterministic Value — The Deterministic Value displays as a blue marker on the report. 
Use the Deterministic value checkbox to turn it on or off.  

 Deterministic Quadrants — The Deterministic Quadrants provide further insight into the 
probability of meeting deterministic durations and/or costs. Use the Deterministic 
Quadrants checkbox to add/remove the quadrants from the report.  
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The example below shows a Risk Sensitivity report where the X-axis is Finish Date and 
the Y-Axis is Cost. The top left quadrant shows that during the analysis, 51% of the time, 
Cost was greater than deterministic while the Finish Date was earlier. 

 
 Joint Confidence Level (JCL) — Gain insight into the probability of meeting cost and 

schedule commitments using the Joint Confidence Level (JCL) curve. It displays the 
combined probability of both axis, for example, Cost and Finish Date, at any P-Value. 

You can turn the JCL view on or off, as well as set the P-Value for the JCL curve, using 
the Joint Confidence Level (JCL) field at the bottom of the report.  

The example below shows a Risk Sensitivity Report Showing Joint Confidence Level 
(JCL) 

 
 Configure — Click the Configure button to return to the configuration screen to enter 

new values. 
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Risk Comparison (Comparing Results) 
Use Risk Comparison to compare multiple risk exposure scenarios. 

Add Scenarios 
To add scenarios to the Risk Comparison chart, complete the following step: 

1. Whilst viewing a risk histogram, in the Risk Exposure menu, click Add to Risk 
Comparison. 

 

See Reporting Risk Exposure (Risk Histogram) for more information about risk 
histograms and how to view them. 

There is no limit to the number of scenarios that you can add. 

Risk Comparison Reporting 
To view a risk comparison report, complete the following step: 

1. Select the S3 // Risk tab. 

2. In the Views menu, click Right Panel » Risk Comparison. 

From within the Risk Comparison Chart, you can rename and annotate scenarios by clicking on a 
given P or Confidence level within the chart itself. Variances are shown in the table beneath the 
chart. 

 

Publish and  Print Results 
You can export risk reports to other tools, either as charts or as raw data. 

To export a risk driver report, complete the following steps: 

1. Select the S3 // Risk tab. 

2. Use one of the options in the Import / Publish menu to export, copy, or print the risk driver 
report. 
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Analyze Risk Results  

Forensics 
You can use the Acumen Forensic analyzer to compare alternate scenarios built during a risk 
analysis. This is useful when needing to report differences in risk exposure such as P50 
Durations between alternate scenarios. 

 

See Using Forensics to Identify Additions, Deletions, and Modifications for more information 
about forensic analysis. 

Example of Forensics Comparing Risk Models 
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Diagnostics and Risk Metrics 
Acumen includes two risk metric libraries — Risk Inputs and Risk Exposure. Risk Input includes 
metrics that provide analytics around how the risk model has been put together as well as insight 
into the team’s perception of risk and uncertainty. 

Risk Inputs Metrics Risk Exposure Metrics 

 

 

 

 

See Running Diagnostics with Acumen Fuse for more information. 

Example of Fuse Metric Analysis on Acumen Risk Results 
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Schedule Remediation and Acceleration Using 
Acumen 360 
Acumen 360™ is a schedule remediation and acceleration product. You use it to accelerate or 
compress project schedules to meet faster completion deadlines or to get a delayed project back 
on track. In addition, 360 can be used to hypothesize acceleration options or model potential 
delays.  

 

You can also accelerate a project schedule from the S1 // Projects tab by clicking Accelerate 
Schedule in the Scenario Generation group. 

Acumen 360 runs a CPM simulation running hundreds of iterations, progressively accelerating 
the project towards a defined goal using sets of user-definable criteria. 

There are three acceleration options:  

 Automatic, Goal-Based — Define the acceleration target and let Acumen 360 
automatically generate the schedule scenario that meets that goal.  

 Targeted — Define the acceleration goal and the criteria for acceleration (for example, 
accelerate construction activities by 50%). 

 Interactive — Accelerate or decelerate individual activities or groups of activities using 
the duration calibration sliders.  

The S4 // Acceleration Tab 
The S4 // Acceleration tab includes a script library/editor and a step library/editor. 
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Advanced Acceleration Settings 
Acumen 360 automatically determines the appropriate level of granularity to apply during an 
analysis. This is calculated based on the complexity of logic, number of activities, remaining 
duration, and aggressiveness of the acceleration.  

Click Advanced >> on the Accelerate Schedule dialog box to manually override the level applied 
so that an even more accurate, or alternately, a faster but less accurate model can be run.  

 

Automatic Goal-Based Acceleration 
Use automatic goal-based acceleration to define the acceleration target and let Acumen 360 
automatically generate the schedule scenario that meets that goal. 

Define a Goal 
You can define a goal in Acumen 360 in several ways: 

 Define the number of acceleration days. 

 Define a target goal date. 

 Define an acceleration percentage. 

 Let Acumen 360 determine the best possible date. 
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Run an Automatic Project Goal-Based Acceleration 

To define a goal relative to the end of the project, complete the following steps: 

1. Select the S4 // Acceleration tab. 

2. In the Acceleration menu, click Accelerate Schedule. 

3. On the Accelerate Schedule dialog box, in the Schedule Accelerator group: 

a. Select the Accelerate Schedule tab. 

b. Use the goal options (date field or sliding scale) to set the target goal for the 
acceleration. 

 

See Advanced Acceleration Settings for information about the advanced options. 

 
4. Click OK to run the simulation. 

5. Compare the results using forensics, timeline, and analysis views. 

Run an Automatic Activity Goal-Based Acceleration 

To define an acceleration goal for a specific activity, complete the following steps: 

1. Select the S4 // Acceleration tab. 
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2. In the Acceleration menu, click Accelerate Schedule. 

3. On the Accelerate Schedule dialog box, in the Schedule Accelerator group: 

a. Select the Accelerate Activity tab. 

b. Click Select / Change Activity to Accelerate to select the activity against which 
the acceleration needs to be conducted (for example, accelerate completion of 
construction). 

c. Use the goal options (date field or sliding scale) to set the target goal for the 
activity acceleration. 

 

See Advanced Acceleration Settings for information about the advanced options. 

 
4. Click OK to run the simulation. 

5. Compare the results using forensics, timeline, and analysis views. 
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Targeted Acceleration 
Use targeted acceleration to define the acceleration goal and the criteria for acceleration. 

Define Criteria Sets (Scripts) 
Criteria Sets are contained in scripts. Scripts contain steps which are the definitions for rules and 
filters for the analysis.  

 
Acumen allows you to: 

 Edit scripts on the S4 // Acceleration tab or by clicking Edit Script on the Accelerate 
Schedule dialog box. 

 Export scripts from a workbook and re-used them within other workbooks. 

 Merge scripts with other script libraries using the merge feature. 

 Set a default script. 

To set the default script, complete the following steps: 

1. Click . 

2. On the bottom of the pane, click Deltek Acumen Options. 

3. In the Deltek Acumen Options dialog box, select the General tab. 

4. Click  in the Default Script Library Location field to select and set the default 
script.  

Define Steps 
Use the Steps Editor to define steps. Steps define how a schedule optimization is conducted. A 
step can define the following: 

 Reduce duration 
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 Reduce predecessor lag 

 Reduce successor lag 

 Change calendar 

 Remove constraints 

A step also defines the priority for applying the acceleration action. This can be defined as: 

 Earliest — Earliest activities in the selection. 

 Latest — Latest activities in the selection. 

 Longest — Longest duration activities. 

 Easiest — Acumen determines the activities with the “least amount of resistance” during 
the acceleration simulation.  

Define Filters within Steps 
Use filters to control the activities to which the steps get applied. A single step can contain one or 
more filter sets.  

 A single filter set can be a compound filter (that is, “AND” statements).  

 Multiple filters within a step enable “OR” set of filters to be created.  

This allows you to generate hybrid and hierarchical AND/OR filter sets. 

To define a filter, complete the following steps: 
1. Select the S4 // Acceleration tab. 
2. In the Step Editor menu, click Create Filter Set.  

3. In the New Filter Set dialog box, define the field and associated value(s) within the filter. 

The most common filter use is to create a filter by WBS. If selecting a WBS, then all 
activities within the selected WBS are included (that is, the selected WBS is assumed to 
be the parent).  

For example, the filter set below shows a filter that defines all activities within the WBS 
grouping called Commissioning where the contractor is ACom. 

 
4. Click Add to add additional filters. 
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Work with Script Templates 
You apply steps to a script by “drag-dropping” the steps from the step library into the script 
timeline. The timeline defines the order in which the steps are applied during the simulation. Drag 
the steps within the timeline to rearrange them.  

 

Example 

The following shows an example of the results from an Acumen 360 targeted acceleration.  

 
The results show: 

 Number of iterations run — Either the maximum number of runs or the number needed to 
reach the goal or the number of runs before the criteria in the script were exhausted. 

 Original, targeted and achieved goal dates. 

 Targeted and achieved acceleration. 

 Total activity reduction — Total number of activity days reduced. 



Schedule Remediation and Acceleration Using Acumen 360 

 

User Guide 183 

 

 Schedule Compression efficiency™ — An index showing how efficient the acceleration is 
(see white paper on Acumen website for further explanation of this metric). 

 The results window also shows whether or not the target has been completely or partially 
achieved. 

After an analysis has been run, you can choose to do one of the following:  

 Add the scenario. 

 Add the scenario and try another script. 

 Add the scenario and view the changes in forensics. 

 Add the scenario and compare in the analysis view. 

 

See Using Forensics to Identify Additions, Deletions, and Modifications and Project Risk 
Analysis for more information. 

Run a Targeted Acceleration 

To run a targeted acceleration, complete the following steps: 
1. Select the S4 // Acceleration tab.  

2. In the Acceleration menu, click Accelerate Schedule to display the Accelerate Schedule 
dialog box. 

3. (Optional) In the Schedule Cleanser group, select schedule cleanse options prior to 
running an analysis. This will enable the simulation to create a more naturally flowing and 
realistic schedule. 

4. In the Schedule Accelerator group: 

a. Select the goal (activity or project) options. 

b. Select an acceleration script. 

 If needed, click Edit Script to edit the selected script or to create a new one. 

 

See Advanced Acceleration Settings for information about the advanced options. 

5. Click OK to run the simulation. 

Interactive Acceleration 
The interactive acceleration mode of Acumen 360 allows you to accelerate or decelerate activities 
and immediately view the impact on the rest of the schedule.  

You can calibrate each individual activity or use the grouping options to calibrate groups of 
activities.   

 

See Viewing and Editing the Schedule for more information about setting up the Project view. 

Calibration applied to a parent row automatically cascades down to the children of that row. To 
set exceptions, or activities that do not follow their parent, re-set the calibration slider on that 
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activity. The activity is locked, which you can see by looking at the  lock icon next to that 
activity. If you next adjusted the calibration of the parent, all activities would follow except for the 
locked activity.  

 

See Calibration for more information about this feature. 

Example 1 

In the example below, the parent activity has been set to Requires Less Time which has 
changed the Remaining Duration and Finish Dates for the parent and all child activities.  

 

 

Example 2 

This example shows how calibration settings cascade down to child activities. Manufacturing, and 
all of its children, has been set to Requires More Time. Phase 2 has been flagged as an 
exception and set as Realistic.  

 

Use Calibration to Manipulate the Schedule 

To calibrate the schedule, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Set up your project view to apply acceleration or deceleration to activity groups. 
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See Viewing and Editing the Schedule for more information. 

3. Create a scenario for calibration. 

4. (Optional) In the Activities menu, click the Activity View down-arrow then click Grouping 
and use the display level slider to roll-up or expand the project schedule.  

5. Use the Activity view Calibration column sliders to move durations. 

For example: 

 To see the impact of the selected activity taking less time than planned, set it to 
Light Green (Requires Less Time).  

 To see the impact of the selected activity taking more time than planned, set it to 
Orange (Requires More Time). 

The Gantt chart will adjust to the new setting and the finish dates of that activity and any 
successor activities will change.   

 

See Advanced Acceleration Settings for information about the advanced options. 

The Schedule Realism Adviser 
The Schedule Realism Adviser™ provides suggestions for calibrating each activity based on a 
given criteria.  

To define how the advisor should calculate suggestions, complete the following steps: 

1. Select the S1 // Projects tab. 

2. In the Scenario Generation menu, click Schedule Realism Advisor. 

3. In the Schedule Realism Advisor dialog box, select from the following options:  

 Schedule Quality — This mode presents uncertainty assignments based on the 
Fuse Schedule Index score for each activity and activity grouping. By default, an 
activity with a score lower than 10% will be flagged as needing more time than 
planned. Conversely, an activity with a score greater than 75% will be flagged as 
needing less time than planned.  

 Historical Performance — This mode compares the baseline plan to the current 
schedule and looks for discrepancies in order to suggest which activities should be 
accelerated.  

 Metric — Select any metric from Fuse to use as the basis for acceleration 
suggestions.  

 Field — Select any field from the project to use as the basis for acceleration 
suggestions.  

4. Click Calculate Advice. 

After the Schedule Realism Adviser has calculated the advice, the recommendations are 
shown in the activities view.  
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5. Click the  icon next to any activity or activity grouping to implement the recommended 
calibration settings. 

You can choose to assign the summary suggestion to all activities or assign individual 
suggestions to each activity. 

 

Analyze the Results 
You can analyze the newly created scenarios using any of the standard analysis features within 
Acumen Fuse including Forensics, timeline view and the Fuse diagnostics view. Acumen 360 
includes a metric library called “Scenario Comparison” that contains a set of metrics pertaining to 
scenario comparison analysis. 

 

Publish Scenarios 

You can publish Acumen 360 scenarios to MS Project and Primavera using the  Publish 
button on the S1 // Project tab or by right-clicking on the project name. 
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Project Scoring and Ranking (Benchmarking) 
The benchmarking view provides a means of comparing project analytics against a global 
database of similar projects.  

This view performs a benchmark analysis of the project including:  

 Standardized project scoring using the Fuse Schedule Index™. 

 Benchmarking against other projects across the world using Acumen Cloud™. 

 Forecasting of project success; that is, what the likelihood is of an on-time, on-budget 
project completion. 

The following topics describe these in more detail. 

Deltek Acumen Cloud 
Acumen Cloud™ is a web-based repository of results generated from running Fuse analyses. 
Acumen Cloud is included as part of an Acumen Fuse license and is an optional module activated 
through an end-user opt-in process as part of installation.  

 

To manually opt-in or out of Acumen Cloud, complete the following steps: 

1. Click . 

2. On the bottom of the pane, click Deltek Acumen Options. 

3. On the About Deltek Acumen tab, click Opt-in to enjoy the benefits of Deltek Acumen 
CoudTM. 

4. Click OK. 
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Project Benchmarking 

 
The above diagram shows the flow of data during a benchmark analysis. First, the analysis on 
your project is conducted locally within Acumen. The results of the analysis are then securely 
(using Secure Socket Layer/SSL) and anonymously sent to a cloud-based repository called 
Deltek Acumen Cloud.  

 

The project schedule itself is not sent to the cloud. 

Acumen Cloud does not store project-specific attributes such as project name, type, owner, 
author, and so on. Instead, only the resultant score from running a Fuse analysis is stored. This 
data is then used to compare against other calculated project scores also stored in the cloud. 

Scoring, Benchmarking, and Forecasting 
An Acumen Cloud analysis generates three results: 

 Scoring — A standardized score in the form of an index is generated. This score is 
based on a standard set of metrics that cannot be editing or re-weighted by an end-user. 
By adopting this standardization, projects can be anonymously compared using the same 
scoring system. As a target, you should aim for 75 and above with any Fuse Index score. 

 Benchmarking — While Fuse Indices give good insight into the quality of a plan, being 
able to compare how your project ranks with other similar projects is even more valuable. 
Acumen Cloud automatically calculates where in the population your project lies. This is 
presented in the form of a percentile. For example, you rank in the top 60th percentile.  

 Forecasting — Based on years of project benchmarking, Acumen is now able to deliver 
true benchmarking in the form of forecasting project success. This is achieved by 
comparing your project score to other completed projects with a similar score and 
examining how they fared with regards to on-time completion. Based on an established 
correlation between quality of plan and chance of execution success, Acumen Cloud is 
able to forecast the probability of your project having an on-time completion. 
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Metric Percentile Analysis 
As well as generating overarching Indices, Acumen Cloud also analyses how you rank with 
regards to each individual metric score. The percentile analyzer shows not only each metric 
score, but in addition, the red indicator shows how you rank against the rest of the population. 
This is very useful when pinpointing root cause of a poor Index score. 

 

Fuse Schedule Index 
You can use the Fuse Schedule Index™ to score projects with regards to their quality of plan.  

 
The Fuse Schedule Index is based upon nine core metrics that all pertain to the overarching 
quality of a plan. Each of these nine metrics are weighted according to importance to quality. 

Metric Description 

Missing Logic In theory, all activities should have at least one predecessor and one 
successor associated with them. Failure to do so will impact the quality of 
results derived from a time analysis as well as a risk analysis. This number 
should not exceed more than 5%. 



Project Scoring and Ranking (Benchmarking) 

 

User Guide 190 

 

Metric Description 

Logic Density™ This metric calculates the average number of logic links per activity. An 
average of less than 2 indicates that there is logic missing within the 
schedule. An average greater than 4 indicates overly complex logic, with a 
high likelihood of redundant links. Therefore, Logic Density™ should be 
between 2 and 4. 

Critical While a highly critical schedule is not necessarily a sign of poor 
scheduling, it can indicate a highly risky schedule. Use this metric as a 
point of reference. 

Hard 
Constraints 

Hard, or two-way constraints, such as ‘Must Start On’ or ‘Must Finish On’ 
should be avoided. Use of such constraints can lead to inaccurate finish 
dates and a lack of insight into the impact of schedule changes, risk 
events, and earlier delays. 

Negative Float Negative float is a result of an artificially accelerated or constrained 
schedule, and is an indication that a schedule is not possible based on the 
current completion dates. 

Insufficient 
Detail™ 

Activities with a high duration relative to the life of the project are an 
indication of poor schedule definition. Detail should be added to the 
schedule. 

Number of Lags A lag is a duration applied to a logic link often used to represent non-
working time between activities such as concrete curing. Lags tend to hide 
detail within the schedule and cannot be statused like normal activities; 
therefore, lags should be converted to actual activities with durations. 

Number of 
Leads 

A lead, also known as a negative lag, is often used to adjust the successor 
start or end date relative to the logic link applied. This is a poor practice as 
it can result in the successor starting before the start of the predecessor. 

Merge Hotspot Also known as merge bias, a merge hotspot is an indication as to how 
complex the start of an activity is. If the number of links is greater than two, 
there is a high probability that the activity in question will be delayed due to 
the cumulative effect of all links having to complete on-time in order for the 
activity to start on time. 
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Fuse Logic Index 
The Fuse Logic Index™ is a cloud-based metric library that gives insight into the logic quality of a 
schedule. Logic is viewed as one of the most important underpinnings of a schedule.  

 

Metric Description 

Redundancy 
Index™ 

A redundant, or unnecessary logic link, is a link between two activities 
made redundant by an additional, often more complex, logic link between 
the same two activities. A high Redundancy Index is a sign of an overly 
complex schedule which should be simplified. 

Open Ends A high number of activities missing a predecessor, a successor, or both, 
signals a poorly developed plan. This number should be less than 5% of 
the schedule. 

Open Starts If the start of the successor activity is left open, with the predecessor 
activity tied to the finish of the successor, the result is an open start or 
:dangling activity.” 

Open Finishes If the finish of the predecessor activity is left open, with the predecessor 
tied by its start to the successor, the result is an open finish or “dangling 
activity.” 

Leads A lead, also known as a negative lag, is often used to adjust the successor 
start or end date relative to the logic link applied. This is not good practice 
as it can result in the successor starting before the start of the 
predecessor. 

Lags A lag is a duration applied to a logic link often used to represent non-
working time between activities, for example, concrete curing. Lags tend to 
hide detail within the schedule and cannot be statused like normal 
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Metric Description 

activities; therefore, they should be converted to actual activities with 
durations. 

SF Links A high number of SF links is indicative of a well-developed plan. 

Example of an Acumen Cloud Analysis 
An example of a project that scores 74 against the Fuse Schedule Index, ranking in the top 88th 
percentile of the population resulting in a 75% chance of completion on time.  

 

Run an Acumen Cloud Benchmarking Analysis 
To run an Acumen Cloud benchmark analysis, complete the following steps: 

1. Select the S2 // Benchmarking tab. 

2. Select a metric library to use for the analysis.  

Acumen Cloud analysis is automatically triggered when a different project is selected from the 
project browser on the left-hand side of the view. 

If the same project is repeatedly analyzed, Acumen will update the score in the cloud for this 
project; it will not create multiple separate entries. 

 

Aim for an index and percentile score of 75 or above. The Acumen Cloud histogram is color-
coded (red, orange, yellow and green). The color segments represent the 25th percentile, 50th 
percentile, and the 75th and above percentile. 
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Fields Tab 
Use the fields tab to map fields from the various source projects to corresponding fields in the 
Acumen Fuse workbook. Field mapping is flexible in that an individual Acumen Fuse field can get 
its data from any source project field. Further, the mappings between source projects may be 
different, for example, Baseline Start may come from Start1 in Project A and BaselineStartDate 
in Project B (all within the same workbook).  

You can map standard fields, user-defined fields, and code fields. Default mappings for all the 
supported platforms are included. 

  

 

See Appendix B: Standard Field Mappings for a list of the standard field mappings for each of 
the supported platforms. 

The Fields Tab Menu Options 
 Source Fields 

 Map to All Projects — If your workbook contains multiple projects or snapshots, you 
can use the Map to All Projects menu option to map a single field (standard, user, 
code) to all projects or snapshots with a single click instead of repeating the field 
mapping process manually for each project. 

 Map All Code Fields for this Project — If you need to map all code fields from a 
source project or snapshot, you can use the Map All Code Fields for this Project 
menu option to assign all code fields to the workbook in a single click.  

By default, all code fields are auto-mapped during an import. This feature can be 
disabled in the Deltek Acumen Options dialog box. 

 Map All Code Fields for All Projects — If you need to map all code fields from a 
source project or snapshot to multiple projects, you can use Map All Code Fields for 
all Projects to assign all code fields for all the projects in the workbook in a single 

Selected Source 

Mapped Source 
Fields 

Acumen Fields 

Source Fields 
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click. Acumen will map all common codes within each source file to all projects within 
the workbook. 

By default, all code fields are auto-mapped during an import. This feature can be 
disabled in the Deltek Acumen Options dialog box. 

 Map All User Fields for All Projects — If you need to map all user fields from a 
source project/snapshot to multiple projects, you can use Map All User Fields for all 
Projects to assign all user fields to the workbook in a single click. 

By default, all user fields are not mapped during an import. This feature can be 
enabled in the Deltek Acumen Options dialog box. 

 Mapped Fields 

 Delete — Select a mapped field, then click Delete to delete the mapped field from 
the list of fields. The Acumen field is not removed from the product, only deleted from 
the list. 

 Load Default Mapping — Click Load Default Mapping to reset field mappings 
within a workbook. 

 Activity Fields 

 Delete — Select an activity field then click Delete to remove the field and all of its 
associated field mappings. 

 Templates 

 Open — Use this option to open a saved mapping template. 

 Save — Use this option to save a mapping as a template. The template will save as 
an XML file with .fieldmap appended to the filename. For example, if the project is 
called Schedule1, then the filename is Schedule1.fieldmap.xml. 

Field Mapping Context 
Each workbook contains its own field-mapping template. Each project or snapshot within a 
workbook also has its own mapping values back to the fields within the workbook template. 

Mapped Fields and Metrics 
In order for metrics to produce valid calculations, the fields referenced in the metric definition 
must be present in the workbook. The default field mapping templates include the required fields 
for the standard metric libraries to be run. 

Custom Field Mappings 
In addition to being able to import from multiple platforms, you can also customize which fields 
are imported into a workbook. Each supported platform (for example, MS Project and Primavera) 
has default field mapping templates. These defaults mean that, unless you need to change the 
default behavior of an import, you can import project data without manually having to create or 
maintain field mappings. 

 

See Appendix B: Standard Field Mappings for a list of the standard field mappings for each of 
the supported platforms. 
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However, if you want to change the way fields are imported and/or want to import additional fields 
that are not part of the standard field mapping templates, then you can use the field-mapping 
feature to achieve your custom imports. 

 
The right-hand side column contains a list of Acumen fields. These fields are available during an 
analysis and can be referenced by metric formulas. You can click on the field name to edit it; 
however, you cannot edit the bold field names but you can assign customized mappings to them.  

The center columns are the currently mapped fields. There is a separate column shown for each 
of the projects/snapshots within a workbook.  

Acumen field mapping provides the flexibility to have different custom mappings from each of 
your data sources map to a common field — in effect, standardizing data from multiple platforms 
that may have very different data schemas.  

When linking to a data source, default mappings are assigned based on the platform type.  

Example of Field Mapping 
The example below shows two projects within a workbook (Project A and Project B).  

 Project A is a Primavera P6 project  

 Project B is a Microsoft Project project  
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For the Acumen field called Baseline Work, the corresponding default field for Project A 
(Primavera file) is Budgeted Labor Units whereas in Project B, the same field is known as 
BaselineWork. Based on the default mappings, Acumen normalizes these fields even though the 
field names are actually different. Within your workbook, this field is then referred to as Baseline 
Work. 

 

Edit Field Mappings 

To edit field mappings, complete the following steps: 
1. Select the data source.  

Before you can map a field, Acumen has to retrieve all the available fields for the project 
in question.  

a. To update the available field list, click on the desired project which would be 
either of the two columns showing Project A and Project B. 

2. Select the desired field.  

The source fields are grouped into Standard, User Defined, and Code fields.  

b. Click on the relevant header to reveal the fields for the required field type.  

3. Assign the field.  

Drag and drop the selected field to an existing Acumen field or a blank row to create a 
new field in your workbook. 

Edit Field Names 
When adding a new source field to your list of fields, Acumen, by default, adopts the same field 
name as that of the source. However, you can rename fields by editing the field name directly 
within the table. The exception to this rule is the list of Acumen fields that are highlighted in bold 
type (ID, Description, Critical, Percent Complete, Start, Finish).  

Delete Fields 
You can delete any of the non-bold type faced Acumen fields. 
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To delete an Acumen field, complete the following steps: 

1. Click on the field you want to delete. 

2. In the Activity Fields menu, click Delete. 

Delete Field Mappings 
You can delete field mappings without deleting the field itself. This is useful when you no longer 
want to import a specific field that has previously been mapped. 

To delete a field mapping, complete the following steps: 
1. Click on the mapped source field you want to delete. 

2. In the Mapped Fields menu, click Delete. 

Field Mapping Templates 
When you complete field mapping, you can save it as a mapping template. You can import a 
saved template back into field mapping and apply it to a single project or all projects. 

Save a Mapping Template 

To save a field mapping as a template, complete the following steps: 

1. On the Fields tab, select the project whose mapping you want to save as a template. 

2. In the Templates menu, click Save. 

3. In the Save dialog box, select a folder and click Save. 

You can change the project name; however, .fieldmap.xml is appended to any name 
you use. 

Import a Mapping Template 

To import a mapping template, complete the following steps: 

1. On the Fields tab, select the project to which you want to apply the template. If you are 
applying the template to all projects, then skip this step. 

2. In the Templates menu, click Open. 

3. Select the template you wish to apply and click Open. 

4. On the Apply field mapping template dialog box, select one of the following options: 

 <selected project> — This is the name of the currently selected project on the 
Fields tab. Select this option to apply the template to this project only. 

 All — Select this option to apply the template to all projects listed on the Fields tab. 

 Cancel — Select this option to cancel the import process. 

Minimum Fields Required 
In order to draw activities and ribbons in the ribbon analyzer view, only the Start and Finish fields 
need to contain valid data. In reality though, in order to obtain useful results from the analysis, the 
standard default mapped fields should be populated.  
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Work with Different Field Types 
The custom field mapping enables fields of different types to be matched with each other. During 
analysis, Acumen determines how to treat a field (type) based on the data and context within 
which it is being used. Such flexibility allows, for example, a user-defined number field to be 
mapped as a text field in Acumen. 
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Appendix A: External Data Sources 
This topic provides information specific to each of the following data sources that Acumen 
supports: 

 Microsoft Project 

 Oracle Primavera 

 Microsoft Excel 

 Deltek Open Plan 

 Phoenix Project Manager 

 Asta PowerProject 

 UN/CEFACT 

 Safran Project 

 

 See the Compatibility Matrix in the Deltek Acumen Installation Guide for version 
information. 

 See Link to External Data Sources and and Import Projects for general linking and 
importing information and steps. 

Microsoft Project  
Acumen links to Microsoft Project (MSP) files using your installed copy of MS Project or by 
directly reading an .MPP file (without needing MS Project installed on your computer).  

MS Project linking supports: 

 Cost, schedule, risk, and earned value integration by default.  

 Custom field mapping (normal, code, and user-defined fields). 

When you import a project from Microsoft Project, Acumen also imports the Estimated and 
Manual fields. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 

Import External Activities 
In Microsoft Project, you can link an activity in another project as a predecessor or successor to 
an activity in your current project. These external activities display in gray in your current 
Microsoft project.  

You can import these external activities as part of an MS Project import by setting the Import 
external activities option on the Platforms tab in the Deltek Acumen Options dialog box. The 
external activities display in gray in the Activities view of the S1 // Projects tab. If you select one, 
you can see the predecessor/successor information on the Activity Relationships sub-tab. 
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These external activities are excluded from analysis by default; however, you can include them by 
deselecting the option in the Excluded column next to the activity in the Activity browser pane of 
the S2 // Diagnostics tab. 

 

See Exclude Activities from Analysis for more information. 

Set Microsoft Project Platform Options 

To set the Microsoft Project platform options, complete the following steps: 

1. Click . 

2. At the bottom of the pane, click Deltek Acumen Options. 

3. On the Platforms tab, in the Microsoft Project group, set your preferred options: 

 Activity Comparison Field 

 Load MPP files directly without requiring Microsoft Project 

 If the “Acumen ID” field is present, map it to “Id” 

 Import External activities 

 

See Platforms Tab in the Setting Deltek Acumen Options topic for field descriptions. 

4. Click OK. 

Microsoft Project “Get External Data From” Menu Options 
This topic describes the Microsoft Project options in the Get External Data From menu on the S1 
// Projects tab. 

To access the Microsoft Project menu in the Get External Data From group, complete the 
following steps: 

1. Select the S1 // Projects tab. 

2. In the Get External Data From menu, click the down-arrow on the bottom right corner of 
the Microsoft Project menu item. 

The following options display: 

 Microsoft Project — Use this option to create a link to a Microsoft Project .MPP file. 
When you select it, an Open dialog displays, allowing you to select the .MPP file. 

 Active Microsoft Project — Use this option to create a link to a project that you currently 
have open in MS Project.  

 Create Microsoft Project MPP Project — Use this option to create a new project in the 
workbook.  

When you select it, a Create Microsoft Project Schedule dialog box displays. Enter a 
project name, select Time Now and click OK. Acumen creates a new project with start 
and finish milestones and adds it to the list in the Projects pane. 
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Oracle Primavera 
This topic describes options, dialog boxes, and steps specific to Oracle Primavera projects. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 

Primavera P6 
Acumen includes direct integration to Primavera P6 through web-services (v8.2 and v8.3). This 
means that all P6 8.2 and 8.3 users can link directly to Primavera to analyze their projects.  

In addition, Acumen analyzes Oracle Primavera P6 XER and XML files. XER files are the 
standard means of exporting data outside of a P6 database. You do not need P6 installed on your 
computer to link and import XER or XML files into Acumen.  

Primavera P6 linking supports custom field mapping (normal, code, and user defined fields). 

You can import a single project or multiple projects from Primavera P6 web services.  

Acumen uses profiles to connect to P6 Web Services servers. The system can store multiple 
profiles that include the address, user name, password, and so on. When you import a Primavera 
P6 file through web services, you have the option to: 

 Use your current profile (Acumen remembers the last profile used). 

 Select a different profile. 

 Add, edit, or delete profiles. 

Set Oracle Primavera Platform Options 

To set the Oracle Primavera platform options, complete the following steps: 

1. Click . 

2. At the bottom of the pane, click Deltek Acumen Options. 

3. On the Platforms tab, in the Oracle Primavera Project Management P6 group, set your 
preferred options: 

 Calculate Baseline Values From 

 Web Service Timeout (seconds) 

 

See Platforms Tab in the Setting Deltek Acumen Options topic for field descriptions. 

4. Click OK. 

Oracle Primavera “Get External Data From” Menu Options 
This topic describes the Oracle Primavera options in the Get External Data From menu on the S1 
// Projects tab. 

To access the Oracle Primavera menu in the Get External Data From group, complete the 
following steps: 

1. Select the S1 // Projects tab. 
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2. In the Get External Data From menu, click the down-arrow on the bottom right corner of 
the Oracle Primavera menu item. 

The following options display: 

 Import 

 Single Project from a P6 XER file — Use this option to import a single P6 project 
from an XER file. After you select the file, a Select a Primavera P6 Project dialog box 
displays, allowing you to select the project you want to import. 

 Multiple Projects from a P6 XER file — If the XER contains multiple projects, you 
can use this option to import all projects contained in the XER file. 

 All Projects from a P6 XER file as a single Project —Use this option to import all 
projects contained in an XER file as a single project. 

 Project from a P6 XML file — Use this option to import a P6 project that has been 
stored in the Primavera XML file. 

 Single or Multiple Projects from P6 Web Services — Use this option to import 
single or multiple P6 projects using web services. 

 

See Link to Single or Multiple P6 Projects Through Web Services for more 
information and steps. 

 Project from a P3 file — Use this option to import a Primavera P3 (with a dir.p3 
suffix) file. 

 Primavera Risk Analysis — Use this option to import data from an Oracle 
Primavera Risk Analysis or Pertmaster plan. 

 

See Primavera Risk Analysis for more information. 

 Create Schedule 

 Create New Primavera XER P6 Schedule — Use this option to create a new XER 
P6 schedule. 

 Baseline 

 Assign / Change Baseline — Use this option to assign or change a baseline. 

 Assign / Change Baseline and Add Snapshot — Use this option to assign or 
change a baseline and add a snapshot. 

 Clear Baseline — Use this option to delete a previously set baseline. 

 

See Add a Baseline to Primavera P6 Workbooks for more information. 

 XER File Encoding 

 Set Text Encoding — XER files do not include any information about what is being 
used to encode the files. If the file you are importing does not use standard encoding 
(for example, it uses Russian instead of English), use this option to set the text 
encoding prior to importing the data. 
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Link to Single or Multiple P6 Projects Through Web Services 

To link to a Primavera P6 file through web services, complete the following steps: 

1. Click . 

2. Click Open to open an existing workbook or click New to create a new workbook. 

3. Select the S1 // Projects tab. 

4. In the Get External Data From menu, click the Oracle Primavera drop-down arrow, and 
select Single or Multiple Projects from P6 Web Services.  

 If you already have at least one profile defined, the Project Selection dialog box 
displays. If this is the case, skip to step 6.  

 If you do not have any profiles defined, the Edit Profile dialog box displays. Continue 
to step 3. 

5. On the Edit Profile dialog box, enter or select the following information: 

 Profile Name 

 Host Name and Port 

 Use HTTPS  

 Database 

 Username and Password 

 
6. Click Test to confirm that the information is correct. 

7. Click OK to accept the settings.  

The Edit Profile dialog box closes and the Primavera P6 Web Services Project Selection 
dialog box displays.  

8. On the Project Selection dialog box, for your profile, do one of the following: 

 Keep your current profile (Acumen displays the last profile you used). 

 Use the Select your profile field to select a different profile. 

 Click   Add to add a new profile using the Edit Profile dialog box. 
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 Click   Edit to edit the existing profile using the Edit Profile dialog box. 

 Click   Delete to delete the currently selected profile in which case you will need 
to select or add a profile before continuing. 

9. In the Import column, place a check next to each project you want to import. 

 
10. Click OK to close the dialog box. 

11. Acumen adds links to these projects in the Projects pane. 

7. After you add your project links, you can choose to: 

 Add snapshots to projects. 

 Convert snapshots to projects. 

 Merge multiple data sources into a single dataset. 

 

You can add and convert snapshots and merge data sources at any time, before and 
after you import your data. 

When you are done, your next step is to import your project data. 

 

See Link to External Data Sources and and Import Projects for information about: 

 Adding and converting snapshots. 

 Merging multiple data sources into a single dataset. 

 Importing your project data. 

Add a Baseline to Primavera P6 Workbooks 
XER files exported from Primavera P6 do not contain associated baseline project data. This is a 
challenge when running metrics within Acumen that compare baseline data with the current 
schedule. To overcome this, you can assign a given P6 baseline schedule to a P6 schedule that 
has been brought into an Acumen workbook.  
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This process merges a baseline dataset with the current project dataset overcoming the issue of 
baselines not natively being saved as part of an XER export from P6. 

To assign a P6 baseline to a P6 schedule, complete the following steps: 

1. Select the S1 // Projects tab. 

2. Do one of the following: 

 In the Projects pane, right-click on the P6 project and select Set/Change Baseline. 

 Select the P6 project in the Projects pane then, in the Get External Data from menu, 
click Oracle Primavera » Assign / Change Baseline. 

3. In the Open dialog box, select the P6 XER that you want to set as the baseline project. 

After it is assigned, a black B ( ) displays on the Primavera P6 file icon in the Projects 
panel of the workbook to show that it has an assigned baseline. 

4. Import the project data to import both the project and baseline files together. 

Baselines can be reassigned, assigned, added, or deleted by right-clicking on the Primavera 
project.  

Set Baseline and Add Snapshot 

A Primavera file can be assigned as both a snapshot and a baseline in a single step. To do this, 
right-click on the parent project and select Set Baseline and Add Snapshot. 

Primavera Risk Analysis 
Acumen uses your installed copy of Risk Analysis (V8.x and higher), formerly known as 
Pertmaster, to link directly to Primavera Risk Analysis files. You must have Risk Analysis installed 
on your PC in order to link and to import .plan files from a Risk Analysis file. 

If you don’t have Risk Analysis installed, you can: 

 Natively read .plnx files into Acumen 

 Import .plnx files generated in Risk Analysis 

In addition to importing cost and schedule data, Acumen imports both risk input and risk output 
data from your Risk Analysis file. This enables you to conduct advanced risk-based analytics. 

Risk Analysis linking supports custom field mapping. 

 

You cannot run risk analysis on files imported from Primavera Risk Analysis. 

Microsoft Excel 
This topic describes options and information specific to Microsoft Excel files , Deltek Cobra’s CAP 
report, and ARES PRISM G2 data. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 
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Microsoft Excel  
Acumen’s interface with Microsoft Excel provides an open and flexible means of linking to 
external data. Any data that can be stored as an XLS or XLSX file can be imported into Acumen 
for analysis.  

When you link to an Excel file, an Options dialog box displays. Use the fields in this dialog box to: 

 Select the worksheet from the Excel file that you want to import. 

 Create mappings between the columns in the XLS spreadsheet and the fields within your 
Acumen workbook. Excel fields are auto-mapped to Acumen fields if the field names are 
consistent between the two applications. 

Deltek Cobra CAP Earned Value Data 
You can link to detailed phase-based Earned Value (EV) data from Deltek Cobra®’s Excel-based 
CAP report. Importing a CAP report into Acumen enables Earned Value metrics to be run during 
an analysis.  

 

Outputs from an EV analysis (for example, CPI, SPI, SV, CV) are not imported from the CAP 
report. Instead, these calculations are carried out directly within Acumen and are included in 
the Earned Value metrics. 

Cobra linking in Acumen does not support custom field mapping. 

Earned Value metric analysis is not limited to Cobra data. EV data can originate from any of the 
supported platforms and be imported into an Acumen workbook through custom field mapping. 

ARES PRISM G2 
You can link to detailed phase-based Earned Value (EV) data from ARES PRISMG2. This is a 
very flexible means of analyzing time-phased cost data.  

PRISM linking in Acumen does not support custom field mapping. 

Microsoft Excel “Get External Data From” Menu Options 
This topic describes the Microsoft Excel options in the Get External Data From menu on the S1 // 
Projects tab. 

To access the Microsoft Excel menu in the Get External Data From group, complete the 
following steps: 

1. Select the S1 // Projects tab. 

2. In the Get External Data From menu, click the down-arrow on the bottom right corner of 
the Microsoft Excel menu item. 

The following options display: 

 Standard Excel File — Use this option to import a standard Microsoft Excel file with the 
first row containing a header with the attribute names and the rest of the rows each 
containing an activity. 

 Deltek Cobra Spreadsheet Report for Planning (CAP) — Use this option to import a 
Microsoft Excel file containing a Deltek Cobra Spreadsheet Report for Planning (CAP) 
with earned value information. 

 ARES PRISM G2 Spreadsheet Report — Use this option to import a Microsoft Excel file 
containing an ARES PRISM G2 spreadsheet report with earned value information. 
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 Create Cost Estimate — Use this option to create a custom cost estimate within 
Acumen. 

 

See Create a Cost Estimate for more information. 

Deltek Open Plan 
Acumen links to Open Plan files directly through your installed copy of Open Plan. You must have 
Open Plan® installed on your computer in order to link to, and to import from, an Open Plan file. In 
addition, you must have a valid Open Plan login in order to select a project for linking.   

Open Plan linking supports custom field mapping (normal, code, and user-defined fields).  

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 

Set Open Plan Platform Options 

To set the Open Plan platform options, complete the following steps: 

1. Click . 

2. At the bottom of the pane, click Deltek Acumen Options. 

3. On the Platforms tab, in the Deltek Open Plan group, set your preferred options: 

 Username 

 Password 

 Import Code Field Definition as 

 

See Platforms Tab in the Setting Deltek Acumen Options topic for field descriptions. 

4. Click OK. 

Phoenix Project Manager 
Import CPM schedules directly from Phoenix Project Manager for use in project analysis and 
acceleration in the full Acumen software suite. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 
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Asta PowerProject 
Acumen links to Asta PowerProject schedules that have been saved in the Asta PowerProject 
database format (MS Access files with .mdb suffixes). You must have Microsoft Access 
Database Engine in order to import these files. 

These files do not contain float values for activities, therefore if float-based analysis is required for 
an Asta PowerProject in Acumen, the following steps must be carried out before importing the 
.mdb file. 

To allow for float-based analysis, complete the following steps: 

1. Load the project file in PowerProject. 

2. Click Tools » User Field Manager. 

3. Click Object Type » Bar » Add » Integer and name the newly created field, for example, 
TotalFloatUserField. 

4. On the column header, right click and select Add column » Float » Total Float. 

5. On a column header, right click and select Add column » User » <field>, for example, 
TotalFloatUserField. 

6. Copy the Total Float field data to the user field (for example, TotalFloatUserField): 

a. Select the Total Float column header and copy (CTRL+C or Edit » Copy).  

b. Navigate to the user field and paste the data (CTRL+V or Edit » Paste). 

7. Save the file as an Asta PowerProject database MDB file. 

You will now be able to read the MDB file directly in Acumen.  

To reference the Total Float field, after it is imported, map the User Field representing Total 
Float to the Acumen Total Float field in the field mapping view. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 

UN/CEFACT XML Schedule Files 
Acumen links to schedule files that use the UN/CEFACT XML Schema (IPMR Format 6 v1.0). 
This schema is an emerging standard being driven by organizations like DCMA. You can link to, 
and import from, a UN/CEFACT XML file without having a scheduling tool installed on your 
computer. 

UN/CEFACT linking does not support custom field mapping. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 
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Safran Project 
Acumen links to Safran Project 5 through exported Safran Project (.SP) files. You can link to, and 
import from, a Safran Project file without having Safran Project installed on your computer. 

 

See Link to External Data Sources and and Import Projects for general linking and importing 
information and steps. 

Import Activities with Constraints 
Every Safran activity has one field for each type of constraint. Acumen allows a maximum of two 
constraints on an activity. The third and subsequent constraints are ignored. When you import 
from Safran, Acumen loads constraints in the order shown below.  

Constraint Type Safran Field 

Must Start On Fixed Start Date 

Must Finish On Fixed Finish Date 

Start On Or After Target Start Early 

Finish On Or After Target Complete Early 

Start On Or Before Target Start Late 

Finish On Or Before Target Complete Late 

As Late As Possible As Late As Possible 

Safran Outline Codes 
When you import a Safran project: 

 If the selected project has no outline code defined, Acumen doesn’t create a WBS.  

 If the selected project has one outline code defined, Acumen assumes that field is the 
WBS.  

 If the selected project has more than one outline code defined, then during import, a 
Safran Import Settings dialog box displays where you can select the project outline code 
that you want as the WBS.  
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Error and Warning Log 
If there are any errors during the import, a Log dialog box displays that includes information about 
the warning or error. You can click Copy to Clipboard to copy the information to your clipboard 
for further review, or click OK to close the Log dialog box. 
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Appendix B: Standard Field Mappings 
Acumen includes standard field mappings for each of the supported platforms. These are listed 
below. You can create additional custom field mappings using the Fields tab. 

Acumen Field Microsoft 
Project® 

Primavera 
P6 

Primavera 
Risk 

Deltek 
Cobra® 

Deltek  
Open 
Plan® 

UN/CEFACT Safran 

Activity Status Status Activity 
Status 

Calculated 

 
NA Progress 

Type 
Calculated 

 

NA 

Activity Type Calculated Activity 
Type Task Type Calculated Activity 

Type 

ProjectSched
uleTask.Typ

eCode 

Calculated 

 

Actual Cost Actual Cost Calculated Cost[Actual] NA Calculated NA Calculated 

Actual Duration Actual 
Duration 

Actual 
Duration NA NA NA NA Calculated 

Actual Finish Actual 
Finish 

Actual 
Finish Actual Finish NA Actual 

Finish 

ActualSched
uledBasePeri

od.Finish 
Calculated 

Actual Start Actual Start Actual Start Actual Start NA Actual 
Start 

ActualSched
uledBasePeri

od.Start 
Calculated 

ACWP (AC) ACWP ACWP  ACWP (AC) NA NA  

Baseline Finish Baseline 
Finish 

Planned 
Finish 

Baseline 
Finish NA Baseline 

Finish 

TargetSched
uledBasePeri

od.Finish 

Baseline 
Early Finish 

Baseline Start Baseline 
Start 

Planned 
Start 

Baseline 
Start NA Baseline 

Start 

TargetSched
uledBasePeri

od.Start 

Baseline 
Early Start 

Baseline Work Baseline 
Work 

Budgeted 
Labor Units Calculated NA NA NA NA 

BCWP (EV) BCWP BCWP(EV) Calculated BCWP (EV) Calculated NA NA 

BCWS (PV) BCWS Calculated NA BCWS (PV) NA NA NA 

Budget Cost Baseline 
Cost Calculated Cost[Budget] NA Calculated NA NA 

CAM-EAC NA NA NA CAM-EAC NA NA NA 

Critical Critical Critical Critical NA Critical_Ac
tivity 

ProjectSched
uleTask.Criti
calPathIndic

ator 

Calculated 

Description Name Activity 
Name Description Description Activity 

Desc. 

ProjectSched
uleTask.Des

cription 

Description 

EAC EAC EAC NA EAC NA NA NA 

Early Finish Early Finish Early Finish Early Finish NA Early 
Finish 

EarliestSche
duledBasePe

riod.Finish 
NA 
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Acumen Field Microsoft 
Project® 

Primavera 
P6 

Primavera 
Risk 

Deltek 
Cobra® 

Deltek  
Open 
Plan® 

UN/CEFACT Safran 

 

Early Start Early Start Early Start Early Start NA Early Start 
EarliestSche
duledBasePe

riod.Start 
Early Start 

ETC NA NA NA ETC NA NA NA 

Finish Finish Finish Finish Calculated Early 
Finish 

CurrentSche
duledBasePe

riod.Finish 
Calculated 

Free Float Free Float Free Float Free Float NA Free Float Free Float Free Float 

ID ID Activity ID ID ID Activity ID 
ProjectSched
uleTask.Nam

e 

Activity 
Name 

Late Start Late Start Late Start Late Start NA Late Start Late Start Late Start 

Late Finish Late Finish Late Finish Late Finish NA Late Finish Late Finish Late Finish 

LIKELY NA NA NA LIKELY NA NA NA 

Longest Path Critical Longest 
Path Critical NA Critical NA Calculated 

MOD NA NA NA MOD NA NA NA 

Number of Lags Calculated Calculated Calculated NA Calculated 

ProjectSched
uleTaskRelat
ionship.LagTi
meMeasure 

NA 

Number of Leads Calculated Calculated Calculated NA Calculated Calculated NA 

Number of FF 
Predecessors Calculated Calculated Calculated NA Calculated 

Calculated 

 
NA 

Number of 
Predecessors Calculated Calculated Calculated NA Calculated 

Calculated 

 
NA 

Number of   SF 
Predecessors Calculated Calculated Calculated NA Calculated Calculated NA 

Number of SS 
Predecessors Calculated Calculated Calculated NA Calculated 

Calculated 

 
NA 

Number of 
Successors Calculated Calculated Calculated NA Calculated 

Calculated 

 
NA 

Original Duration Duration Original 
Duration 

Original 
Duration NA Original 

Duration 
TotalDuratio
nMeasure Duration 

OTB NA NA NA OTB NA NA NA 

P50 Cost NA NA P50 Cost NA NA NA NA 

P50 Finish NA NA P50 Finish NA NA NA NA 
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Acumen Field Microsoft 
Project® 

Primavera 
P6 

Primavera 
Risk 

Deltek 
Cobra® 

Deltek  
Open 
Plan® 

UN/CEFACT Safran 

P50 Start NA NA P50 Start NA NA NA NA 

P80 Cost NA NA P80 Cost NA NA NA NA 

P80 Finish NA NA P80 Finish NA NA NA NA 

P80 Start       NA 

Percent Complete % Complete Calculated Percent 
Complete NA Calculated 

ProjectSched
uleTask.Calc
ulatedCompl
etionPercent 

NA 

PLAN_ACC NA NA NA PLAN_ACC NA NA NA 

Primary Constraint Constraint 
Type 

Primary 
Constraint 

Primary 
Constraint NA Calculated Primary 

Constraint Calculated 

Primary Constraint 
Date 

Constraint 
Date 

Primary 
Constraint 

Date 

Primary 
Constraint 

Date 
NA Calculated 

Primary 
Constraint 

Date 
Calculated 

Project Finish Finish Date Finish Data Date NA Scheduled 
Finish NA NA 

Project Start Start Date Start Start NA Project 
Start NA NA 

Project Time Now Status Date Data Date Finish NA Time Now NA NA 

Remaining Cost Remaining 
Cost Calculated Cost[Remaini

ng] NA ETC NA Calculated 

Remaining 
Duration 

Remaining 
Duration 

Remaining 
Duration 

Remaining 
Duration NA 

Computed 
Remaining 

Dur. 

ProjectSched
uleTask.Rem
ainingDuratio

nMeasure 

Remaining 
Duration 
Analyzed 

REPLAN NA NA NA REPLAN NA NA NA 

Risk Input - 
Duration 
Description 

NA NA Calculated  NA NA 
NA 

Risk Input - 
Duration 
LowerPcent 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Duration Max NA NA 

Risk input- 
Duration 
Maximum 

NA NA NA 
NA 

Risk Input - 
Duration Mean NA NA 

Risk input- 
Duration 

Mean 
NA NA NA 

NA 

Risk Input - 
Duration Min NA NA 

Risk input- 
Duration 
Minimum 

NA NA NA 
NA 

Risk Input - 
Duration 

NA NA Risk Input - 
Duration 

NA NA NA NA 
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Acumen Field Microsoft 
Project® 

Primavera 
P6 

Primavera 
Risk 

Deltek 
Cobra® 

Deltek  
Open 
Plan® 

UN/CEFACT Safran 

MostLikely MostLikely 

Risk Input - 
Duration 
MostLikelyPcent 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Duration Notes NA NA 

Risk Input - 
Duration 

Notes 

 

NA NA NA 

NA 

Risk Input - 
Duration Risk 
Distribution 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Duration 
RiskFunction 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Duration RiskId NA NA Calculated NA NA NA NA 

Risk Input - 
Duration RiskOn NA NA Calculated NA NA NA NA 

Risk Input - 
Duration Shape NA NA Calculated NA NA NA NA 

Risk Input - 
Duration 
StdDeviation 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Duration 
UpperPcent 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic 
Description 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic Notes NA NA Calculated NA NA NA NA 

Risk Input - 
Probabilistic 
RiskFunction 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic 
RiskId 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic 
RiskOn 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic Links 
Description 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic Links 
Notes 

NA NA 
Risk Input - 
Probabilistic 
Links Notes 

NA NA NA 
NA 
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Acumen Field Microsoft 
Project® 

Primavera 
P6 

Primavera 
Risk 

Deltek 
Cobra® 

Deltek  
Open 
Plan® 

UN/CEFACT Safran 

Risk Input - 
Probabilistic Links 
RiskFunction 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic Links 
RiskId 

NA NA Calculated NA NA NA 
NA 

Risk Input - 
Probabilistic Links 
RiskOn 

NA NA Calculated NA NA NA 
NA 

Risk Input - Task 
Existence 
Description 

NA NA Calculated NA NA NA 
NA 

Risk Input - Task 
Existence Notes NA NA 

Risk Input - 
Task 

Existence 
Notes 

NA NA NA 

NA 

Risk Input - Task 
Existence 
RiskFunction 

NA NA 

Risk Input - 
Task 

Existence 
Function 

NA NA NA 

NA 

Risk Input - Task 
Existence RiskId NA NA Calculated NA NA NA NA 

Risk Input - Task 
Existence RiskOn NA NA Calculated NA NA NA NA 

Risk Input - Task 
Existence 
Probability 

NA NA 
Risk Input - 

Task 
Existence 

NA NA NA 
NA 

Risk Output - 
CostSensitivity NA NA 

Risk Output - 
CostSensitivit

y 
NA NA NA 

NA 

Risk Output - 
CostStdDeviation NA NA 

Risk Output - 
CostStdDevia

tion 
NA NA NA 

NA 

Risk Output – 
CriticalityIndex NA NA 

Risk Output – 
CriticalityInde

x 
NA NA NA 

NA 

Risk Output – 
DurationCruciality NA NA 

Risk Output - 
Duration 

Cruciality 
NA NA NA 

NA 

Risk Output - 
DurationStdDeviati
on 

NA NA 
Risk Output - 
DurationStdD

eviation 
NA NA NA 

NA 

Risk Output – 
DurationSensitivity NA NA 

Risk Output – 
DurationSens

itivity 
NA NA NA 

NA 

Risk Output – 
MeanCost NA NA Risk Output – 

MeanCost NA NA NA NA 
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Acumen Field Microsoft 
Project® 

Primavera 
P6 

Primavera 
Risk 

Deltek 
Cobra® 

Deltek  
Open 
Plan® 

UN/CEFACT Safran 

Risk Output – 
MeanDuration NA NA 

Risk Output – 
MeanDuratio

n 
NA NA NA 

NA 

Risk Output - 
MeanFinish NA NA Risk Output - 

MeanFinish NA NA NA NA 

Risk Output – 
MeanStart NA NA 

Risk Output – 
MeanStart 

 
NA NA NA 

NA 

Risk Output - 
PercentageTaskExi
sted 

NA NA 
Risk Output - 
% Iterations 

Existed 
NA NA NA 

NA 

Risk Output - 
ScheduleSensitivit
yIndex 

NA NA 
Risk Output - 
ScheduleSen
sitivityIndex 

NA NA NA 
NA 

Secondary 
Constraint NA Secondary 

Constraint NA NA Calculated Secondary 
Constraint Calculated 

Secondary 
Constraint Date NA 

Secondary 
Constraint 

Date 
NA NA Calculated 

Secondary 
Constraint 

Date 
Calculated 

Start Start Start Start Start Early Start 
CurrentSche
duledBasePe

riod.Start 
Calculated 

Total Cost Cost Calculated Cost[Total] NA Calculated NA NA 

Total Float Total Slack Total Float TotalFinshFlo
at NA Total Float 

ProjectSched
uleTask.Tota
lFloatDuratio

nMeasure 

Total Float 

WBS Code Outline 
Number WBS 

Work 
Breakdown 
Structure 

WBS Code NA NA 
NA 

WBS Name Outline 
Number WBS Name 

Work 
Breakdown 
Structure 

WBS Name NA NA 
NA 

WORST NA NA NA WORST NA NA NA 
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Appendix C: Executive Briefing Variables and 
Customization 
This topic includes information about customizing the Executive Briefing report.  

 

See Executive Briefing in the Reporting Diagnostics Results section of this guide for more 
information about the report. 

Customizing the Executive Briefing Report 
The ExecutiveBriefingTemplate.xml file is located in the Acumen » Templates folder. It is a 
hard-coded report which means that you cannot add or edit elements, or move a variable to a 
different element; however, you can make changes to the “regular text.” In addition, you can 
remove any of the fields in parenthesis in which case they will not display in the report.  

For example, the following is a line from the ExecutiveBriefingTemplate.xml file: 

 <MultipleProjectIntroduction>The {NumberOfProjects} projects in the workbook 
represent</MultipleProjectIntroduction> 

You cannot delete the entire line; however, you can delete {NumberOfProjects} and you can 
delete or edit The and projects in the workbook represent. 

Executive Briefing Variables 
The tables below include decriptions of the variables that make up each XML Element of the 
Executive Briefing Report.  

XML Element Variable Description 

GenerationDate GenerationDate Date and time of the system at the 
time of the report creation. 

Author Author Author of the workbook. 

WorkbookSubtitle WorkbookName Name of the workbook. 

FirstSummaryPart GenerationDate Date and time of the system at the 
time of the report creation. 

WorkbookName Name of the workbook. 

ProjectQuantity Number of projects in the workbook. 

Plural Converts the “project” word to plural in 
case that there is more than one 
project in the workbook. 

ListOfProjects Creates a list of all the projects in the 
workbook with their respective source 
platform. 

FirstSummarySecondPart SnapshotQuantity Number of snapshots in the workbook. 
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XML Element Variable Description 

SnapshotPlural Converts the “snapshot” word to plural 
in case that there is more than one 
snapshot in the workbook. 

ListOfSnapshots Creates a list of all the snapshots in 
the workbook with their respective 
source platform. 

ProjectName ProjectName Name of the current project. 

ProjectsWithApp ProjectNames Names of all the projects for the 
current source platform separated by a 
comma. 

PlatformApplication Name of the source platform. 

MultipleProjectIntroduction NumberOfProjects Total number of projects. 

SecondSummaryPart Introduction Uses the SingleProjectIntroduction or 
the MultipleProjectIntroduction XML 
element depending on the number of 
projects in the workbook. 

TotalCost Total cost of the workbook. 

RemainingCost Remaining cost of the workbook. 

ActualCost Actual cost of the workbook. 

EarlierStartDate Earliest start date included in the 
workbook. 

LatestCompletionDate Latest completion date included in the 
workbook. 

ProjectSubtitle ProjectName Name of the current project. 

ProjectSummary ProjectName Name of the current project. 

StartDate Start date of the current project. 

ProjectCompletionDateSenten
ce 

Uses the ProjectCompletionDate XML 
element to add the completion date of 
the project if the project has a 
completion date. 

Status Indicates the status of the current 
project. 

StatusDateSentence Uses the ProjectStatusDate XML 
element to add the status date of the 
project if it has one. 

ProjectCompletionDate CompletionDate Indicates the completion date of the 
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XML Element Variable Description 

current project. 

ProjectStatusDate StatusDate Indicates the status date of the current 
project. 

ProjectNormalActivitiesSu
mmary 

NumberOfNormalActivities Number of normal activities in the 
current project. 

NormalPlural Converts the word “activity” to plural 
depending on the number of activities 
in the schedule. 

NumberOfCompletedActivites Indicates the number of normal 
completed activities in the current 
project. 

CompletedActivitiesPercentag
e 

Indicates the percentage of completed 
activities in the current project. 

CompletedPlural Types the word “is” or “are” depending 
on the number of completed activities. 

NumberOfInProgressActivites Indicates the number of normal in-
progress activities in the current 
project. 

InProgressActivitiesPercentag
e 

Indicates the percentage of in-
progress activities in the current 
project. 

InProgressPlural Types the word “is” or “are” depending 
on the number of in-progress activities. 

NumberOfPlannedActivites Indicates the number of normal 
planned activities in the current 
project. 

PlannedActivitiesPercentage Indicates the percentage of planned 
activities in the current project. 

PlannedPlural Types the word “is” or “are” depending 
on the number of planned activities. 

ProjectOtherActivitiesSum
mary 

NumberOfMilestones Number of milestones in the current 
project. 

MilestonesPlural Converts the word “milestone” to plural 
if the number of milestones is > 1. 

NumberOfSummaries Number of summaries in the current 
project. 

SummariesPlural Converts the word “summary” to plural 
if the number of summaries is > 1. 
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XML Element Variable Description 

NumberOfLoes Number of LOEs (Hammocks) in the 
current project. 

LoesPlural Converts “LOE” to “LOEs” if the 
number of LOEs is > 1. 

ProjectDateComparison BaselineStart Baseline start of the current project. 

BaselineFinish Baseline finish of the current project. 

ProjectDatesStatus Indicates if the project is ahead, 
behind or on schedule. 

StatusDates Indicates the number of days the 
project is behind/ahead. 

ProjectCostComparison TotalCost Total cost of the project. 

BaselineCost Baseline cost of the project. 

ActualCost Actual cost of the project. 

RemainingCost Remaining cost of the project. 

ProjectCostStatus Indicates if the project is over, under or 
on budget. 

StatusCost Indicates the amount the project is 
over/under budget. 

RibbonAnalysis RibbonBy Indicates the criteria used for the 
ribbons in the current ribbon view. 

NumberOfRibbons Number of ribbons in the current 
ribbon view. 

RibbonPlural Converts the word “ribbon” to plural if 
there is more than one ribbon. 

ListOfRibbons Lists all the ribbons in the current 
ribbon view. 

ScorecardAnalysis RibbonNames List of ribbons for the current score. 

Plural Types “ribbon” or “ribbons” depending 
on the current scorecard. 

TypeOfValue Types “worst” or “best” depending on 
the current scorecard. 

Score Current scorecard score. 

SingleRibbonScorecard Score Currrent scorecard score. 
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XML Element Variable Description 

TrendSummary Interval The time interval used in the current 
ribbon view. 

TrendAnalysis MetricName The current metric being used for trend 
anaylsis. 

Trend Indicates if the current metric 
“increases”, “decreases” or “remains 
constant”. 

TrendPeriods Uses the TrendPeriods XML element 
to indicate trend values. 

TrendPeriods Highest Types “best” or “highest” depending on 
the metric definition. 

HighestPeriod Indicates the phase where the value 
for the metric is higher/better. 

HighestValue Indicates the highest value for the 
metric. 

Lowest Types “worse” or “lowest” depending 
on the metric definition. 

LowestPeriod Indicates the phase where the value 
for the metric is lowest/worse. 

LowestValue Indicates the lowest value for the 
metric. 

RibbonSubtitle RibbonName Name of the current ribbon. 

SpecificRibbonSummary RibbonName Name of the current ribbon. 

NumberOfNormalActivities Number of normal activities in the 
current ribbon. 

PluralNormal Converts the word “activity” to plural 
depending on the number of activities 
in the ribbon. 

NumberOfMilestones Number of milestones in the current 
ribbon. 

PluralMilestones Converts the word “milestone” to plural 
if the number of milestones is > 1. 

NumberOfSummaries Number of summaries in the current 
ribbon. 

PluralSummaries Converts the word “summary” to plural 
if the number of summaries is > 1. 
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XML Element Variable Description 

NumberOfLoes Number of LOEs (Hammocks) in the 
current ribbon. 

PluralLoes Converts “LOE” to “LOEs” if the 
number of LOEs is > 1. 

StartDate Start date of the ribbon. 

FinishDate Finish date of the ribbon. 

SpecificRibbonPercentages CompletedPercentage Percentage of completed activities 
inside current ribbon. 

PlannedPercentage Percentage of planned activities inside 
ribbon. 

InProgressPercentage Percentage of in-progress activities 
inside ribbon. 

SpecificRibbonDurationCo
st 

DaysLong Total number of days the ribbon 
spans. 

RemainingCost Sum of the remaining cost of the 
activities included in the current ribbon. 

SpecificRibbonAnalysisMet
rics 

Quantity Number of metrics used to analyze the 
current ribbon. 

RibbonActivityCountMetric
Evaluation 

BaseValue Indicates the result of the primary 
formula for the current metric. 

Plural Converts the word “activity” to plural if 
the BaseValue is > 1. 

SecondaryValue Indicates the result of the secondary 
formula for the current metric. 

SecondPlural Types “has” or “have” depending on 
BaseValue. 

MetricName Name of the current metric. 

TripwireDescription Indicates the tripwire description for 
the current value of the metric. 

RibbonActivityAttributeMet
ricEvaluation 

BaseValue Indicates the result of the primary 
formula for the current metric. 

Plural Converts the word “activity” to plural if 
the BaseValue is > 1. 

SecondaryValue Indicates the result of the secondary 
formula for the current metric. 
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XML Element Variable Description 

SecondPlural Types “is” or “are” depending on 
BaseValue. 

MetricName Name of the current metric. 

TripwireDescription Indicates the tripwire description for 
the current value of the metric. 

RibbonCountMetricEvaluati
on 

BaseValue Indicates the result of the primary 
formula for the current metric. 

MetricName Name of the current metric. 

SecondaryValue Indicates the result of the secondary 
formula for the current metric. 

TripwireDescription Indicates the tripwire description for 
the current value of the metric. 

RibbonValueMetricEvaluati
on 

BaseValue Indicates the result of the primary 
formula for the current metric. 

MetricName Name of the current metric. 

SecondaryValue Indicates the result of the secondary 
formula for the current metric. 

TripwireDescription Indicates the tripwire description for 
the current value of the metric. 
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